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Preface

This redbook will help you either upgrade or install Windows 2000 on your
clients and servers using the IBM Universal Manageability tools. We show
you the added value of these tools over and above the base Microsoft tools
and documentation that are provided with Windows 2000. In addition, this
book provides some basic details on how to implement Software Delivery
Assistant and the new version of System Migration Assistant. This book also
incorporates the new function for Windows 2000 deployment in LCCM.

Examples are provided of how to use Netfinity Director to determine which of
your clients and servers are candidates for migration to Windows 2000. In
addition to the examples provided throughout this redbook, there is a chapter
that covers the support structure for the tools used in this book as well as a
chapter on frequently asked questions.

The team that wrote this redbook

This redbook was produced by a team of specialists from around the world
working at the International Technical Support Organization, Raleigh Center.

Figure 1. Team that wrote this redbook
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Chapter 1. Deploying Windows 2000 using UM deployment tools

This redbook shows how you can use the IBM Universal Manageability (UM)
tools to deploy Microsoft Windows 2000. It shows how you can do this better
than with the tools delivered by Microsoft itself. We show you how the UM
tools can help reduce the total cost of ownership (TCO).

Microsoft wrote a Deployment Planning Guide for upgrading or deploying
Windows 2000 on Intel-based PC platforms. This is a large document that
should help you to upgrade and deploy your systems to Windows 2000.

Note: You can find the Microsoft Windows 2000 Deployment Planning Guide
on the following Web site:

http://www.microsoft.com/WINDOWS2000/library/resources/reskit/dpg/default.asp

IBM will also use this guide as the basis or development of Universal
Manageability (UM) tools for deploying Windows 2000 on IBM and non-IBM
systems. These tools are part of the Universal Manageability initiative from
IBM that can help you to manage your systems easier and reduce the TCO. In
this chapter we give you a short overview of the Universal Manageability tools
and start with the planning of the Windows 2000 deployment.

The UM tools are all based on industry standards such as:

• Wired for Management (WfM)

• Wake on LAN (WOL)

• Desktop Management Interface (DMI)

• Common Information Model (CIM)

• Simple Network Messaging Protocol (SNMP)

Note: Information about these industry standards can be found on the
following Web sites:

http://www.pc.ibm.com/us/infobrf/
http://www.intel.ie/support/desktopmgmt/apptech.htm
http://www.faqs.org/rfcs/

You can also search for the terms using the different search engines on the
Internet, such as:

http://www.yahoo.com
http://www.altavista.com
http://www.lycos.com.
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The UM tools we used for deploying Windows 2000 were:

• LANClient Control Manager (LCCM) Version 2.5.1 Service Pack 3

• System Migration Assistant (SMA) Version 2.1

• Software Deploying Assistant (SDA) Version 1.1

• Netfinity Director/Universal Manageability Services (UM Services) V2.12

All tests and deployments made in this book were based on the following
operating system levels:

• Microsoft Windows 2000 Professional (build 2195)

• Microsoft Windows 2000 Server (build 2195)

• Microsoft Windows NT Server 4.0 with Service Pack 6a

• Microsoft Windows NT Workstation 4.0 with Service Pack 6a

• Microsoft Windows 98 Second Edition

If you use other versions, some details may be different and some settings
may not work the same way.

For the examples described in this book we used the following hardware
components:

• IBM PC 300PL

• Netfinity 3000

• Netfinity 5000

• Ethernet hub

• Dell OptiPlex GX1

• HP Vectra VLI8
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1.1 Universal Manageability tool

This section gives you an overview of the UM tools that we used for this
redbook. This is only a short introduction to the tools. You can find links to the
chapters where the tools are described in more detail.

1.1.1 LANClient Control Manager (LCCM)
The LANClient Control Manager (LCCM) is part of the IBM Universal
Manageability initiative. This tool helps you to deploy basic programs to new
systems. The basic programs include operating system and additional
applications, such as word processing software and system management
tools. We used LCCM V2.5.1 Service Pack (SP)3. With SP3, LCCM supports
the deployment of Microsoft Windows 2000 Professional, Server and
Advanced Server. The SP3 upgrade also has an enhanced profile, a new
wizard, SMA integration and several other enhancements. You can use the
wizard to create profiles for deploying Microsoft Windows 2000 systems.

Note: LCCM and the Service Pack are available from the following Web site:

http://www.pc.ibm.com/us/desktop/lccm/

Figure 2. LANClient Control Manager
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Note: Information about the features of the LANClient Control Manager can
be found in the redbook Using LCCM Functions with Servers and
Workstations, SG24-5292 and in the LCCM 2.5.1 Training and Procedures
Guide. Both can be downloaded from the above LCCM Web site.

When starting the LCCM Server, you will see the window shown in Figure 3.
This windows contains five main parts:

• Menu bar
• Scan button for new clients
• The left pane with the unassigned clients
• The center pane with profiles and assigned clients
• The right pane with the clients database search

Figure 3. LCCM program window

LCCM gives you different ways to deploy your systems. You can make an
image from a reference system and deploy it or perform an unattended
installation on the client system.You can use the wizard to create a profile or
do it manually with the profile notebook. You will be asked about this when
you select Profile -> Create New (Figure 4).
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Figure 4. Wizard selection

When you select the Profile Wizard, the following window is displayed:

Figure 5. LCCM 2.5.1 SP3 Profile Wizard

The Windows 2000 operating system is supported by LCCM 2.5.1 with SP3
(see Figure 5). The way to use LCCM to deploy Windows 2000 is described in
3.1, “LCCM” on page 101.

Note: Information about the supported systems is available on the following
Web site:

http://www.pc.ibm.com/us/desktop/lccm/compat.html
Chapter 1. Deploying Windows 2000 using UM deployment tools 5
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1.1.1.1 Asset ID
You always have to scan the clients, to bring the clients into LCCM. You can
start the scan in two ways:

1. Power on the system.

2. Wake up the clients.

To wake them, the clients must support Wake on LAN (WOL). To start the
wake-up process you must know the MAC address of the clients to send the
magic packet to.

To get the MAC address from IBM systems that support the Asset ID chip,
you can use the Asset ID reader (Figure 6 on page 6) without the systems
being powered on. On the packaging for the IBM desktop systems there is a
special symbol that looks like a target. Behind this symbol are the antenna
from the Asset ID chip which contains the information you can scan with your
Asset ID reader (including the MAC address of the system).

You can also use the Asset ID reader to set up the LCCM profile name in the
Asset ID chip, so that they can automatically process a profile at scan time
without the need for using the LCCM drag and drop feature.

Figure 6. Using Asset ID reader on desktop boxes, Intellistation and ThinkPad

The following IBM systems are currently supported by the Asset ID reader:

• IBM PC 300PL (6862, 6892, 6584, 6594, 6565)

• IntelliStation (MPro 6889, EPro 6893, ZPro 6865)

• ThinkPad - Through options available by the IBM Authorized Assembler
Program (AAP) (TP 600 2645AAU with antenna 05k6010, TP 770
954883U with antenna 05k5753)
6 Windows 2000 Deployment Using Universal Manageability
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For further information about supported systems check the following Web
site:

http://www.pc.ibm.com/ww/assetid/systems.html

More information about Asset ID and the use of the Asset ID reader can be
found at the following Web site:

http://www.pc.ibm.com/us/desktop/assetid/index.html

1.1.2 System Migration Assistant (SMA)
The System Migration Assistant (SMA) is an IBM Universal Manageability tool
that runs on Microsoft Windows operating systems. We used SMA V2.1
(shown in Figure 7) in these examples.

Note: SMA is available for downloading from the following Web site:

http://www.pc.ibm.com/us/software/sysmgmt/products/sma/

Figure 7. System Migration Assistant

SMA helps you to migrate all the personality and connectivity settings,
applications, files and folders from one system to a new system. SMA has two
parts: a source and a target. On the system that you want to take the settings
from for migration, you should run the source part of the SMA. SMA gives you
two ways to migrate from one system to another. These processes are
Selective Migration and Mass Migration, as shown in Figure 8.
Chapter 1. Deploying Windows 2000 using UM deployment tools 7
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Figure 8. Selection of the migration method

In Selective Migration, only selected personality, connectivity settings, files
and folders are migrated. No applications or registry entries are migrated with
this method.

When you use Mass Migration, all of your personality and connectivity
settings (without the ability to select which ones), all registry settings,
applications, files and folders are transferred. You can select which drives,
folders and files should be transferred. Mass Migration can only be done in
the same operating system.

The information and files are stored as *.SMA, *.PRC and *.C01 files. When
you have finished this part, move the files to the new system. On the new
system you should start the target part of the SMA. Here you should select
which *.SMA files you want to use (see Figure 9 on page 9) and start the
installation.
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Figure 9. Selecting SMA files

In Figure 10 on page 10 check the box Edit the SMA file if you want to
change some settings, such as computer name, domain/workgroup or IP
settings. This will be necessary if you installed the saved settings on another
system. This can be useful if you are going to install the saved settings on
multiple systems.
Chapter 1. Deploying Windows 2000 using UM deployment tools 9



Figure 10. Select the edit option

Select the check box now and click Next. That brings you to Figure 11 on
page 11 where you can see which settings are stored in the SMA file and
where you can change these settings. When you have finished the changes,
click Next. A window pops up and asks you if you want to continue (Figure 12
on page 11). Select Yes and the installation starts.
10 Windows 2000 Deployment Using Universal Manageability



Figure 11. Edit the SMA file settings

Figure 12. Start installing on target system

A new window shows the progress of the installation. After finishing the
installation process you should see the following window:
Chapter 1. Deploying Windows 2000 using UM deployment tools 11



Figure 13. SMA migration process

Select Next and the summary window shows you summary status information
about the success of the installation process. This is shown in Figure 14.

Figure 14. Summary of the transfer process
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When you click Exit you are informed that you need to reboot your system in
order for the changes to take effect. Click OK to close all applications and
reboot your system. You have now finished the SMA process.

A detailed description of how to use the System Migration Assistant to deploy
Microsoft Windows 2000 can be found in 5.1, “System Migration Assistant” on
page 211.

1.1.3 Software Delivery Assistant (SDA)
Software Delivery Assistant is an IBM Universal Manageability tool that
simplifies the deployment of IBM systems (PC, IntelliStation, ThinkPad and
Netfinity Servers). We used SDA V1.1. SDA runs on Microsoft Windows
operating systems (Windows 95/98, Windows NT 4.0 and Windows 2000).

Note: You can download SDA from the following Web site:

http://www.pc.ibm.com/ww/solutions/enterprise/sysmgmt/products/sda/index.html

The Software Delivery Assistant creates custom software installation images
to be deployed on new systems. SDA consists of two parts: the
SDA-Administrator and the SDA-Installer. The SDA-Administrator is used to
create and customize the images and the SDA-Installer is used to install the
images on the end user’s system.

You can run the SDA-Installer in different ways. The SDA-Installer can be
started automatically when you create an entry in the registry on the system
where SDA-Installer should run (HKEY_LOCAL_MACHINE\Software\Microsoft
\Windows\CurrentVersion\RunOnce, create the following entry: SDA

“d:\imagepath\SWSELECT.EXE”). Or you can create a shortcut on the user’s
desktop that points to SWSELECT.EXE. That way, the user can start the
SDA-Installer program more easily.

Note: For installation on Windows NT systems, you will need administrator
privileges to install applications through the SDA-Installer, because some
applications update Windows resources such as registry keys and directories.

SDA supports the following operating systems:

• Windows 95

• Windows 98

• Windows NT

• Windows 2000
Chapter 1. Deploying Windows 2000 using UM deployment tools 13
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After installing SDA, you can start the SDA-Administrator program by clicking
Start -> Programs -> IBM SDA1.1.

Figure 15. Software Delivery Assistant

When The SDA-Administrator is started you have the option to create a new
image, use an existing workspace or import a workspace from an existing
image. When using SDA for the first time you should select Create a new
workspace.

Figure 16. Select the workspace for SDA

A wizard guides you through the steps of creating a basic workspace. A
detailed explanation of creating a new workspace can be found in 4.1,
“Software Delivery Assistant” on page 175.
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Figure 17. SDA Administrator program - new workspace

Now that you have a basic workspace, you can begin to customize it by
adding and removing languages, group profiles and applications. The
interface provides the cut, copy and paste, as well as drag and drop features
to allow you to easily customize your workspace.
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Figure 18. Start to make the application image

To insert applications, click on the language and group that should contain
the application and select Insert -> Application. At a minimum every
application should have the following information:

• Application name

• Operating system(s)

• Location of the installation files

• A silent and/or custom installation command (to run the setup program)

• The install type (required, recommended, user’s choice)

For a detailed description of this information see 4.1.2, “SDA-Administrator”
on page 180.
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Figure 19. Complete workspace

When you have your workspace completed, the images need to be built. To
start the creation of the image click Image from the menu bar. Click Preview
to simulate the end user’s experience with the SDA-Installer and to verify that
all settings in the workspace are correct. Click Build to create the application
setup image. Select the folder where the image should be stored. The
SDA-Installer will also be copied to this folder. During the build, all
applications will be checked for accuracy. If any errors are encountered, they
are shown in the bottom portion of the window. Double-clicking on an error
takes you directly to the problem so you can fix it. See Figure 20 on page 18
for this.
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Figure 20. Building image and fixing errors

Note: If any two applications share the same install files, the files will only be
copied to the image once and the applications using these files will use the
same copy.

Once all errors have been fixed and the image built, you can update the
image without entirely rebuilding it. For example, when you get an updated
version of one of the applications, all you need to do is update the location of
the installation files for that application (and any other fields that have
changed) and rebuild the image in the same folder as before. The
SDA-Administrator gives you the option to rebuild the entire image or just
apply any changes that were made (Figure 21 on page 18).

Figure 21. Incremental build
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Copy the created folder (named \SDA %Workspace%) to the client (you can
deploy this together with the operating system using LCCM) or map the
directory where the files are located to the client. Here SDA-Installer can be
run automatically by creating an entry in the registry on the client system (in
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Run).
Create the following entry: SDA “x:\imagepath\SWSELECT.exe”), or create a
shortcut to SWSELECT.EXE on the user’s desktop, allowing the user to run
the SDA-Installer at their leisure.

When the SDA-Installer is run for the first time, the user is prompted to
complete the profile field and to choose a group (Figure 22).

Figure 22. Profiling the user

The group that the user chooses determines which applications are
automatically installed. First, the Common required applications are installed
and then the group’s required applications are installed (Figure 23). If more
than one group is selected, the required applications for all selected groups
are installed.

Figure 23. Installing required applications
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After all required applications are installed, the main window appears. Here
you can select additional software to be installed. After selecting the
applications you can start the installation process by clicking Install. You can
install more than one software program within this process.

Figure 24. SDA Installer main window

For a detailed description of additional SDA settings and how you should use
SDA to install applications on client systems, see 4.1, “Software Delivery
Assistant” on page 175.

1.1.4 Netfinity Director and Universal Manageability Services
Netfinity Director is the follow-on product to IBM Netfinity Manager. Netfinity
Director is a part of the Universal Manageability initiative by IBM based on
industry standards. It provides you with an impressive suite of systems
management tools. Netfinity Director allows you to manage your systems
from a central point. Netfinity Director consists of the following parts:

• Netfinity Director Server

• Netfinity Director Console
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• Universal Manageability Services (UM Services) agent

Note: Information about the features of Netfinity Director can be found in the
redbook Netfinity Director-Integration and Tools, SG24-5389.

When you start the Netfinity Director (Figure 25), you will see the console
windows divided into five main parts:

1. Group pane

2. Group Contents pane

3. Tasks pane

4. Task bar

5. Status line

Figure 25. Netfinity Director Console

On the left pane you select the group. In the center pane you can see the
systems that are in this group. To activate a task for a system or for the group,
drag the system (group) and drop it on the task in the right pane. Then the
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task window will open (for example, in Figure 26 on page 22 we show the
inventory task window for one of our systems).

Figure 26. Inventory task display

We used Netfinity Director to check all our systems from one central point for
Windows 2000 readiness. We created a new dynamic group named “System
not W2k ready”. For this group we set the minimum requirements for Windows
2000. All members of this group are not Windows 2000 ready. Now that we
know this we can make the systems Windows 2000 ready. The process to do
that as well as how to use Netfinity Director is described in 2.2.1, “Use
Netfinity Director to determine hardware and software” on page 35.

UM Services must be installed on the client systems. You must select Client
Installation during the installation process (Figure 27).
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Figure 27. Installation of UM Services

This will install UM Services on your client systems. When it is installed, all of
your clients should be selected when you click Tasks -> Discover Systems
-> All Systems and Devices from your Netfinity Director console.

In Chapter 2, “Upgrade of clients to Windows 2000” on page 35 you can find
detailed information about using Netfinity Director to help deploy Windows
2000.

You can use UM Services to manage your local system. You can also use the
Microsoft Management Console (MMC) within Microsoft SMS or a Web
browser (for example, Netscape Navigator or Microsoft Internet Explorer) to
access the UM Services. To start UM Services select Start -> Programs ->
IBM UM Services and then Microsoft Management Console to start the
access over MMC or IBM UM Services Browser to access UM Services over
the browser. When you start UM Services in a Web browser, it will look similar
to Figure 28 on page 24. When starting it in the MMC, you will see a window
similar to Figure 29 on page 25.

Note: More Information about UM Services and its integration can be found in
the following redbooks: Universal Manageability: Enterprise Management
Integration, SG24-5388-00 and in Netfinity Director - Integration and Tools,
SG24-5389-00.
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Figure 28. UM Services running in Internet Explorer
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Figure 29. UM Services running in MMC

UM Services also works as the client for Netfinity Director. You can access
the systems where UM Services is installed from the Netfinity Director
console.

1.1.5 Why should you use the UM tools
The UM tools give you additional features that help you to manage your
deployment better than the standard tools that are delivered by Microsoft for
deployment and upgrades. An advantage of the UM tools is that they upgrade
and support all Windows 32-bit operating systems, not only Windows 2000.
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Table 1 shows the features of the UM tools compared with the Windows 2000
standard features:

Table 1. Comparisons between LCCM and RIS

You can see in this table that LCCM gives you more features, supports more
operating systems, and helps you to reduce your costs. This is due to the fact
that you do not need to access each system manually to perform the
installation.

Microsoft has a tool on the following Web site to check your system’s
readiness for running Microsoft Windows 2000:

http://www.microsoft.com/windows2000/upgrade/compat/RAread.asp

Feature LCCM
(LANClient Control

Manager)

RIS
(Remote Integration

Service)

Imaging drive C Yes Yes

Imaging Drive D+ Yes (only with OEM
imaging tool)

No

NIC support Yes limited (25 PCI based
adapter cards)

Support Windows 2000
Pro

Yes Yes

Support Windows 2000
Server and Adv. Server

Yes No

Support Windows 95/98 Yes No

Support Windows NT Yes No

Additional information Runs on standard system;
no Active Directory Service
required

Run only with a Windows
2000 Domain with Active
Directory Service and DNS

No direct access to system
necessary when NIC with
WOL functionality used

Require Boot Disk -> need
direct access to the system
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We have compared the tool with Netfinity Director. We used Netfinity Director
to dynamically check Windows 2000’s readiness for all our systems. The
results can be seen in Table 2:

Table 2. Netfinity Director and Windows 2000 readiness analyzer

You can see from this table that Netfinity Director gives you more flexibility,
central management, and helps to reduce the TCO.

For the deployment and upgrade you can bring the personality settings,
network connections and files and folders to a new system. IBM has created
the System Migration Assistant, which makes this possible. The SMA lets you
bring your settings from one system to another, and also from one Windows
version to a newer one. This means you can migrate the systems from
Windows 98 or Windows NT to Windows 2000. We compare this tool with the
IntelliMirror tool that is provided by Microsoft for Windows 2000.

Netfinity Director Microsoft Windows
2000 Readiness

Analyzer

Centrally usable Yes No

Completely remote
operation possible. Does
not require physical access
to the system

Yes No

Supports dual boot
systems (NT4 and W9x)

Yes No

Dynamic update of the
results

Yes No
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The most important fact about SMA is that it is not required to run in a
Windows 2000 environment.

Table 3. Comparison between SMA and IntelliMirror

SMA gives you the ability to bring settings from your installed systems
running Windows 98 or Windows NT to the new Windows 2000 systems by
using the Selective Migration function of SMA. It also lets you bring settings
from a donor system to the other systems running the same operating system
when you use the Mass Migration function of SMA. All these features give you
great flexibility, help to bring the settings quickly and easily to your systems
as well as help you to reduce the TCO.

IBM also has a tool that allows you to deploy applications to different
systems. This is the IBM Software Delivery Assistant. We compared this tool
with Intellimirror.

SMA IntelliMirror

Support for Windows 98 Yes No

Support for Windows NT Yes No

Support for Windows 2000 Yes Yes

SMA can run in a standard
Windows environment.
SMA doesn’t need Active
Directory to run.

IntelliMirror needs the
Active Directory installed
on the system. Due to that
fact, IntelliMirror is limited
to use only with Windows
2000.

With SMA you can bring
settings from an NT or
Windows 98 system to
Windows 2000.

Only settings from one
Windows 2000 system can
be migrated to another
Windows 2000 system.
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Note: SDA can be run in Windows 98, Windows NT and Windows 2000.

Table 4. Comparisons between SDA and IntelliMirror

Here you can see how SDA gives you more flexibility for deploying
applications than IntelliMirror. Through this flexibility, SDA helps you to save
time and money. You can use your existing environment to prepare images
that need to be deployed on Windows 2000.

1.2 Deployment planning considerations when using UM tools

Before you can start to deploy your Windows 2000 systems or before you
upgrade your system to Windows 2000, you should have a plan. Table 2
shows which UM tools you should use to upgrade or deploy your systems.

Table 5. Planning guide

SDA IntelliMirror

Support for Windows 98 Yes No

Support for Windows NT Yes No

Support for Windows 2000 Yes Yes

Usable without active
directory

Yes No

Can build images on
W98/NT for W2000

Yes No

What do you want to do? You should use the
following UM tool

Reference to the
following chapters

Check if your system is
Windows 2000 ready

Netfinity Director 2.2, “Analysis of systems
for upgrade” on page 35

Upgrade your system to
Windows 2000

Netfinity Director 2.4, “Upgrading to
Windows 2000
Professional” on page 86

Install a new Windows 2000
Professional system on a
desktop

LCCM 3.1.1, “Unattended install
of Windows 2000
Professional on a client” on
page 102

Install a new Windows 2000
Server system on a server

LCCM 3.1.2, “Unattended install
of Windows 2000 Server
on a server” on page 148
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As you can see, there are UM tools available for each of the steps you have to
take. First you should check to see if your hardware is Windows 2000 ready.
To do this you can use different tools. Microsoft delivers on its Web page a
tool which checks your hardware and software. IBM offers tools to help you
check your hardware and software for Windows 2000 readiness. If you have
installed Netfinity Director you can use it to check your systems. Netfinity
Director is shipped with each IBM Netfinity server. Netfinity Director gives you
the ability to perform a hardware and software inventory of all the systems in
your network. The use of Netfinity Director will be discussed in 2.2.1, “Use
Netfinity Director to determine hardware and software” on page 35.

You should also check the corresponding Web site for your system to check if
there is a BIOS update necessary, to make your system run with Windows
2000. To do this, you can use UM Services. In UM Services you can find the
System Updates function as shown in Figure 30.

Install a new Windows 2000
Server system on a Netfinity
server (example)

LCCM Chapter 6, “Installing
Netfinity Servers with UM
deployment tools” on page
253

Upgrade Windows 98 settings
to Windows 2000 Professional

SMA 5.1, “System Migration
Assistant” on page 211

Upgrade Windows NT 4
Workstation settings to
Windows 2000 Professional

SMA 5.1, “System Migration
Assistant” on page 211

Upgrade Windows NT 4
Server settings to Windows
2000 Server

SMA 5.1, “System Migration
Assistant” on page 211

Deploy Software to a Windows
2000 system (Professional
and Server)

SDA or LCCM 4.1, “Software Delivery
Assistant” on page 175

What do you want to do? You should use the
following UM tool

Reference to the
following chapters
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Figure 30. UM Services - System Update

When selecting this function you can connect directly to the corresponding
IBM Web site for your system. For example, we used a Netfinity 3000
(8647-31U) running Windows 2000 and UM Services 2.12. We selected the
System Upgrade -> Drivers function, and were connected to the following
system-specific Web site:

http://www.pc.ibm.com/support?page=847631U

From the system-specific Web site to which you get connected by selecting
this function, you can download the latest drivers and BIOS versions for your
system. You can also create a profile (the Profile function found at UM
Services -> System Update). With this function you will be connected to an
IBM Web site. Select the browser that you use and fill out the profile template.
You can also add additional systems and components to the profile. You only
need to create a profile once for all of your IBM systems.

You can search the Web for driver and BIOS updates and you can optionally
use LCCM to deploy the new BIOS updates. To do that you should connect to
the following Web site:
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When checking the Windows 2000 readiness of your systems hardware, you
should be sure that all the applications installed on your systems are also
Windows 2000 ready. To check that, you can use Netfinity Director and the
Microsoft winnt32 /checkupgradeonly audit tool. This procedure is described
in 2.2.1, “Use Netfinity Director to determine hardware and software” on page
35.

You should also contact the software manufacturer or your business partner
to ask about the Windows 2000 readiness of the installed application. You
can also check the Windows 2000 readiness for your software products on
the following Web site:

http://www.microsoft.com/windows2000/upgrade/compat/search/default.asp

When applications installed on your systems are not Windows 2000 ready
you should uninstall them before you start the upgrade or deployment of
Windows 2000. This is described in 2.3.1, “Removal of incompatible
applications and services” on page 69.

When you check your systems for Windows 2000 readiness, you must select
what you want to do. You have some choices. You can upgrade an existing
Windows 98 or Windows NT system or you can deploy a complete installation
with LCCM, including applications.

It is important to know that you can only upgrade your system to the following
versions:

Table 6. Upgrade path to Windows 2000

Installed Upgrading to

Windows 95/98/98SE Windows 2000 Professional

Windows NT 4.0 Workstation or
Windows NT 3.51 Workstation

Windows 2000 Professional
Windows 2000 Server

Windows NT 4.0 Server or
Windows NT 3.51Server

Windows 2000 Server
Windows 2000 Advanced Server

Windows NT 3.51 Server with Citrix No upgrade, only full installation

Windows NT 4.0 Terminal Server Windows 2000 Server
Windows 2000 Advanced Server

Microsoft Backoffice Small Business
Server

No upgrade, only full installation
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Note: For Windows 98 there is a suggestion from Microsoft that home
computer users who have installed Windows 95/98 should wait for the next
version of the consumer operating system, code named “Millennium”.

Microsoft indicates that when you want to use your system for music and
video work, to play PC games, or if you need easy home networking and
Internet access, you should leave Windows 98 on your system. If you want to
have the highest reliability for your business, enhanced security and the best
support for mobile users you should use Windows 2000 Professional edition
on your systems. For more information see the Microsoft Web site:

http://www.microsoft.com/windows2000/upgrade/path/win9x.asp

In some cases it is better to install a completely new system. For example,
you might want to change your hardware environment, or you may want to run
both operating systems on the same hardware. In addition, it might be an
opportunity to start a complete new installation and remove some old
problems that were occurring on your original operating system installation.

To bring all your personalized settings, connection information and personal
files and folder to the new system, IBM has created the System Migration
Assistant (SMA). Detailed information about the System Migration Assistant
can be found in 5.1, “System Migration Assistant” on page 211.

With SMA you have a powerful tool that can help you save time and money
when you upgrade your systems. It gives users, after the upgrade, the same
resources and the same personalized settings that they had on their
pre-migrated system. Thus, you won’t incur the additional costs of
reconfiguring the new system. Users can start working on the new system
faster and with less training since they will see the same settings, such as
printer and network drives, which also helps reduce the TCO.

Another important UM tool is the Software Delivery Assistant (SDA). This tool
lets you prepare the installation of programs and allows the installation of
specific applications for this user from a common installation base. Detailed
information about the Software Delivery Assistant can be found in 4.1,
“Software Delivery Assistant” on page 175.

SDA gives you the chance to prepare a complete installation of all
applications in your company on one system. You can also prepare the

Windows NT Server 4.0 Enterprise
Editition

Windows 2000 Advanced Server
Windows 2000 Data Center

Installed Upgrading to
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complete package delivery. SDA gives you the opportunity to check the
packages on your systems before you deliver them to the end users. When
building an image, you can upgrade the image without installing all of the
applications which are part of the image. SDA can run without user
interaction to install required applications quicker. You can start with the
creation of the images on your existing environment running Windows 98 or
Windows NT. This helps you to reduce the costs and time for preparing
additional systems before you start your migration and deployment.
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Chapter 2. Upgrade of clients to Windows 2000

Migrating from either the Windows NT 4.0 or Windows 98 platform to
Windows 2000 Professional on desktop clients doesn’t have to be a difficult
experience. Proper planning, preparation, and tools can make even a large
rollout flow smoothly. IBM’s Universal Manageability applications can
enhance your migration by automating many of the time consuming and
mundane tasks associated with such an undertaking. This chapter provides
specific details on how to use IBM’s suite of total cost of ownership (TCO)
tools with the IBM desktop (client) line.

2.1 Our environment

The examples in this chapter were performed on a pair of PC 300PL (6862)
desktop systems connected via the onboard Etherjet adapters through an
IBM 8222 10 Mbps Ethernet hub. The Netfinity Director server was running
on Windows NT 4.0 Server, Service Pack 6a, and Netfinity Director V2.11.
The Windows NT 4.0 Workstation client had Service Pack 6.0a and UMS
V2.11 installed. All base system drivers were installed from the 2.1 Ready to
Configure CD. The Windows Scripting Host and Visual Basic Script programs
in this chapter were tested using Windows Script V5.1.

2.2 Analysis of systems for upgrade

As with any new application or operating system there is a specific set of
minimum hardware and software requirements that must be met for the
software to work properly. Windows 2000 Professional is no exception and
without current configuration information about your clients it would be
difficult to anticipate the problems that may be encountered. Through the use
of Netfinity Director, Universal Manageability Services (UM Services), and
Microsoft’s Analysis Tool we are able to gather the information needed. For
further information on IBM Universal Management Tools and to download the
applications go to:
http://www.pc.ibm.com/ww/solutions/enterprise/sysmgmt/index.html.

2.2.1 Use Netfinity Director to determine hardware and software
Netfinity Director is a powerful and flexible management tool based on Tivoli’s
IT Director. We examined specific aspects of data capture and filtering in
Netfinity Director, using many examples to provide step-by-step instructions.
Those unfamiliar with Netfinity Director may find it helpful to refer both to the
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user documentation for the product and to the redbook Netfinity Director -
Integration and Tools, SG24-5389.

2.2.1.1 How to use Netfinity Director to gather inventory
The simplest method of discovering what machines meet the minimum
hardware installation requirements for Windows 2000 Professional is to
create a dynamic group based on that criteria.

The first step is to right click on an empty area in the Groups pane and then
select New Dynamic Group from the resulting pop-up window.

Figure 31. New group menu

This will produce the Dynamic Group Editor window. Start by selecting the
first criteria that you want to filter on. Click the + sign for Disk -> Total Size
(KB). Next select one of the drive icons flagged with a numeric value.
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Figure 32. Dynamic Group Editor

Click the Add button and the object appears in the Selected Criteria pane.
Select the newly added criteria and choose Edit -> Change Criteria Value.

Figure 33. Change Criteria Value menu item

Once the Update Value window appears we select the Change operator value
by clicking the drop-down menu arrow and choosing Less than. Next, the
hard drive size in kilobytes was entered in the Change value field. This value
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should be the minimum hard drive space requirement for the installation of
Windows NT 2000 Professional as indicated by Microsoft or the specific value
needed for your implementation. Clicking OK returns you to the Dynamic
Group Editor window.

Figure 34. Update Value window for changing criteria

The next step is to set the criteria and logical operator that will ensure that
only hard disk drives are checked for the space requirements. Select Disk
->Type -> HARDDISK and click Add.

Figure 35. Selecting disk type

The Choose Add Operation window will appear. Select the All true for the
same disk radio button and then OK.
38 Windows 2000 Deployment Using Universal Manageability



Figure 36. Choose Add Operation

After clicking the + next to All true for the same disk the Selected Criteria
pane will appear as in the following figure:

Figure 37. Selected Criteria for hard disk size

If the Dynamic Group was saved with only these criteria it would display those
machines that did not meet the space requirements for Windows 2000
Professional. There are, however, two more hardware concerns that should
be checked before a machine is considered as meeting the minimum
requirements: memory size and processor speed. To set up the criteria for
memory, select Installed Memory -> Physical Memory Installed. Next,
choose any of the icons representing the amount of memory installed and
click Add.
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Figure 38. Adding Physical Memory installed criteria

The Choose Add Operation window will appear. Select the Any true (OR)
radio button and click OK.

Figure 39. Add operation for memory criteria

After expanding the tree, the Selected Criteria panel will look like Figure 40.

Figure 40. Selected Criteria: hard disk and memory

To modify the memory criteria, highlight Physical Memory Installed and
select Edit -> Change Criteria Value.
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Figure 41. Modifying Physical Memory criteria

The Update Value window will appear. Select Less than from the Change
operator pull-down menu, enter the minimum amount of RAM needed by
Windows 2000 Professional in the Change value field, and click OK.

Figure 42. Modify RAM criteria

To add the final dynamic group criteria expand Processor -> Maximum
speed of installed processor (MHz) and choose any of the icons
representing processor speed. Click the Add button.
Chapter 2. Upgrade of clients to Windows 2000 41



Figure 43. Adding processor criteria

In the Choose Add Operation window, select Any true (OR) and click OK.

Figure 44. Specifying an add operation

Fully expand the Selected Criteria pane and highlight Maximum speed of
installed processor. Then choose Edit -> Change Criteria Value.
42 Windows 2000 Deployment Using Universal Manageability



Figure 45. Selecting processor speed criteria for modification

Choose Less than from the Change operator drop-down menu and specify
the minimum processor speed (MHz) in the Change value field. Then click
OK.

Figure 46. Updating processor speed criteria

When fully expanded, the Selected Criteria pane will look like Figure 47.

Figure 47. Complete criteria for minimum hardware dynamic group
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Once we have finished specifying the criteria for our new dynamic group it
can be saved by selecting File -> Save As, entering a name for the group,
and clicking OK.

Figure 48. Saving the dynamic group

The new dynamic group is added to the Netfinity Director Console Groups
pane. The new group will be automatically updated with the machines
meeting the criteria specified; thus all machines not meeting the minimum
processor, memory, or hard drive values will appear in this group.
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Figure 49. Windows 2000 Professional minimal hardware requirements

This simple format is helpful for a quick overview of what machines are not
compliant but it does not present you with what components failed or allow
you to export the needed information. A few more steps are necessary to
provide specific details in a flexible format. Creating a custom inventory query
will allow us a simple point-and-click method of viewing or exporting the
information to CSV or HTML format. To create the query we must first open
the Inventory Query Browser for our Windows 2000 Professional minimum
hardware requirements group by right clicking the group we just created and
selecting View Inventory.
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Figure 50. Opening Inventory Query Browser window

The Inventory Query Browser window will appear. Right click Custom in the
Available Queries pane and then choose Build Custom Query.
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Figure 51. Opening Inventory Query Builder window

The Inventory Query Builder will be presented. In the Available Criteria pane
expand Disk and choose Type -> Add.
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Figure 52. Setting disk criteria

Follow the same process to add the following. Click:

• Disk -> Total Size

• Processor -> Maximum speed of installed processor (MHz)

• Installed Memory -> Physical Memory installed (KB)

Figure 53. Hardware criteria
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Additional criteria can be added to make the information a little more
meaningful. Click:

• User Details -> User Name

• User Details -> User Phone

• User Details -> User Department

• User Details -> System Location

Figure 54. Additional criteria

The Selected Criteria pane will resemble Figure 55.

Figure 55. Suggested criteria for custom query

Select FIle -> Save.
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Figure 56. Saving custom query

Enter a name for the custom query, click OK, and close the window.

Figure 57. Naming custom query

We are returned to the Inventory Query Browser. Upon expanding the
Custom tree we find our query. If selected, the criteria requested in the query
is displayed in the Query Results pane.

Figure 58. Results of the custom query

This is the level of detail we need to assist us in evaluating what machines
may require hardware upgrades to support Windows 2000 Professional
presented in a simple format. There are situations, however, where the query
results need to be manipulated in another application, such as a spreadsheet
or database. The Inventory Query Browser allows you to export to either
Comma Separated Value (CSV) or HTML language. To do this, click File ->
Export and the format you need, in this case CSV.
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Figure 59. Selecting export format

The export window displays the format type selected. Provide a name and
save location for the file. Click OK.

Figure 60. Saving exported data

A window appears confirming that the export completed successfully. Click
OK to finish the export.

2.2.1.2 Software collections
Determining if the pre-existing software installed on deployed client machines
is compatible with Windows 2000 Professional is a multi-part process. First
you need to determine what applications should be maintained on the current
image. A good starting point for this is to ensure that the applications and
drivers contained in the base image deployed to the machines are compliant.
Next, gathering an inventory of the software and drivers currently installed on
a sample group of clients will inform you of what software or devices are
being used in addition to the base image. After determining what software
you wish to allow, performing software and device driver inventories with
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custom dictionary entries, if necessary, will allow you to plan for what
software and data directories need to be migrated or removed.

A good example of how to easily find the existence of incompatible device
drivers and applications for a remote client using IBM Universal
Manageability tools is a scenario involving two known incompatible software
components. Let’s examine how to leverage dynamic groups and custom
inventory queries to present what software is involved and where it is
installed. This example will assume the Netfinity Director software dictionary
has been appended with appropriate entries for the application in question.
For details on how to update the software dictionary or any of the other basic
concepts presented in this example, please see the Netfinity Director Users
Guide or refer to the redbook Netfinity Director - Integration and Tools,
SG24-5389.

Our initial step is to create a dynamic group for the machines that possess the
non-compliant software. From the Netfinity Director Console, right click an
empty area of the Groups pane to produce a pull-down menu. From that
menu choose New Dynamic.

Figure 61. Opening Dynamic Group Editor

Once the Dynamic Group Editor window appears expand Software ->
Program Title under Available Criteria. Highlight the application from the
software dictionary that you wish to find and click Add.
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Figure 62. Adding criteria to a new dynamic group

The application will now appear under Selected Criteria. In addition to the
application, we would also like to query for a Windows 2000 incompatible
device driver. Add this criteria by expanding the Device Drivers -> Driver
Name tree under Available Criteria, choose the incompatible driver, and
clicking Add.
Chapter 2. Upgrade of clients to Windows 2000 53



Figure 63. Adding device driver criteria to a dynamic group

The Choose Add Operation window will appear. Select the Any true (OR)
radio button and click OK.

Figure 64. Selecting criteria add operation

You will now have the same criteria under the Selected Criteria pane as the
following figure.

Figure 65. Suggested criteria for Windows 2000 software compatibility

To save the Dynamic Group choose File -> Save then in the Save As window
enter a name for the Dynamic Group and click OK.
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Figure 66. Saving a dynamic group

The new Dynamic Group will appear under the Groups pane on the Netfinity
Director Console. When the dynamic group is selected, the machines
meeting the criteria, in this case systems that contain Windows 2000
Professional incompatible software, will appear in the Group Contents pane.

Figure 67. Dynamic group contents

This provides an excellent overview of what machines possess incompatible
Windows 2000 software. However, it does not illustrate which software and it
is not presented in a flexible format. A custom inventory query can be used to
expand the amount of data shown and how it is formatted.

To create a custom inventory query, start by clicking the dynamic group that
was just created and choose View Inventory.
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Figure 68. Opening View Inventory for a dynamic group

The Inventory Query Browser window will be displayed. To build a custom
query right-click Custom under the Available Queries pane and select Build
Custom Query from the pop-up menu.

Figure 69. Opening Custom Query Builder

The Inventory Query Builder appears. To select criteria for the query, expand
Device Drivers under the Available Criteria pane and choose Driver Name.
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Next, click Add and the highlighted criteria will be added to the Selected
Criteria pane.

Figure 70. Adding device driver criteria

Repeat this procedure to add the following criteria:

• Device Drivers -> Version

• Device Drivers -> Startup Options

• Device Drivers -> Status

Follow the same process to add the software dictionary data outlined in the
following list:

• Software -> Program Title

• Software -> Version ID
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Figure 71. Adding software criteria

The completed list of Selected Criteria will be the same as Figure 72.

Figure 72. Suggested criteria for software query

To save the custom query select File -> Save, then in the Save Query window
that appears enter a name for the query and click OK.

Figure 73. Saving a custom query

Close the Inventory Query Builder to reveal the Inventory Query Browser. The
new custom query will appear in the Available Queries pane. To view the
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results for the query click the desired query, and the data will be displayed in
the Query Results pane.

Figure 74. Query results for example software custom query

This query provides all the information needed to discover what software or
device drivers specified in the dynamic group are incompatible with Windows
2000. The format that the data is presented in, however, may not meet the
needs of individuals who have to place this information in another application
such as a spreadsheet or database. There are two export format options
available for this query data, Comma Separated Value and Hypertext Markup
Language. To export the data highlight the desired query and select File ->
Export and the desired format, in this case Spreadsheet (.CSV).
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Figure 75. Exporting Inventory Query Browser data

When the Export Comma Separated Value Format window is displayed, enter
the name and the location of where the file will be saved and then click OK.

Figure 76. Export file information

A window appears confirming that the export completed successfully. Click
OK to finish the export.

2.2.1.3 Netfinity Director and Microsoft’s Analysis tool
Microsoft has created a pair of applications based on the same tools for
detecting Windows 2000 upgrade compatibility from Windows 9x or Windows
NT 3.51, 4.0, and Terminal Server. The two utilities differ only in how they are
packaged and executed. The stand-alone tool can be downloaded from
Microsoft at http://www.microsoft.com/technet/download/default.asp and run
interactively on a client. The second analysis tool is executed during the
upgrade installation process and it can be scripted to run unattended or
interactively on the target machine.
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Netfinity Director can be used to schedule the winnt32.exe command line
audit to run unattended on remote clients via a point-and-click interface.
Configuring this scenario requires a minimum amount of setup. To start, a
share point with the Windows 2000 Professional installation files should be
created. In this example, the shared folder has already been created. The
directory C:\Archive has been shared as \\23ff458\Archive. We then created a
subdirectory called W2KPro and copied the x:\I386 subdirectory from the
Windows 2000 Professional CD-ROM to C:\Archive\W2KPro. This will result
in a share point called \\23ff458\Archive\W2KPro\I386. An additional pair of
directories were created for the script files and the resulting log files
generated by the analysis utility, C:\Archive\W2KPro\Scripts and
C:\Archive\W2KPro\Scripts\log.

Table 7. Example share points

Once a share point has been established, the batch files that call the
winnt32.exe audit function need to be created under the exported directory.

Purpose Directory Name Share Name

Windows 2000
installation files
share point

C:\Archive\W2KPro\I386 \\23ff458\Archive\W2KPro\I386

Batch file share
point

C:\Archive\W2kPro\Scripts \\23ff458\Archive\W2KPro\Scripts

Log share point C:\Archive\W2KPro\Scripts\log \\23ff458\Archive\W2KPro\Scripts\log
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There are many ways to script this function. In this case we created a simple,
single batch program that illustrates some of the options available.

Figure 77. upcheck.bat

The method by which the audit utility is run depends on what the target
operating system is. Therefore, we must first determine what supported
operating system is installed on the machine. This can be accomplished
either through Netfinity Director using dynamic groups that sort machines
according to their installed platform, or the script file itself can determine what
is running on the client. In this example we have illustrated two simple
methods that determine what operating system is running on the client and in
turn run the appropriate command for the platform. The IF EXIST

%windir%\WINIPCFG.EXE GOTO W98 statement determines whether a specific file
exists, which indicates if Windows 98 SE is installed; in this case we used
WINIPCFG.EXE. The next line,IF %OS%==Windows_NT GOTO NT, uses the default
Windows NT %OS% environment variable to determine if the operating
system in question is running.

Once the operating system has been determined, the proper command can
be run to launch the audit utility. To start the analysis tool under Windows 98
an unattended script file must first be created that sets the options allowing
only the tool to run. The example on the following page provides an example
of the unattend.txt file to be used. The save location and name for the log file
is set here. In this case it is: \\23FF458\Archive\W2KPro\Scripts\log\
%COMPUTERNAME%.LOG. The file should be placed in a shared directory
such as \\23ff458\Archive\W2KPro\Script.

@ echo off

rem This script is used to check for Windows 2000 upgrade compatibility on
rem remote machines using Netfinity Director and Microsoft's
rem winnt32 /checkupgradeonly audit tool.

IF EXIST %windir%\WINIPCFG.EXE GOTO W98
IF %OS%==Windows_NT GOTO NT
GOTO END

:W98
\\23ff458\Archive\W2KPro\I386\WINNT32 /unattend:\\23ff458\Archive\W2kPro\Scripts\w98check.txt
GOTO END

:NT
\\23ff458\Archive\W2KPro\I386\WINNT32 /CHECKUPGRADEONLYQ
COPY %SystemRoot%\WINNT32.LOG \\23FF458\Archive\W2KPro\Scripts\log\%COMPUTERNAME%.LOG
DEL %SystemRoot%\WINNT32.LOG
GOTO END

:END
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Note: A valid product ID must be used for the operation to complete
successfully.

The Win98 section of the batch file shown in Figure 77 on page 62 contains
the command \\23ff458\Archive\W2KPro\I386\WINNT32 /unattend:\\23ff458\

Archive\W2kPro\Scripts\w98check.txt. This requests WINNT32.EXE from the
\\23ff458\Archive\W2KPro\I386 share point to execute using the w98check.txt
unattend.txt file from the \\23ff458\Archive\W2kPro\Scripts share point.

Configuring the analysis tool for Windows NT 4.0 is a bit more
straightforward. The command \\23ff458\Archive\W2KPro\I386\WINNT32

/CHECKUPGRADEONLYQ in Figure 77 on page 62 asks WINNT32.EXE from the
\\23ff458\Archive\W2KPro\I386 share point to run using the
/CHECKUPGRADEONLYQ option. This will initiate the audit tool in quiet
mode and create a log file named WINNT32.LOG in the Windows NT
installation directory. The next command in the NT section of the batch file,
COPY %SystemRoot%\WINNT32.LOG

\\23FF458\Archive\W2KPro\Scripts\log\%COMPUTERNAME%.LOG transfers the log
file to a central repository and renames it to the target computer name. The
share point \\23FF458\Archive\W2KPro\Scripts\log is once again used as the
log save location.

To test the example batch file and share points we ran the following command
at a command prompt on the target machine:

\\23ff458\Archive\W2KPro\Scripts\upcheck.bat

The batch file upcheck.bat from the Figure 77 on page 62 is being executed
from the \\23ff458\Archive\W2KPro\Scripts share point. A log file named after
the target computer will appear after a few moments in the log file target
directory.

[Unattended]
Win9xUpgrade=yes

[UserData]
ProductID=XXXXX-XXXXX-XXXXX-XXXXX-XXXXX

[Win9xUpg]
ReportOnly=yes
SaveReportTo=\\23FF458\Archive\W2KPro\Scripts\log\%COMPUTERNAME%.LOG
Chapter 2. Upgrade of clients to Windows 2000 63



Note: The Windows 98 audit process will produce a window for the duration
of the analysis but will not require user interaction.

The final set of steps involved with using the Microsoft Windows 2000
compatibility analysis tool with IBM Netfinity Director centers around creating
a Process Task. This will allow the batch file to be run on remote machines
through Netfinity Director. To create a new Process Task, in the Tasks pane
expand Process Management, right-click Process Task and select Open
from the pop-up menu.

Figure 78. Opening a new Process Task

A Process Task window will appear. In the Command field enter
\\23ff458\Archive\W2KPro\Scripts\upcheck.bat and in the Login section enter
the user ID and password for an account with the proper permissions to
access the machine and run the executable.

Directory of C:\Archive\W2KPro\Scripts\log

01/31/2000 02:08p <DIR> .
01/31/2000 02:08p <DIR> ..
01/31/2000 02:02p 1,742 NFD.LOG
02/07/2000 11:46a 64 RAYSPL.LOG
01/31/2000 01:58p 3,898 ROKCLNT.LOG

3 File(s) 5,704 bytes
2 Dir(s) 5,290,799,104 bytes free
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Figure 79. Creating the analysis tool process task

Save the new Process Task by clicking File, selecting Save As from the
pull-down menu, entering a name for the task in the Save As window, and
clicking OK.

Figure 80. Saving the Microsoft W2K compatibility audit Process Task

Close the Process Task window. The new task should appear under Process
Tasks in the Tasks pane.
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Figure 81. Microsoft W2K Compatibly Audit task

To execute the audit on a single remote machine, drag and drop the client
from the Group Contents pane on to the task. To assign multiple machines to
the task, use a group from the groups pane containing the desired systems.
Either action will cause a window to appear asking how you want the job
executed. It can be canceled, executed now, or scheduled for a later date.
Click Execute Now to run the audit immediately.

Figure 82. Task execution selection window

The Execution History window is presented showing the status of the task.
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Figure 83. Execution History

Once all the machines have completed the task, you will find the audit logs for
the clients in the specified log directory. The logs detail hardware and
software Windows 2000 compatibility concerns. The Table 8 on page 67
illustrates the information contained in the log. The section tag points to the
location of the data in the sample log file on page Start Menu Contents on
page 68

Table 8. Windows 2000 Analysis Tool log data types

Data Type Section

Amount of Memory (A)

Drive Size and Free Space (B)

Incompatible Drivers (C)

Contents of the Windows Start Menu (D)
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********************************************************************

Windows NT Upgrade Verification Tool

********************************************************************

Detected 512 MBytes of memory.

Examining system partition for adequate space for temporary boot files.
Drive C: acceptable for boot files

Examining disk for adequate space expand the WinDir.
Drive C: acceptable for final installation directory.

Examining Disks for adequate space for temporary setup files.
Drive A: doesn't exist or is not a local hard drive
Drive A: not valid for holding temporary installation files.
Drive C: acceptable for local source.

sermouse
3com 3C562D/3C563D
CrystalWare Audio Driver
Logitech Mouseware Drivers
Logitech Mouseware Drivers
Logitech Mouseware Drivers
Intel PIIX IDE Controller
Directory Replicator

********************************************************************

Start Menu Contents

********************************************************************

\Start Menu
\Programs
\Startup
\Administrative Tools (Common)
Disk Administrator.lnk
Performance Monitor.lnk
Backup.lnk
Event Viewer.lnk
Windows NT Diagnostics.lnk
Remote Access Admin.lnk
User Manager.lnk

\IBM UM Services
IBM UM Services Browser.url
Troubleshooting Guide.lnk
IBM UM Services Help.lnk

\System Migration Assistant
Source.lnk
Target.lnk

\Start Menu
\Programs
\Startup
\Accessories

(B)

(C)

(D)

(A)
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2.3 Pre-deployment

Once it has been determined what immediate road blocks will be encountered
when attempting to migrate from either Windows 98 Second Edition or
Windows NT 4.0, Service Pack 6a to Windows 2000 Professional, the next
obvious step is to remove them. IBM Universal Manageability tools can once
again be leveraged to provide flexible assistance. This section examines how
IBM tools can be used to remove incompatible applications and services
along with migrating user client settings and updating system BIOS.

2.3.1 Removal of incompatible applications and services
When migrating to Windows 2000 Professional from a legacy operating
system, service or application incompatibilities may be discovered. Removing
this software can become complex depending upon what procedure needs to
be used. Netfinity Director can help simplify this process by distributing and
scheduling these automated tasks via a point and click interface.

2.3.1.1 Removing incompatible applications
Removing an incompatible application using Netfinity Director is a simple
process. For our example we used the Windows PC Doctor application that is
shipped on the IBM 300PL Ready-to-Configure CD, V2.1. This utility is not
compatible with Windows 2000 Professional and therefore must be
uninstalled. This example is a two-part process: first a series of batch files
need to be created allowing the automated removal of the application, then
the scripts will be incorporated into a Process Task for distribution to the
target machines.

PC Doctor uses the Wise Installation System for its delivery method. This
software uses a combination of an executable UNWISE.EXE and a log of the
initial installation called INSTALL.LOG. The command C:\WINDOWS\UNWISE.EXE

/A /S C:\PCDU\INSTALL.LOG silently uninstalls PC Doctor from C:\PCDU on the
Windows 98 platform. This assumes that the default installation directories
were used. Further details about the Wise Installation System can be found at
the Wise Solutions home page http://www.glbs.com/Default.htm. To
implement this command for both Windows 98 Second Edition and Windows
NT 4.0 operating systems, we incorporated it into the batch files shown in
Figure 84 and Figure 85 on page 71.
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Figure 84. Install PC Doctor

@ ECHO OFF
REM This script is part one of a two part process which uninstalls the PC DOCTOR
REM Application from the Windows NT 4.0 and Windows 98 platforms. The second part
REM ofthis process is started by PCDUINST.BAT.

REM Connect to the sharepoint
NET USE U: \\23ff458\Archive

REM Open a command interpreter with enough environment space to run PCDUINST.BAT
REM and execute it.
COMMAND /E:2048 /C U:\Scripts\PCDUINST.BAT

REM Disconnect from the sharepoint
ECHO Y | NET USE U: /DELETE

:END
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Figure 85. The rest of the PC Doctor install

Figure 84 on page 70 starts by connecting to the share point NET USE U:
\\23ff458\Archive. This is the working directory for the scripts where all
processing will take place. Next, it uses COMMAND /E:2048 /C

U:\Scripts\PCDUINST.BAT to open a command interpreter with 2048 bytes of
initial environment space and executes the second batch file. It is necessary
to initiate a separate command interpreter with additional environment
resources due to the limited amount of space provided by the Process Task.

@ ECHO OFF
REM This script is part two of a two part process which uninstalls the PC DOCTOR
REM Application from the Windows NT 4.0 and Windows 98 platforms. The first part
REM of this process is started by BOOST.BAT.

REM Add U:\Scripts to the PATH variable and move to the share point.
PATH=%PATH%;U:\Scripts
u:
cd \Scripts

REM Discover where on the C: drive PC Doctor is installed and place the
REM information in a.DAT file.
DIR /S /B C:\*.LOG | FIND /I "PCDR" > PCDUTMP.DAT

REM Add and extra space to the .DAT file so DATE does not wait for input.
echo.>> pcdutmp.dat

REM Set the %DIR% variable to the information contained in PCDUTMP.DAT
TYPE PCDUTMP.DAT | DATE | FIND "Enter" > PCDUTMP.BAT
ECHO SET DIR=%%4 > Enter.BAT
CALL PCDUTMP.BAT

REM Check to see if we are under Windows NT then run the appropriate uninstall
REM command.
IF %OS%==Windows_NT GOTO NT
GOTO W98

:W98
%windir%\UNWISE.EXE /A /S %DIR%
GOTO CLEANUP

:NT
%SYSTEMROOT%\UNWISE.EXE /A /S %DIR%
GOTO CLEANUP

REM Remove uneeded files.
:CLEANUP
DEL PCDUTMP.DAT
DEL Enter.BAT
DEL PCDUTMP.BAT
C:
GOTO END

:END
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The main purpose of Figure 84 on page 70 is to configure a workspace for
PCDUINST.BAT.

The uninstallation of the application takes place in PCDUINST.BAT which
appears in Figure 85 on page 71, though there is a lot of ground work
performed before it is removed. Initially the script adds the working directory
on the share point to the %PATH% and moves you to the U:\Scripts directory.

Once we are in the right location, the C: drive is scanned for the default
installation directory of PC Doctor and the path is stored in PCDUTMP.DAT
by the command DIR /S /B C:\*.LOG | FIND /I "PCDR" > PCDUTMP.DAT. This is
done because PC Doctor installs to \PCDR under Windows 98 or to
\PCDRNT for Windows NT 4.0. DIR /S /B C:\*.LOG finds all .LOG files in all
subdirectories on the C: drive and presents them to standard out in a bare
format. This information is then piped to FIND /I “PCDR”, which looks for any
line containing the string PCDR. The result of this query is redirected to the
file PCDUTMP.DAT which, under Windows 98 SE, will contain
C:\PCDR\INSTALL.LOG.

The next steps take the information stored in PCDUTMP.DAT and assign it to
a variable. Typically this is accomplished via a small C or Visual Basic
program but due to the lack of a native solution common to both Windows NT
4.0 and Windows 98 Second Edition a process consisting of batch files was
used. The command echo.>> pcdutmp.dat is used to add an empty line to
PCDUTMP.DAT which will allow DATE in the next line to continue without
requiring user input. To reformat the data contained in PCDTMP.DAT so that it
calls a known batch file name, the line TYPE PCDUTMP.DAT | DATE | FIND "Enter"

> PCDUTMP.BAT is used. First, TYPE PCDUTMP.DAT sends the contents of
PCDUTMP.DAT to standard out, which is then piped to the DATE command.
The date command will try and use the contents of PCDUTMP.DAT as the
input for its request for a new date. DATE will then return an invalid date error
and request input for a new date. This is where the additional blank line
added by echo.>> pcdutmp.dat comes into play. The empty entry provides a
blank space and carriage return for DATE, which allows the command to end
as if the Enter key were pressed. If we interrupted the process at this point
the output would appear as in Figure 86.

Figure 86. Sample output for TYPE PCDUTMP.DAT | DATE
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The contents of standard out is then piped to FIND "Enter" > PCDUTMP.BAT. This
will look for any line containing the string “Enter” and redirect it to the file
PCDUTMP.BAT. The final contents of PCDUTMP.BAT are shown in Figure 87.

Figure 87. Contents of PCDUTMP.BAT

A temporary batch file called Enter.BAT is created via ECHO by the command
ECHO SET DIR=%%4 > Enter.BAT. This script will contain SET DIR=%4. The extra
percent symbol in %%4 tells ECHO to produce the string %4 rather than
translating the variable to the fourth option on the batch file command line.

The last step in setting the variable %DIR% consists of the command CALL

PCDUTMP.BAT. Figure 87 shows the contents of PCDUTMP.BAT. As we can see,
Enter is the first command that it will attempt to execute with the rest of the
text acting as command options. Enter.BAT is the first executable it runs since
it is the first encountered. This will always be the case because Enter.BAT is
created in the same directory as PCDUTMP.BAT. Enter.BAT then sets the
fourth command line option to the variable %DIR%. In this example it will be
C:\PCDR\INSTALL.LOG.

Once the location of the PC Doctor installation log has been determined and
set to a variable we need to determine what platform we are running on.
There are command line utilities that are capable of querying the registry
which would aid in this process but for simplicity in this example we used the
Windows NT %OS% variable. If %OS% is equal to Windows_NT then we
know the client is using Windows NT and are directed to the :NT subsection.
If the check fails then the platform should be Windows 9x and therefore
directed to the :W98 subsection. This check is required due to the lack of a
shared platform variable that presents the Windows installation directory.

The :W98 section puts all of the data collected together and runs the PC
Doctor uninstallation command %windir%\UNWISE.EXE /A /S %DIR%. The batch
file interprets the variables and presents C:\Windows\UNWISE.EXE /A /S

C:\PCDR\INSTALL.LOG for execution. Further details about the Wise Installation
System can be found at the Wise Solutions Web site:
http://www.glbs.com/Default.htm.

The :NT section performs the same duties as the :W98 portion. The only
difference is what variable is being used for the location of the Windows
installation directory. The command %SYSTEMROOT%\UNWISE.EXE /A /S %DIR%

initiates the quiet software removal process.
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Now that the uninstallation process has finished it is time to clean up the files
and shares left behind. The :CLEANUP section deletes the three temporary
files used to set the %DIR% variable, moves to the C: drive, and passes
control back to the batch file that spawned it. The last action of BOOST.BAT, who
is now in control, is to disconnect from the U: \\23ff458\Archive share point
using ECHO Y | NET USE U: /DELETE. The ECHO Y piped to NET USE replies to the
executable’s request for confirmation that we want to disconnect from the
share.

To remotely execute this series of batch files on the target machines a
Process Task needs to be created in Netfinity Director. To create a new
Process Task, under the Tasks pane expand Process Management, right
click Process Task and select Open from the pop-up menu.

Figure 88. Creating a new process task

A Process Task window appears. In the Command field enter
\\23ff458\Archive\Scripts\BOOST.BAT and in the Login section enter the user
ID and password for an account with the proper permissions to access the
machine and run the executable.
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Figure 89. Creating the PC Doctor unistaller process task

Save the new Process Task by clicking File, selecting Save As from the
pull-down menu, entering a name for the task in Save As window, and clicking
OK.

Figure 90. Saving the process task

Close the Process Task window. The new task should appear under Process
Tasks in the Tasks pane.
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Figure 91. The PC Doctor Uninstaller

To execute the audit on a single remote machine, drag and drop the client
from the Group Contents pane on to the task. To assign multiple machines to
the task, use a group from the Groups pane containing the desired systems.
Either action causes a window to appear asking how you want the job
executed. It can be canceled, executed now, or scheduled for a later date.
Click Execute Now to run the audit immediately.

Figure 92. PC Doctor Uninstaller job schedule window

The Execution History window details the status of the task.
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Figure 93. PC Doctor Uninstaller task execution history window

Once the machine has completed its task, the PC Doctor application will have
been removed from the target system.

2.3.1.2 Modifying incompatible services under Windows NT 4.0
There are several ways to remotely change the settings for a service under
Windows NT 4.0. The least complicated involves a utility provided in the
Windows NT 4.0 Resource Kit called SC.EXE. This allows service states and
configurations to be changed from the command line. To stop and then
disable a service on remote systems using Netfinity Director, a process task
executing a batch file can be used.

The batch file for this example connects to the share point \\23ff458\Archive
to execute SC.EXE with the correct parameters to disable the win32SL service.
The two variables set at the beginning of the script describe the share point
where SC.EXE is stored and which service we want to disable. The next section
stops the service to be disabled via the command %SHARE%\SC.EXE STOP

%SERVICE%. This would be interpreted at the command prompt as
\\23ff458\Archive\Scripts\SC.EXE STOP win32sl. The batch file then disables
the service by executing %SHARE%\SC.EXE CONFIG %SERVICE% start= disabled. At
the command prompt this line appears as \\23ff458\Archive\Scripts\SC.EXE

CONFIG win32sl start= disabled. For further information about SC.EXE please
refer to the Microsoft Resource Kit 4.0 Support Tools documentation.
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To create the process task for disabling a Windows NT service, start at the
IBM Netfinity Director Console and expand Process Management under the
Tasks pane. Right-click Process Tasks and choose Open.

Figure 94. Creating a new process task

When the Process Task windows appears enter
\\23ff458\Archive\Scripts\SERVICED.BAT in the Command field. In the Login
section, provide the user ID and password for an account with the appropriate
permissions to execute the command. Click File and select Save As from the
pull-down menu.

REM This script uses the Microsoft Windows NT Resource Kit tool SC.EXE to stop
REM and then disable a service on a remote machine through IBM Netfinity
REM Director.

SET SHARE=\\23ff458\Archive\Scripts
SET SERVICE=win32sl

%SHARE%\SC.EXE STOP %SERVICE%
%SHARE%\SC.EXE CONFIG %SERVICE% start= disabled

:END
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Figure 95. Saving the process task

In the Save As window enter a name for the task and click OK.

Figure 96. Saving the process task

Close the Process Task window. The new task should appear under Process
Tasks in the Tasks pane.

Figure 97. The Disable NT Service process task

To execute the audit on a single remote machine, drag and drop the client
from the Group Contents pane on to the task. To assign multiple machines to
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the task, use a group from the Groups pane containing the desired systems.
Either action will cause a window to appear asking how you want the job
executed: it can be canceled, executed now, or scheduled for a later date.
Click Execute Now to run the audit immediately.

Figure 98. Disable NT Service job schedule window

The Execution History window gets presented detailing the status of the task.

Figure 99. Execution history window

Once all of the systems have finished processing the win32sl service will
appear as disabled under Control Panel -> Services on the target machine.
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Figure 100. Disabled win32sl service

2.3.2 Updating BIOS and changing CMOS settings
On some older machines it may be necessary to update the BIOS or change
the CMOS configuration of the client to allow the proper function of Windows
2000 Professional. Information about BIOS updates for IBM Personal
Computers can be found at http://www.pc.ibm.com/support. In a situation
where a large number of machines require such an upgrade, it can become
time consuming and expensive to manually update each machine. A solution
to this problem can be done with the BIOS and CMOS update function of
LANClient Control Manager (LCCM). LCCM is capable of remotely flashing
the BIOS and modifying the CMOS settings of a target machine across the
network. A simple GUI interface is used to configure and deploy the new
images.

Note: In order for BIOS or CMOS updates to work (or any LCCM function),
the system must be known to LCCM. This usually happens during a scan
process. In this case, the system must be set to boot from the network. If it’s
powered off, it has to be Wake on LAN-enabled (or left powered on).

2.3.2.1 Upgrading BIOS remotely via LCCM
Flashing the BIOS of a remote client via LCCM is a two-step process. First
the BIOS image must be converted into a format that can be used by LCCM,
then the target machine is assigned to a maintenance profile and processed.
To create the BIOS update, start by obtaining the BIOS flash disk appropriate
for the target system. In the LANClient Control Manager Installation and
Maintenance window click Tools and from the resulting pull-down menu
select Import BIOS files -> Read BIOS flash disk.
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Figure 101. Importing BIOS image under LCCM

When the BIOS Flash Setup window appears, insert the BIOS Flash diskette
in the floppy drive and select its drive letter from the select drive drop-down
menu. The version of the update will appear in the Flash level window. Click
Setup.

Figure 102. Selecting flash disk for import

The floppy drive reads data from the disk for several seconds. Upon
completion, a window informs you that the BIOS flash diskette has been
copied successfully. The BIOS level is now ready to be assigned to a client
and processed.

The first step in requesting a BIOS flash for a system is to open its Individual
Client Details. From the LCCM Installation and Maintenance window, highlight
the system you want to open in the Unassigned Clients pane. Click Client
and choose Configure from the drop-down menu.
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Figure 103. Opening the individual client settings

The LANClient Control Manager Individual Client Details window is
sometimes presented with the Details page open. Click the Maintenance tab
to reveal the BIOS and CMOS setup options. Select the desired BIOS level
from the pull-down menu. This automatically places a mark in the Update
BIOS check box thereby enabling a remote flash for this machine. Select the
desired language from the Language drop-down and click OK to assign the
image to the client.

Figure 104. Selecting BIOS level for update

We are returned to the LCCM Installation and Maintenance window. Click
Process to start the remote BIOS flash. For further information on this
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procedure please refer to Using LCCM Functions with Servers and
Workstations, SG24-5292 or the product documentation.

2.3.2.2 Changing CMOS configuration remotely
Modifying the CMOS settings for a client is a simple procedure that has
elements on both the client and the LANClient Control Manager Server. On
the client side, a single machine is be used as the donor for the captured
CMOS settings. The resulting CMOS image is then transferred to the LCCM
server and distributed over the network to selected machines with the same
BIOS level as the donor.

Select a donor machine that has the same BIOS level as the target systems.
The CMOS changes can only be transferred to the matching BIOS level that
they were captured from. Enter the BIOS Configuration/Setup Utility by
pressing the F1 key at the IBM splash screen during system POST. Make the
needed modifications to the configuration, save the settings, and reboot to a
DOS operating system. For this example we used Windows 98 Second
Edition. To capture the CMOS settings, one of three command line utilities is
used: SRCMOS.EXE, SRCMOSNV.EXE, or CMOSUTIL.EXE. One of them will be on the
BIOS flash disk for the level being modified. Place the appropriate BIOS flash
disk in the floppy drive and open a command prompt. For BIOS level 49a the
executable SRCOMOSNV.EXE is used; therefore, the command to capture the
current CMOS configuration would be A:\SRCMOSNV C:\TEMP\300PL.CMS

/CAPTURE. This creates the file 300PL.CMS in C:\TEMP. Transfer the file
containing the captured CMOS settings to the LCCM server. In our example
we used E:\LCCM\CLNTFILE\BIOS\NVJT49A\300PL.CMS.

Make sure that you shut down the target system and power it off. It should
get powered on by the Wake on LAN function.

Note: Captured CMOS settings can only be transferred to machines with the
same BIOS level as the donor.

Note: The CMOS capture utilities will not work at a Windows NT command
prompt. Boot a DOS disk to allow the capture of CMOS settings on a
Windows NT system.

Move to the LANClient Control Manager server and from the LCCM
Installation and Maintenance window, highlight the system you want to open
in the Unassigned Clients pane. Click Client and choose Configure from the
drop-down menu.
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Figure 105. Opening the individual client settings

The LANClient Control Manager Individual Client Details window is presented
with the Details page open. Click the Maintenance tab to reveal the BIOS
and CMOS Setup options. Select which CMOS configuration file to use by
clicking Browse across from Update CMOS with file.

Figure 106. Selecting CMOS configuration file

A window requesting the location and name of the file will appear. Navigate to
the file’s location, highlight it, and click Open.
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Figure 107. Locating the CMOS configuration file

The LANClient Control Manager Individual Client Details window will
reappear. Click the Update CMOS with file check box and select OK.

Figure 108. Enable Update CMOS with file

You are returned to the LCCM Installation and Maintenance window. Click
Process to start the remote CMOS update. For further information on this
procedure please refer to Using LCCM Functions with Servers and
Workstations, SG24-5292 or the product documentation.

2.4 Upgrading to Windows 2000 Professional

The simplest path to deploying Windows 2000 Professional is its unattended
upgrade capability. The majority of the system configuration settings are
migrated to Windows 2000 along with existing data directories and
applications that have the capability of being transferred from a legacy
software platform. The one major drawback of this process is that the
upgrade can only be initiated from within the active target operating system.
One way around this restriction is to use Netfinity Director to distribute the
task to running clients.

2.4.1 Unattended upgrade to Windows 2000 Professional
An unattended upgrade from Windows 98 Second Edition or Windows NT 4.0,
Service Pack 6a can be started remotely through a Netfinity Director process
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task. The procedure is performed in three parts: system preparation,
uninstallation of Universal Management Services, and Windows 2000
Professional unattended installation. Each part, or phase, is executed by a
separate Visual Basic Script run under Windows Scripting Host Version 5.1.

The first step in setting up the upgrade process requires the creation of a
share point for both the Windows 2000 Professional installation files and the
Visual Basic Scripts. In this example, the shared folder has already been
created. The directory C:\Archive has been shared as \\23ff458\Archive. We
then created a subdirectory called W2KPro and copied the x:\I386
subdirectory from the Windows 2000 Professional CD-ROM to
C:\Archive\W2KPro. This will result in a share point called
\\23ff458\Archive\W2KPro\I386. An additional directory,
C:\Archive\W2KPro\Scripts, was created for the script files. Table 9 on page
87 illustrates the share names and their locations.

Table 9. Share point for Windows 2000 Migration example

Now that the share point has been established the script files can be created.
All of the script files used in this example are presented full length in
Appendix B, “Scripts for the Windows 2000 upgrade example” on page 335.
The first phase of the remote upgrade, system preparation, is performed by
BOOST.VBS. The first section of this script sets up the Windows Shell Script
and Visual Basic objects used in the rest of the file.

Next, the script checks to see what operating system is installed and calls the
appropriate subroutine. If (WSHEnvironment("OS")="Windows_NT") uses the
%OS% Windows NT environment variable to determine if the machine is
running Windows NT. If the query indicates that %OS% is equal to
Windows_NT then sysdir =
WSHShell.ExpandEnvironmentStrings("%SystemRoot%") is executed to set
the variable sysdir to the Windows NT installation directory and Call NT() is

Purpose Directory Name Share Name

Windows 2000 installation
files share point

C:\Archive\W2KPro\I386 \\23ff458\Archive\W2KPro\I386

Script file share point C:\Archive\W2kPro\Scripts \\23ff458\Archive\W2KPro\Scripts

' Set up the required objects
Dim WSHShell,FSO
Set WSHShell = WScript.CreateObject("WScript.Shell")
Set FSO = CreateObject("Scripting.FileSystemObject")
Set WSHEnvironment = WSHShell.Environment
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used to move us to the NT() subroutine. If the check fails then the
environment variable sysdir is set to the Windows 98 installation directory and
the subroutine W98() is called.

The subroutine for Windows NT starts off by copying the Microsoft Windows
Resource Kit file SHUTDOWN.EXE from the sharepoint to the target machine
from the sharepoint by FSO.Copyfile

"\\23ff458\Archive\W2KPro\Scripts\SHUTDOWN.EXE", sysdir + "\". This
executable is used to reboot or shut down Windows NT systems from the
command line. The next series of instructions, which appear under the Create
the Autologon entries to be used with the Startup Folder process section,
write the appropriate registry entries to enable an Autologon for the next
reboot. FSO.CopyFile "\\23ff458\Archive\W2KPro\Scripts\PREUPGRD.VBS",

sysdir + "\Profiles\Administrator\Start Menu\Programs\Startup\" copies
PREUPGRD.VBS to the system’s Startup folder for the account being used
with Autologon. This script is the second part of the upgrade process and will
be executed once the system reboots and the contents of the Startup folder
are executed. The last entry in this subroutine, WSHShell.Run "SHUTDOWN /L /R

/T:0 /Y /C",0, runs the SHUTDOWN command with options that tell the system to
immediately reboot the machine.

Note: PREUPGRD.VBS cannot be run directly via a task process.
PREUPGRD.VBS uninstalls Universal Manageability Services; therefore,
once UM Services is removed, the task process is complete and the script will
end. Since the system needs to be rebooted after the removal of UM Services
the script will not be able to perform this action remotely. That is why the
script is set up to be executed automatically on the target system.

Note: PREUPGRD.VBS on the Windows NT platform can be placed in a
Runonce registry entry. This is not done here to be consistent with the
method employed for Windows 98. The method used to reboot Windows 98
has a restriction which prevents the use of Runonce with this script.

' Check what operating system is running on the target machine, set the sysdir
‘ variable, and run the appropriate subroutine
If (WSHEnvironment("OS")="Windows_NT") Then

sysdir = WSHShell.ExpandEnvironmentStrings("%SystemRoot%")
Call NT()

Else
sysdir = WSHShell.ExpandEnvironmentStrings("%windir%")
Call W98()

End If
WScript.Quit
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The Windows 98 subroutine, W98(), follows the same basic principle as the
NT() subroutine. The Microsoft utility TWEAKUI.CPL is copied from the share
point to the target machine using the instruction FSO.CopyFile

"\\23ff458\Archive\W2KPro\Scripts\TWEAKUI.CPL", sysdir + "\system\". This
file is used to facilitate the Autologon process under Windows 98. The next
section, Create the Autologon entries to be used with the Startup Folder
process, contains several instructions to write Autologon information to the
registry. The entry WSHShell.RegWrite

"HKLM\Software\Microsoft\Windows\CurrentVersion\RunServicesOnce\Tweak UI",

"RUNDLL32.EXE TWEAKUI.CPL,TweakLogon sets up the TWEAKUI Autologon
service to run once, which allows the Windows 98 client to automatically log
on. The script now copies the file PREUPGRD.VBS to the target machine’s
Startup folder for the account set in the Autologon section. This script is the
second part of the upgrade process and will be executed once the system
reboots and the contents of the Startup folder are executed. The final
instruction in the subroutine, WSHShell.Run "rundll32

shell32.dll,SHExitWindowsEx 2",0, tells the system to immediately reboot.

Note: PREUPGRD.VBS can’t be executed from Runonce on a Windows 98
system. SHELL32.EXE is used in conjunction with SHELL32.DLL to reboot
the machine. When SHELL32.EXE is called it automatically executes the
contents of the Runonce registry entry. Since the last action of the script is to
reboot the system, any commands placed in Runonce are immediately
executed. PREUPGRD.VBS is placed in the Startup folder of the Autologon
account to avoid this problem.

Note: WSHShell.Run "rundll32 shell32.dll,SHExitWindowsEx 2",0 will not work
under Windows 95. The SHExitWIndowsEx function is only supported under
Windows 98. To restart a Windows 95 machine try rundll.exe user.exe,

exitwindowsexec EW_REBOOTSYSTEM, 0. This method has not been tested with the
scripts contained in the example.

' Subroutine for Windows NT 4.0 Operating System
Sub NT()
' Copy the file needed for rebooting Windows NT
FSO.Copyfile "\\23ff458\Archive\W2KPro\Scripts\SHUTDOWN.EXE", sysdir + "\"

' Create the Autologon entries to be used with the Startup Folder process
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows NT\CurrentVersion\Winlogon\AutoAdminLogon", 1
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows NT\CurrentVersion\Winlogon\DefaultPassword", "password"
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows NT\CurrentVersion\Winlogon\DefaultUserName", "administrator"

' Copy PREUPGRD.VBS to the Startup Folder
FSO.CopyFile "\\23ff458\Archive\W2KPro\Scripts\PREUPGRD.VBS", sysdir +
"\Profiles\Administrator\Start Menu\Programs\Startup\"

' Reboot the system
WSHShell.Run "SHUTDOWN /L /R /T:0 /Y /C",0

End Sub
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The next phase of upgrading to Windows 2000 Professional, uninstallation of
Universal Manageability Services, is performed by the script
PREUPGRD.VBS. The first section of this script sets up the Windows Shell
Script and Visual Basic objects used in the rest of the file.

The script checks to see what operating system is installed and calls the
appropriate subroutine. If (WSHEnvironment("OS")="Windows_NT") uses the %OS%
Windows NT environment variable to determine if the machine is running
Windows NT. If the query indicates that %OS% is equal to Windows_NT then
sysdir = WSHShell.ExpandEnvironmentStrings("%SystemRoot%") is executed to set the
variable sysdir to the Windows NT installation directory and Call NT() is used
to move us to the NT() subroutine. If the check fails then the environment
variable sysdir is set to the Windows 98 installation directory and the
subroutine W98() is called.

Subroutine for Windows 98 Second Edition Operating System
Sub W98()
' Copy the file needed for AutoLogon under Windows 98
FSO.CopyFile "\\23ff458\Archive\W2KPro\Scripts\TWEAKUI.CPL", sysdir + "\system\"

' Create the Autologon entries to be used with the Startup Folder process
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows\CurrentVersion\Winlogon\AutoAdminLogon", 1
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows\CurrentVersion\Winlogon\DefaultPassword",

"password"
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows\CurrentVersion\Winlogon\DefaultUserName",

"administrator"
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows\CurrentVersion\RunServicesOnce\Tweak UI",

"RUNDLL32.EXE TWEAKUI.CPL,TweakLogon"

' Copy PREUPGRD.VBS to the Startup Folder
FSO.CopyFile "\\23ff458\Archive\W2KPro\Scripts\PREUPGRD.VBS", sysdir + "\startm~1\Programs\StartUp\"

' Reboot the system
WSHShell.Run "rundll32 shell32.dll,SHExitWindowsEx 2",0

' Set up the required objects
Dim WSHShell, FSO
Set WSHShell = WScript.CreateObject("WScript.Shell")
Set FSO = CreateObject("Scripting.FileSystemObject")
Set WSHEnvironment = WSHShell.Environment
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The Windows NT subroutine starts off in the Create the Autologon entries to
be used with the Runonce section by creating the registry entries needed for
Autologon. These will be used in conjunction with the reboot required to fully
uninstall UM Services and start the Windows 2000 Upgrade process. UM
Services is uninstalled next by executing the instruction WSHShell.Run

"%COMSPEC% /C %SystemRoot%\uninsums.exe /u",0. Script execution is now
moved to the Wait() subroutine by Call Wait(). This subroutine monitors the
existence of the UM Services uninstallation file. When the file is removed it
waits for a brief amount of time and returns control to the section that called
it. This is necessary since the command line UM Services uninstaller does
not have a reboot option. If the SHUTDOWN command that appears later in
the script were called too early the removal of Universal Manageability
Services would be interrupted. This subroutine ensures the uninstall of UM
Services completes before the NT() subroutine continues. Wait() is examined
more closely in Sub Wait() on page 93. After Wait() returns to the NT()
subroutine the Runonce registry entry for the next phase, W2KUPGRD.VBS,
is added by WSHShell.RegWrite

"HKLM\Software\Microsoft\Windows\CurrentVersion\Runonce\W2KUPGRD",

"CSCRIPT \\23ff458\Archive\W2KPro\Scripts\W2KUPGRD.VBS"

Note: Any Runonce registry entries under Windows NT must be made after
UMS is uninstalled from the command line. Entries made before the
uninstallation will be removed.

A reboot is called next by using the instruction WSHShell.Run "SHUTDOWN /L /R

/T:0 /Y",0. Finally, just before the system reboots, the file is removed from
the Startup folder by FSO.DeleteFile(sysdir + "\Profiles\Administrator\Start

Menu\Programs\Startup\PREUPGRD.VBS").

' Check what operating system is running on the target machine, set the sysdir
‘ variable, and run the appropriate subroutine
If (WSHEnvironment("OS")="Windows_NT") Then
sysdir = WSHShell.ExpandEnvironmentStrings("%SystemRoot%")
Call NT()

Else
sysdir = WSHShell.ExpandEnvironmentStrings("%windir%")
Call W98()

End If
WScript.Quit
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The Windows 98 subroutine mirrors the flow of NT(). It begins by writing the
Autologon registry entries for the administrator account and creating a
RunServicesOnce entry for TWEAKUI.CPL. Next, a Runonce entry is created
for the last phase of the Windows 2000 Professional install, and
W2KUPGRD.VBS is added by WSHShell.RegWrite

"HKLM\Software\Microsoft\Windows\CurrentVersion\Runonce\W2KUPGRD", sysdir +

"\COMMAND\CSCRIPT \\23ff458\Archive\W2KPro\Scripts\W2KUPGRD.VBS"

Note: Uninstalling UM Services under Windows 98 does not disable Runonce
entries as it does under Windows NT; however, it does stop RUNDLL32.EXE
from automatically running the contents of Runonce. This is why a Runonce
entry can be used with Windows 98 in this section.

Once the preparation for the reboot has been completed the uninstallation of
UM Services is started by WSHShell.Run "%COMSPEC% /C %windir%\uninsums.exe

/u",0. As with the NT() subroutine, this process is monitored by the Wait()
subroutine which is called by the next entry Call Wait(). Once released by
Wait(), the W98() subroutine uses WSHShell.Run "rundll32

shell32.dll,SHExitWindowsEx 2",0 to reboot the system. The last action of the
script, just before it restarts, is to execute FSO.DeleteFile(sysdir +

"\startm~1\Programs\StartUp\PREUPGRD.VBS"). This will remove the file
PREUPGRD.VBS from the Startup folder.

' Subroutine for Windows NT 4.0 Operating System
Sub NT()
' Create the Autologon entries to be used with the Runonce
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows NT\CurrentVersion\Winlogon\AutoAdminLogon", 1
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows NT\CurrentVersion\Winlogon\DefaultPassword",
"password"
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows NT\CurrentVersion\Winlogon\DefaultUserName",
"administrator"

' Running the command to uninstall Universal Management Services
WSHShell.Run "%COMSPEC% /C %SystemRoot%\uninsums.exe /u",0

' Call the subroutine wait which delays reboot until the uninstallation finishes
Call Wait()

' Add the Runonce entry for W2KUPGRD.VBS
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows\CurrentVersion\Runonce\W2KUPGRD", "CSCRIPT

\\23ff458\Archive\W2KPro\Scripts\W2KUPGRD.VBS"

' Reboot the machine
WSHShell.Run "SHUTDOWN /L /R /T:0 /Y",0

' Delete the Startup Folder process
FSO.DeleteFile(sysdir + "\Profiles\Administrator\Start Menu\Programs\Startup\PREUPGRD.VBS")

End Sub
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The final subroutine in this script, Wait(), monitors the status of the UM
Services uninstall process. One of the last files that is deleted by the
uninstallation process is UNINSUMS.EXE. If (FSO.FileExists(sysdir +

"\uninsums.exe")) Then checks to see if the file exists. If it still does, it
executes WScript.Sleep 30000. This causes the script to delay for 30000
milliseconds. It then calls itself again to complete a loop until
UNINSUMS.EXE is removed. Once the file is deleted, the subroutine will
hand control back over to the section of script that called it.

Now that all of the ground work has been laid, the last reboot in this process
will call the unattended upgrade installation of Windows 2000 Professional.
The final script, W2KUPGRD.VBS, starts off by setting up all of the required
objects.

Sub W98()
' Create the Autologon entries to be used with the Runonce
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows\CurrentVersion\Winlogon\AutoAdminLogon", 1
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows\CurrentVersion\Winlogon\DefaultPassword", "password"
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows\CurrentVersion\Winlogon\DefaultUserName",
"administrator"
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows\CurrentVersion\RunServicesOnce\Tweak UI",
"RUNDLL32.EXE TWEAKUI.CPL,TweakLogon"

' Add the Runonce entry for W2KUPGRD.VBS
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows\CurrentVersion\Runonce\W2KUPGRD",
sysdir + "\COMMAND\CSCRIPT \\23ff458\Archive\W2KPro\Scripts\W2KUPGRD.VBS"

' Run the command to uninstall Universal Management Services
WSHShell.Run "%COMSPEC% /C %windir%\uninsums.exe /u",0

' Call the subroutine wait which delays reboot until the uninstallation finishes
Call Wait()

' Reboot the machine
WSHShell.Run "rundll32 shell32.dll,SHExitWindowsEx 2",0

' Delete the Startup Folder process
FSO.DeleteFile(sysdir + "\startm~1\Programs\StartUp\PREUPGRD.VBS")

End Sub

' Subroutine that waits for the uninstallation of UMS to complete.
Sub Wait()
If (FSO.FileExists(sysdir + "\uninsums.exe")) Then
WScript.Sleep 30000
Call Wait

End If
End Sub
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The next step is to connect to the Windows 2000 Professional sharepoint.
This is accomplished by the instruction WSHNetwork.MapNetworkDrive "Z:",

"\\23ff458\archive". In our example \\23ff458\archive is mapped to Z:.

The script determines what operating system is installed and calls the
appropriate subroutine. If (WSHEnvironment("OS")="Windows_NT") uses the %OS%
Windows NT environment variable to determine if the machine is running
Windows NT. If the query indicates that %OS% is equal to Windows_NT then
sysdir = WSHShell.ExpandEnvironmentStrings("%SystemRoot%") is executed to set the
variable sysdir to the Windows NT installation directory and Call NT() is used
to move us to the NT() subroutine. If the check fails then the environment
variable sysdir is set to the Windows 98 installation directory and the
subroutine W98() is called.

The Windows NT 4.0 subroutine, NT(), first removes the Autologon registry
entries using the instructions contained in the Remove the AutoLogon
Registry Entries section. Next, the file SHUTDOWN.EXE is deleted from the
system since it is not longer needed. The last instruction WINNTCMD =

WSHShell.Run("%COMSPEC% /C Z:\W2KPro\I386\WINNT32

/UNATTEND:Z:\W2KPro\Scripts\NT4UPGRD.TXT",1,TRUE) starts the Windows 2000
Professional upgrade from the Windows NT 4.0 platform. WINNT32.EXE is run
from the Z:\W2KPro\I386 directory on the distribution point and the answerfile
NT4UPGRD.TXT is pulled from Z:\W2KPro\Scripts\.

' Set up the required objects
Dim WSHShell,WSHNetwork,FSO
Set WSHShell = WScript.CreateObject("WScript.Shell")
Set WSHNetwork = WScript.CreateObject("WScript.Network")
Set FSO = CreateObject("Scripting.FileSystemObject")
Set WSHEnvironment = WSHShell.Environment

' Map Windows 2000 Professional sharepoint
WSHNetwork.MapNetworkDrive "Z:", "\\23ff458\archive"

' Check what operating system is running on the target machine and run the appropriate

If (WSHEnvironment("OS")="Windows_NT") Then
Call NT()

Else
Call W98()

End If
WScript.Quit
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NT4UPGRD.TXT instructs Windows 2000 Professional to perform a full
unattended upgrade of Windows NT 4.0. It will attempt to use all of the
settings from Windows NT to guide the installation of Windows 2000. For
further information on the creation of Windows 2000 Professional unattended
installation answer files please refer to Microsoft’s White Paper Deployment
Guide: Automating the Windows 2000 Upgrade and MS Windows 2000
Unattended Setup Parameters Guide. Both may be found at:
http://www.microsoft.com/technet/win2000/ by searching for the document
title.

The Windows 98 subroutine, W98(), follows the same basic path as NT(). It
starts by removing the registry entries associated with Autologon. This is
done in section Remove the Autologon Registry Entries. The next section
removes the TWEAKUI.CPL file using
FSO.DeleteFile(WshShell.ExpandEnvironmentStrings("%WinDir%" +

"\system\TWEAKUI.CPL")). The final instruction for Windows 98 in this script
initiates the Windows 2000 upgrade. WIN98CMD = WSHShell.Run("%COMSPEC% /C

Z:\W2KPro\I386\WINNT32 /UNATTEND:Z:\W2KPro\Scripts\W98UPGRD.TXT",1,TRUE)

runs WINNT32.EXE from the distribution share Z:\W2KPro\I386\ using the
answer file W98UPGRD.TXT. The answer file is kept in Z:\W2KPro\Scripts.

' Subroutine for Windows NT 4.0 Operating System
Sub NT()
' Remove the AutoLogon Registry Entries
WSHShell.RegDelete("HKLM\Software\Microsoft\Windows NT\CurrentVersion\Winlogon\AutoAdminLogon")
WSHShell.RegDelete("HKLM\Software\Microsoft\Windows NT\CurrentVersion\Winlogon\DefaultPassword")
WSHShell.RegDelete("HKLM\Software\Microsoft\Windows NT\CurrentVersion\Winlogon\DefaultUserName")

' Remove the Windows NT Shutdown utility
FSO.DeleteFile(WshShell.ExpandEnvironmentStrings("%SystemRoot%" + "\SHUTDOWN.EXE"))

' Run the Windows 2000 Professional upgrade
WINNTCMD = WSHShell.Run("%COMSPEC% /C Z:\W2KPro\I386\WINNT32
/UNATTEND:Z:\W2KPro\Scripts\NT4UPGRD.TXT",1,TRUE)

End Sub

[Unattended]
Unattendmode = FullUnattend
OemPreinstall = No
OemSkipEula = Yes
NtUpgrade = Yes

[UserData]
ProductID = XXXXX-XXXXX-XXXXX-XXXXX-XXXXX
Chapter 2. Upgrade of clients to Windows 2000 95

http://www.microsoft.com/technet/win2000/
http://www.microsoft.com/technet/win2000/


W98UPGRD.TXT instructs Windows 2000 Professional to perform a full
unattended upgrade of Windows 98 SE. It will attempt to use all of the
settings from Windows NT 4.0 to guide the installation of Windows 2000. For
further information on the creation of Windows 2000 Professional unattended
installation answer files please refer to Microsoft’s White Paper Deployment
Guide: Automating the Windows 2000 Upgrade and MS Windows 2000
Unattended Setup Parameters Guide. Both may be found at
http://www.microsoft.com/technet/win2000/ by searching for the document
title.

To create the process task for the unattended upgrade of Windows 2000
Professional start at the IBM Netfinity Director Console and expand Process
Management under the Tasks pane. Right-click Process Tasks and choose
Open.

' Subroutine for Windows 98 Second Edition Operating System
Sub W98()
' Remove the AutoLogon Registry Entries
WSHShell.RegDelete("HKLM\Software\Microsoft\Windows\CurrentVersion\Winlogon\AutoAdminLogon")
WSHShell.RegDelete("HKLM\Software\Microsoft\Windows\CurrentVersion\Winlogon\DefaultPassword")
WSHShell.RegDelete("HKLM\Software\Microsoft\Windows\CurrentVersion\Winlogon\DefaultUserName")

' Remove the Windows 98 AutoLogon utility
FSO.DeleteFile(WshShell.ExpandEnvironmentStrings("%WinDir%" + "\system\TWEAKUI.CPL"))

' Run the Windows 2000 Professional Upgrade
WIN98CMD = WSHShell.Run("%COMSPEC% /C Z:\W2KPro\I386\WINNT32
/UNATTEND:Z:\W2KPro\Scripts\W98UPGRD.TXT",1,TRUE)

End Sub

[Unattended]
Win9xUpgrade=yes

[UserData]
ProductID=XXXXX-XXXXX-XXXXX-XXXXX-XXXXX

[Win9xUpg]
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Figure 109. Creating the Windows 2000 Professional upgrade task

When the Process Task window appears enter
\\23ff458\Archive\W2KPro\Scripts\BOOST.VBS in the Command field. In the
Login section, provide the user ID and password for an account with the
appropriate permissions to execute the command. Click File and select Save
As from the pull-down menu.

Figure 110. Saving the Windows 2000 Professional upgrade task

In the Save As window enter a name for the task and click OK.
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Figure 111. Naming the Windows 2000 Professional upgrade task

Close the Process Task window. The new task should appear under Process
Tasks in the Tasks pane.

Figure 112. The Windows 2000 Professional upgrade task.

To execute the upgrade process on a single remote machine, drag and drop
the client from the Group Contents pane on to the task. To assign multiple
machines to the task, use a group from the Groups pane containing the
desired systems. Either action will cause a window to appear asking how you
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want the job executed. It can be canceled, executed now, or scheduled for a
later date. Click Execute Now to run the Windows 2000 Professional upgrade
process immediately.

Figure 113. Scheduling the Windows 2000 Professional upgrade task

The Execution History window gets presented detailing the status of the task.

Figure 114. Execution history for the WIndows 2000 upgrade process task

Once all of the systems have finished processing, the upgrade will have
begun on the target systems. This is indicated by a series of three reboots
and on the final restart, windows relating to the upgrade will be presented.
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Figure 115. The Windows 2000 Professional process task running
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Chapter 3. Unattended Windows 2000 deployment for new systems

This chapter shows how to use LCCM for deploying Windows 2000 on new
systems (not upgrades). This is done for both a client and a server.

3.1 LCCM

LANClient Control Manager (LCCM) is IBM’s tool for automating the
deployment of operating systems as well as additional applications. As a part
of the Universal Manageability offering it simplifies the deployment
procedures, and once it is set up, allows for the repetition of that process.

For the most current information on LCCM or for downloading installation
code and updates, please go to:

http://www.pc.ibm.com/us/desktop/lccm/

Our intention for this chapter is to show the use of LCCM in deploying
Windows 2000 operating systems on typical IBM machines. In our examples
we set up two different scenarios:

1. Unattended installation of Windows 2000 Professional on an IBM PC
300PL

2. Unattended installation of Windows 2000 Server on an IBM Netfinity 3000

Together with the operating system, it is often necessary to install additional
applications. This is shown in our examples using a utility within LCCM called
DiffTool. Norton AntiVirus was chosen as an example application.

For all client examples in this chapter we used the following hardware
environment: PC 300PL desktop machines and Netfinity 3000 Servers
connected to the network using on-board Etherjet controllers through an IBM
8222 10 Mbps Ethernet hub.

The LCCM server was installed on a Windows NT Server machine with
Service Pack 6a. Another machine was running the Microsoft DHCP service.
For a detailed description of LCCM and the installation and setup procedure,
please see Using LCCM Functions with Servers and Workstations,
SG24-5292 and readmeSP3.txt file from Service Pack 3.

To be able to deploy Windows 2000 clients, it is necessary to upgrade the
LCCM V2.5.1 code with Service Pack 3.
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Note: We were working with beta code, because Service Pack 3 was not
generally available at the time this book was written.

To upgrade to SP3, log on to the server using an account with administrative
privileges. Make sure that LCCM is not running and execute the downloaded
file lccmsp3.exe.The upgrade process preserves the settings and existing
profiles. Following are the new features in SP3:

• Profile wizard supports unattended installation of Windows 2000
Professional, Server and Advanced server.

• Profile wizard supports unattended installation of Windows 98 with the
latest Service Pack 1 and Windows 98 Second Edition.

• Profile wizard supports Windows NT 4.0 Service Packs 3, 4, 5, 6 and 6a.
• Profile wizard allows true maximum size NTFS and FAT32 partitions.
• New IBM systems and network adapters are supported. For the complete

list please see the updated Compatibility and Configuration Guide on the
following IBM Web page:

http://www.pc.ibm.com/us/desktop/lccm/compat.html

• Profile wizard supports installing IBM UM Services V2.11 (instead of
UMA) as part of an unattended installation profile.

• Profile wizard supports built-in integration with IBM System Migration
Assistant V2.1.

• DiffTool supports application installation during Windows 2000
Professional, Server and Advanced Server unattended installation.

You can find a complete list of changes and additions in the readmeSP3.txt
file that comes with the Service Pack 3 installation file.

3.1.1 Unattended install of Windows 2000 Professional on a client
After you have successfully scanned in the clients (using the procedure
described in the redbook Using LCCM Functions with Servers and
Workstations, SG24-5292) and before you can start the actual deployment,
the installation profile, which contains various configuration files and
parameters, needed for the LCCM installation, has to be created. The easiest
way to do this is by using the Profile wizard.

The Profile wizard leads you through a series of windows, asking questions
about options necessary for the installation.

3.1.1.1 Creating a software profile using the Profile wizard
Start the LCCM program if it is not already started and click Profile -> Create
new.
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Figure 116. Creating new profiles

A pop-up window asks whether you want to create a profile manually or use a
wizard. Click Use the Profile Wizard.
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Figure 117. Starting the Profile Wizard

The welcome screen is opened. Here you are asked to provide the following
information:

• Profile Name: Enter desired name, which identifies this profile later in the
Profiles and Assigned Clients pane of the main LCCM window.

• Installation method: Select Unattended Install and select the check box
Do you also want to install applications with this profile?

• Operating system you wish to install: Select Windows 2000 Professional.
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Figure 118. Profile Wizard

In the next window select the language for the Windows 2000 Professional
operating system you would like to install:
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Figure 119. Supported international language selection

If your machine has a RAID adapter installed click Yes, the target clients
have RAID adapters installed check box and specify file name and location
of an existing RAID configuration, then click Next.
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Figure 120. RAID Adapter Setup

If you want to create a local backup of the entire client installation partition
click Yes, create a hidden local copy of the entire client image option in
the next window.

If this option is enabled, the maximum size of the working partition will be
limited to half of the available hard disk space minus 5 MB used for
administrative purposes.

For a detailed explanation of the Rapid Restore please see 3.1.3, “Rapid
Restore” on page 169 or the LCCM V2.5.1 Training and Procedures Guide.

Note: If you have selected the RAID option on the previous window, the
Rapid Restore option will not be available.
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Figure 121. IBM Rapid Restore Partition Setup

Next, you specify the size and organization of the client’s hard disk. The
following options are available:

1. Single partition of fixed size

2. Single partition using maximum available space

3. First partition of fixed size, and second partition using remaining allowed
space

Select appropriate option and insert the partition size value for options 1 and
3.

You also have to decide on the file system to be used for formatting all client
partitions. Choose from:

• FAT16
• FAT32
• NTFS

Note: To install the Windows 2000 operating system using the Profile Wizard
the minimum installation partition size is 1800 MB. If you want to install on a
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smaller partition, you need to create the profile manually, but we do not
recommend you do it manually.

Figure 122. Target Machine’s Disk Setup

Note: NTFS formatting of a selected partition is done for you automatically. It
starts with a FAT32 partition and then it automatically converts it for you to
NTFS.

From the Profile Customization window you can customize the installation
profile by providing the Company Name (this is required by the operating
system installation procedure).

If you want to change the background of the client computer click the Specify
bitmap to be used as default desktop wallpaper check box and select the
bitmap file name and location.

If your company uses multi-user licensing, you can enter the CD key in the
space provided.
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Figure 123. Profile Customization

LCCM can be used to deploy the user settings, previously collected using the
System Migration Assistant (SMA). Select the SMA check box to enable this
option during the Profile wizard creation. For a more detailed SMA
explanation please refer to 5.1, “System Migration Assistant” on page 211.
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Figure 124. Deploying user settings gathered previously with SMA

Select the appropriate time zone in the Regional Settings window:
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Figure 125. Regional Settings

Next, several windows concerning networking settings appear. On the first, as
shown in Figure 126 on page 113, choose between Workgroup or Domain
according to the networking environment into which this client will connect.
Enter the workgroup/domain name as well.

In order to be able to connect with this client, at least one of the provided
network protocols has to be enabled (NetBEUI and TCP/IP are enabled by
default).
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Figure 126. Workgroup/Domain and network protocol selection

If you selected TCP/IP, you have to decide how the client will get its IP
address. Click Obtain IP addresses from a DHCP Server to configure the
client dynamically or select Configure TCP/IP settings manually and enter
the subnet mask and Default gateway (optional) information.
Chapter 3. Unattended Windows 2000 deployment for new systems 113



Figure 127. TCP/IP Configuration window

If static TCP/IP configuration was selected, the next window pops up so you
can configure WINS or DNS services for the client.
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Figure 128. WINS and DNS Configuration window

In the following window you can select additional applications to install along
with the operating system.

Note: If there are no applications available with this operating system you can
use the DiffTool (before you create the profile) to add an application to the
LCCM client deployment process. For the detailed procedure please refer to
3.1.1.3, “Adding applications to LCCM using DiffTool” on page 135.
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Figure 129. Application Selection window

Now the Profile Summary window appears. Here you can verify the settings
of the current profile and type in the description for this profile. If you want to
make some changes to the profile just click the Back button to the desired
page. To proceed, click the Next button.
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Figure 130. Profile Summary window

Next you will start creating the installation images for the selected operating
system and applications by clicking the Build images button.
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Figure 131. Image Building window

On the confirmation window select Yes to start building the image(s).
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Figure 132. Image Building confirmation window

In the next step you have to provide the file name and location of the
operating system’s installation file. In our case it is the Winnt.exe file on the
Windows 2000 Professional installation CD.
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Figure 133. Locating image files

The Profile wizard will copy the Windows 2000 Professional installation files
from the CD’s I386 directory to the \LCCM\Clntfile\W2KPROF\eng directory
on the LCCM server.
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Figure 134. Copying image files

Click OK when the copying is finished.
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Figure 135. Finished copying image files

Now the installation profile is created and can be used to deploy the clients.
So, let’s step through the deployment process for installing the Windows 2000
Professional using the LCCM.

3.1.1.2 Assigning the client to the installation profile
There are mandatory client parameters such as computer name, operating
system license key, and computer description, which have to be provided for
every client installation. The Client Assignment wizard is a program that asks
you for these parameters and fills them into the installation profile before the
client is processed. This enables you to perform unattended deployments.

Note: You should go through this procedure for every client that needs a
parameter initialized.

If the client computer meets the hardware requirements defined by the
Windows 2000 Professional operating system (the procedure to determine
this is described in 2.2.1, “Use Netfinity Director to determine hardware and
software” on page 35), you can start the actual deployment by dragging the
client icon to the middle pane of LCCM and dropping it onto the previously
created installation profile, as shown in Figure 136. The advantage of using
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LCCM and Netfinity Director together is, you can first make sure you have the
right hardware, and then use LCCM for the deployment.

Figure 136. Starting the assignment wizard

The Client Assignment starts automatically and presents the welcome
window. The client name and the software profile to be deployed on it are
shown.
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Figure 137. Client Assignment Wizard

The first parameter you should type into the Customized Value field is the
name of the registered user for this client.

If there were some default values defined when creating the software profile
they would appear under Default Value (a procedure of entering default
values and skipping assignment wizard is described later in 3.1.2.2,
“Assigning the client using the default values” on page 165).
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Figure 138. Registered user

Enter the first part of a valid Windows 2000 Professional license key (usually
it is written on the backside of the installation CD case). Be careful of the
format, which includes a dash as the last character.
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Figure 139. First part of the license key

Type in the remainder of the license key as the second part.
126 Windows 2000 Deployment Using Universal Manageability



Figure 140. Second part of the license key

The default logon user ID should be entered. This is the user ID you will use
for the first logon of the client. The wizard is not asking for the password. Your
first logon (after deployment) will be with an empty password field, and you
will be required to change the password at that time.
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Figure 141. Default user ID

The next parameter that is requested is the description of the client computer.
This appears in the Network Identification tab in System Properties when the
client is installed. Enter it into the Customized Value field and click Next.
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Figure 142. Computer description

Note: If you chose a static IP configuration with this installation profile (as
shown in Figure 127 on page 114) you will be asked to provide a specific IP
address for this client. In this profile we selected the dynamic IP
configuration.

If you selected the SMA option for this software profile, two additional
windows will appear asking you to provide details about the SMA profile name
and location. Type in the name of the SMA profile first:
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Figure 143. SMA profile name

Next provide the location of the SMA profile. Type in the share name of the
remote machine on the network:
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Figure 144. SMA profile location

All the required parameters are now provided and the summary window will
appear. If you want to change some of the parameters click the Back button
to reach the desired window; otherwise click Finish to close the wizard.
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Figure 145. Client parameter summary

To start the client installation, click Process.
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Figure 146. Starting client deployment

This wakes up the client and starts the unattended installation of Windows
2000 Professional.

Note: If the client is not Wake on LAN-enabled, you have to power it on
manually.

The LCCM console tracks the client’s status and displays the installation
steps in a window similar to the one shown in Figure 147:
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Figure 147. LCCM - progress and errors

The client’s status line will change through several stages, as in this example:

1. Waiting for client to connect: when the client wakes up and boots it will
connect to the LCCM server.

2. Preprocessing the client: at this stage the hard disk of the client is
repartitioned and the client is restarted.

3. Waiting for client to connect: client reconnects and the installation files
are copied into the \INSTALL directory, created on the client; when
finished the client automatically reboots.

4. Windows 2000 setup stage: the text-based portion of the setup is carried
out, copying the Windows setup files and rebooting the client again.

5. Windows 2000 is completing GUI setup: GUI-based installation
continues, Convert.exe is automatically executed (if NTFS was chosen)
and the installation completes.

6. Copying down the maintenance image: the complete client’s primary
partition will be backed up if the Rapid Restore option was selected during
the profile creation.

7. Resynchronizing client.
8. Processing completed successfully.

If an error occurs during deployment, the client status will show a red X with
the corresponding error message.
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3.1.1.3 Adding applications to LCCM using DiffTool
LCCM can be used for installing applications together with the operating
system. There are two categories of applications:

• Native, which are already integrated into the LCCM interface (they depend
on the target operating system).

• Others, which you can add to the LCCM interface using the DiffTool.

At the time of writing this redbook, there were no native LCCM applications
available for the Windows 2000 operating system. Here we will examine the
procedure of using DiffTool to add applications to LCCM. As an example, we
chose Norton AntiVirus V5.02.04.

DiffTool is a wizard program that runs on a donor computer that can access
the LCCM server over the network. When run, it takes a snapshot of the local
machine twice: before the application installation and after the installation has
finished, and thus creates a delta file, which includes the application itself and
all of its settings.

To start the DiffTool from the donor machine, connect to the \LAN$ADM
directory on the remote LCCM server using an administrative account. Then
double-click the DiffTool icon:

Figure 148. Running DiffTool

The DiffTool welcome screen appears:
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Figure 149. DiffTool welcome screen

First you have to specify the name and location of the LCCM server. If you
don’t know it, click the Find LCCM Server button:

Figure 150. Locate LCCM Server window
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When the server is found, click Next and type in the application name that
you want to add to the LCCM interface:

Figure 151. Target application information window

Now the location of its setup file has to be entered. If you don’t know it, click
the Find Setup File button and search for the file.

Figure 152. Finding the application setup file
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When the setup file is found, proceed to the next window by clicking the Next
button:

Figure 153. Application setup file found

Now you can begin setting up the application. Click the Start Installation
button:

Figure 154. Begin Application Installation window
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DiffTool will take a snapshot of the system at its current state, that is, without
our application installed.

Figure 155. Taking the snapshot before the application installation

When it is done, DiffTool starts the application setup file. Then, the Norton
AntiVirus welcome screen appears:

Figure 156. Application installation
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To proceed, confirm the license agreement by clicking the Yes button:

Next, select the folder into which the program should be installed:

Figure 157. Choosing the destination folder

Next you are asked to define different options for the application, such as
scheduled weekly scans and auto-protect virus shield:
140 Windows 2000 Deployment Using Universal Manageability



Figure 158. Define AntiVirus options

The chosen options overview will be shown. To start copying files click Next:

Figure 159. Installation options overview

Some additional application information is shown, such as where to look for
support:
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Figure 160. Application support information

Norton AntiVirus lets you automatically download the newest virus definition
files called LiveUpdate, which can be selected by clicking the Run
LiveUpdate after installation check box. You can schedule the first virus
check of the system immediately after the application is installed; just select
the Scan for viruses after installation check box.
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Figure 161. Post-installation options

Click Finish to complete the application installation:

Figure 162. Finishing the AntiVirus installation

Note: If the procedure asks to reboot the machine at the end of the
installation it is very important to not reboot the client. Instead, leave the
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application setup procedure by clicking No, I will restart my computer later
and Finish, as shown in the following figure:

Figure 163. Application setup complete

DiffTool still has to take a second snapshot of the client and start it. Click the
Installation Complete button. This takes several minutes, depending on the
size of the installed application.
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Figure 164. Taking the snapshot after application installed

When the DiffTool is finished taking a snapshot of the system, the Summary
window will be shown. To end the procedure, click the Finish button.

Figure 165. DiffTool Summary window
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The result of the DiffTool procedure is the creation of a group of files that
DiffTool puts into its own directory on the server: \lccm\clntfile\App\Diff.

Figure 166. Files created for the UM Services application by DiffTool

Diff005.LDT is a description file (a text file) for the application we just added
to the LCCM interface. You can edit the ApplicationName line as shown in
Figure 167. This is the actual application name shown in the Software Profile
wizard.

Figure 167. DiffTool description file

The Diff005.LCD file is the application image that stores all files and settings
of the application itself (delta file), and the Diff005.LDT.count file is a control
file similar to Diff005.LDT. With every consecutive run of DiffTool a new set of
Diff00x.* files will be created.

Next time you create a software profile using a wizard, the following window
for deploying this application together with the operating system will be
shown:
146 Windows 2000 Deployment Using Universal Manageability



Figure 168. Installing an application with the operating system

3.1.1.4 Only use the UMS agent on an LCCM-deployed system
It is not necessary to upgrade Internet Explorer on systems where you are only
going to install the UMS agent. The following procedure shows you how to install
UM Services and Windows NT 4.0 without upgrading Internet Explorer.

When creating and modifying the LCCM profile:

• Use the Profile wizard in the usual way to create a profile that installs
Windows NT and UM Services.

• Modify the \LCCM\CLNTFILE\PROFILE\PROFnnn\RUNAPPS.INI file by
removing the Program1=C:\Install\UMS\FILES\MSJAVA86.EXE /Q /R:N line.

• Renumber the remaining lines in the
\LCCM\CLNTFILE\PROFILE\PROFnnn\RUNAPPS.INI file consectutively,
starting with 1. Don’t forget to change the last line:
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3.1.2 Unattended install of Windows 2000 Server on a server
Suppose the client computer has an operating system already installed and
the Network boot is only defined in the Automatic Power On Startup
Sequence (but not in the Primary Startup Sequence) in the client’s CMOS
setup. In that case, it is not possible to scan in this client using the normal
procedure. If you don’t want to modify the boot sequence again, the Wake-up
tool (using the Winwake.exe utility) in LCCM can help.

We used this procedure to discover our Netfinity 3000 machine, which
already had an operating system installed and didn’t have the Network device
defined in the Primary Startup Sequence, as shown in Figure 169 on page
149.

[Run0]
Program1=C:\Install\UMS\EN\setup.exe -s
Program2=\\M568207B\LANC$$\imgwiz\utils\pchecker.exe _ins0432._mp
Num=2
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Figure 169. Startup sequence of Netfinity 3000 machine

In the main LCCM window click Tools -> Wake Clients.
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Figure 170. Waking up the client

One of the ways to wake up the client (if you don’t have physical access to the
system) is by providing its MAC address (you will find a discussion on
different ways to acquire the client’s MAC address in 1.1.1.1, “Asset ID” on
page 6). Type the MAC address into the Keyboard field and click OK.
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Figure 171. Entering the client’s MAC address

The address appears under Clients to wake, and by clicking Start waking
LCCM will wake the client up.
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Figure 172. Starting the Wake-up process

When the client is up, click the Cancel button and in the main LCCM window
choose the Start button under the Scan for new clients section.
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Figure 173. Starting the new client scan

The client, which is already powered up, will connect to the LCCM server,
pass its attributes such as serial number, machine type, memory quantity,
and hard disk size, to the server and shut itself down when finished. It will be
added into the client database and its icon will appear in the unassigned
Clients pane, as shown in Figure 174 on page 154.
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Figure 174. Client found

Afterwards you can change the client name to a more descriptive one by
double-clicking it and editing the Name field:
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Figure 175. Individual client details

Now we have the client in the client database and we can move on to
preparing the software profile for Windows 2000 Server unattended install.
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Figure 176. Client with changed name

3.1.2.1 Creating the software profile with the Profile Wizard
To start creating the profile using the Profile wizard, Click Profile -> Create
new.
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Figure 177. Starting the profile wizard

Select the Unattended install, and Do you also want to install
applications with this profile check box, and in the drop-down box, the
operating system you wish to install: Windows 2000 Server.
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Figure 178. Selecting installation options

After selecting the desired language version for the operating system, the
wizard checks the availability of the installation images for the Windows 2000
Server operating system. If they are found in their default location
(\LCCM\Clntfile\W2KSRV\eng directory on the LCCM server), the wizard asks
you whether you want to use them or build new images.
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Figure 179. Installation files - use existing images or build new

The next window appears asking about the RAID setup. If your server has a
RAID adapter installed, click the Yes, the target clients have RAID adapter
installed check box and provide the file name and location of an existing
RAID setup file. For further details please refer to 6.3.1, “Capturing
ServeRAID configuration” on page 254. Otherwise, leave the check box blank
and click Next.
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Figure 180. RAID adapter setup for Windows 2000 Server

The following steps are identical to the Windows 2000 Professional
installation (described in 3.1.1.1, “Creating a software profile using the Profile
wizard” on page 102), so we will briefly describe them and then move to the
point where this procedure differs from the Windows 2000 Professional
procedure.

If you didn’t select the RAID setup, the next window will appear asking about
the Rapid Restore option. Decide whether you want to create a hidden
backup partition or not, and proceed by clicking the Next button.

Now you will be asked to specify the size and organization of the client’s hard
disk. Also, select the file system you wish to use to format the client’s
partition(s).

Next, provide the company name on the Profile Customization window and
select the appropriate time zone for your location on the Regional Settings
window.

Now, define the server role in the network and select the Windows 2000
Server licensing method appropriate for your organization:
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Figure 181. Licensing method

You have to define whether this server is part of a workgroup or a domain. If
you select a domain, you have to provide the administrator user name and
password.
Chapter 3. Unattended Windows 2000 deployment for new systems 161



Figure 182. Networking settings

If there were some applications (for any Windows 2000 operating system)
added to LCCM (using DiffTool) before creating this profile, they will show up
in the following window. Just click the check boxes in front of the applications
to install them along with the operating system:
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Figure 183. Application installation

Finally you are presented with the profile summary:
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Figure 184. Profile summary

Click Finish to end the wizard. You are returned to the LCCM main window.
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Figure 185. New profile for Windows 2000 Server

The next step is to assign the client personalization parameters to this profile.

3.1.2.2 Assigning the client using the default values
Instead of using the assignment wizard you can enter the parameters directly
into the software profile as default values and disable the assignment wizard
to save some time.

Note: This does save you some time but it makes every box have the same
registered user, user ID and IP address.

Make sure the new profile is selected and choose Profile -> Configure from
the menu bar.
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Figure 186. Modifying profile

In the Details tab of the Software Profile window deselect the Enable client
assignment wizard check box.
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Figure 187. Software Profile Details

Click the Client Parms tab and enter the following mandatory information:

1. First part of the valid Windows 2000 Server license key, in the field next to
LCLI_PRODID.

2. Second part of the valid Windows 2000 Server license key, in the field next
to LCLI_PRODID_2.

3. Default logon user ID, in the field next to LCLI_USERID.

4. Client computer description, in the field LCLI_COMPDESC.

When all the information is entered click OK to close the window.
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Figure 188. Software profile details - client parameters

You will be returned to the main LCCM window. The last step required to
initiate the deployment is to click the Process button. The client will wake up,
connect to the LCCM server and start the installation procedure.
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Figure 189. Starting the deployment

Once the client wakes up, connect to the LCCM server and boot the
downloaded boot image. For a complete description of the steps, see Figure
147 on page 134.

3.1.3 Rapid Restore
It is possible to make a backup of the client’s primary partition using the
LCCM tools. The advantage is that we have a backup image of the clients
machine in a known good state and if by any chance the primary partition
becomes corrupted, it is easy to restore to its original status. Rapid Restore
uses a sector-by-sector backup and restore algorithm, which is independent
of the client file system.

Note: The methodology that we used in the rest of this chapter for Rapid
Restore was based upon a beta service pack for LCCM (SP3). Not all of the
functions were enabled in the code that we used. Remember that all
maintenance procedures are client specific, and are run by setting them up in
the Maintenance page of the Client profile. This can be done while the client
remains wherever it is. This includes the unassigned state, when a client is
not assigned to any specific software profile.
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3.1.3.1 Backing up the primary partition
The Rapid Restore function in LCCM uses the RAVE.EXE utility. When the
Rapid Restore option is selected during the Software Profile creation (see
Figure 121 on page 108), the RAVE utility will check the available free space
on the client’s hard disk. The size of the primary partition plus 16 additional
sectors (to store Rapid Restore information, maximum 5 MB) of free space is
needed to create the hidden backup partition.

If you forgot to select the Rapid Restore option before client deployment and
you have the needed free space, you can create a backup of the primary
partition using the RAVE.EXE utility by booting the client with a DOS diskette
that contains the RAVE program and executing the following command:

RAVE /b /i

This will back up the primary partition data together with its Master Boot
Record in interactive mode, and show the results of the operation. The hidden
partition will be named IBM RAVE. To check the partition table, use the
command:

RAVE /v

3.1.3.2 Restoring after the partition has failed
In case of a failure, you can do a local restore initiated on the client or a
remote restore, started from the LCCM console.

To initiate the restore procedure on the client, boot it with a DOS diskette and
execute the RAVE command with one of the following switches:

• To do a full restore of the partition, use RAVE /ALL

• To restore only the master boot record, use RAVE /MBR

• To restore only the data, use RAVE /DATA

• If you don’t need the backup partition, you can delete it using RAVE /d.

The full syntax for the RAVE command is shown in the following screen:
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To prepare to run a restore remotely from the LCCM console, drop the client
icon onto the Donor profile, then click Client -> Configure:

Figure 190. Configuring the client for remote restore

On the Maintenance tab, select the Rapid Restore check box and choose the
Restore option. This enables the Restore maintenance file (lcravers.mns). To
finish the preparation, click the OK button.

C:\LCCM\clntfile>rave /?
Rapid Restore v1.0 (LCCM v2.5.1) - (C) Copyright IBM Corporation 1999

Backs up or restores primary boot partition

RAVE [/b|/DATA|/MBR|/ALL|/d|/v|/t] [/i] [/f]
/b Backup master boot record and primary partition data
/DATA Restore primary partition data only
/MBR Restore Master Boot Record only
/ALL Restore Master Boot Record and primary partition data
/d Delete existing Rapid Restore partition
/v View partition table
/t Test for existing backup. 1 returned if not found
/i Interactive mode (default = non interactive)
/f Force backup, deleting any existing backup
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Figure 191. Selecting the restore option

Now process the client by clicking the Process button.
172 Windows 2000 Deployment Using Universal Manageability



Figure 192. Starting the remote restore procedure

The client machine will wake up and connect to the LCCM server. At the client
the following screen shows up:

We don’t want to break the batch script, so just continue the boot procedure
by pressing any key. The rest of the rapid restore procedure will continue. The
client will reboot, reconnect to the LCCM server and restore the primary
partition by running the RAVE /DATA /I command.

Please press CTRL-C to break out of the batch script and get to a command prompt
.
Press any key to continue . . .
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Chapter 4. Intelligent application deployment

Today, corporations manage software requirements centrally for many
business units in their enterprise. Preloaded images normally include the
operating system, drivers and particular applications for specific units.
Because different business or location units have different requirements, the
preload image pool can become quite intricate and difficult to maintain.

IBM’s approach to this problem is to divide the operating system and drivers
preload from the actual application preload. The Universal Manageability tool
that is used for operating system deployment is called LANClient Control
Manager (LCCM) and it is described in Chapter 3, “Unattended Windows
2000 deployment for new systems” on page 101. For the actual application
deployment, the Software Delivery Assistant (SDA) can be used to create
standard application set images and provide a user-friendly tool to install
them. Standard application sets contain mandatory and selectable
applications that satisfy different business units. Processing is simplified,
labor costs are reduced and the end result is reduced total cost of ownership.

For the latest information about SDA and to download the current version,
please go to:

http://www.pc.ibm.com/ww/solutions/enterprise/sysmgmt/products/sda/

In this chapter we want to show how SDA is used to deploy applications onto
IBM client machines running the Windows 2000 family of operating systems.

4.1 Software Delivery Assistant

IBM SDA consists of two parts. The SDA-Administrator is a visual tool, used
by the person responsible for creating images of applications, needed for
specific groups. Groups are based on a user’s geographical or business
needs. The SDA-Installer (also a visual tool) is used by end users to install
software from the newly created images onto their computers. Before the
installation, users are asked about the group they belong to and based on the
group name, the corresponding image will be selected and applications
installed.

4.1.1 Installing SDA
SDA has to be installed on the machine where the application images will be
created. There are no special requirements for installation except a minimum
of 6 MB of available hard disk space for the SDA program and additional
space on the machine where the application images are stored.
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Both the machines where the images will be created and end users’
machines where applications will be installed can have any of the following
Windows operating systems installed:

• Windows 95
• Windows 98
• Windows NT
• Windows 2000

Note: If your company plans to move PCs to the Windows 2000 platform you
don’t need to install SDA on the Windows 2000 machine. You can prepare the
application images on any other supported Windows platform and roll them
out later when the clients are deployed with the new operating system.

To start the SDA installation, run the SDA installation file sdav11.exe and the
following window appears:

Figure 193. Starting the SDA installation

The installation procedure asks you to select the setup language. The
following are available in V1.1:

• Brazilian Portuguese
• Castilian Spanish
• Danish
• Finnish
• French
• German
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• Italian
• Japanese
• Norwegian - Bokmal
• Portuguese
• Simplified Chinese
• Swedish
• Traditional Chinese
• US English

Figure 194. Selecting the setup language

After choosing the desired language the Welcome window appears. It
recommends that you close other programs that may be running. Continue by
clicking the Next button:
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Figure 195. SDA installation

Next the Software license agreement window appears. Review the terms and
conditions and acknowledge them by clicking the Yes button.

SDA is licensed and supported on the following IBM machines:

• All commercial desktops
• All IBM Thinkpads
• All IntelliStation models
• All Aptiva models

You have to have a valid software license to use SDA installer on non-IBM
systems.

Next, confirm the SDA default installation folder, which is \Program Files\SDA
v11, or choose an alternative. Then proceed by clicking the Next button.
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Figure 196. Choose SDA installation folder

After the copying is done, finish the installation procedure by clicking the
Finish button.

Figure 197. SDA installation finished
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Now you can start using SDA. If there is no existing workspace available, you
have to create one.

4.1.2 SDA-Administrator
A workspace is a file (.SSW) which contains all the required information to
build an image. With new SDA installations, there is no existing workspace
available. You have to either create a new workspace or import an existing
one.

4.1.2.1 Creating the workspace
The process of creating a workspace is simplified by using the creation
wizard. First, start SDA by clicking Start -> Programs -> IBM SDA v1.1.

Figure 198. Starting SDA-Administrator

Select the language for the SDA-Administrator:
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Figure 199. SDA-Administrator language selection

By default, the wizard starts and guides you through workspace creation and
usage. Select Create a new workspace and click OK.

Note: If you don’t want to use the wizard, click the Do not show this window
again check box.

Figure 200. SDA-Administrator wizard
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First the wizard asks you about the workspace name. This is a descriptive
name, not a file name. You will provide a file name when saving the
workspace before exiting SDA-Administrator.

Figure 201. Workspace name

In step 2 you should select all the languages this workspace will support. The
languages that you select must correspond to the language versions of the
operating systems that will support this workspace. You can also add the
languages after the workspace has been created.
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Figure 202. Selecting supported languages for application images

In step 3, list the groups that you want the image to support. A group is a set
of applications that are specific to an organization, job or discipline in your
enterprise. There is a default group called Common, which contains
applications that should be installed on all user machines and therefore
common to all groups.

Figure 203. SDA default group
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In our example, we set up an additional group called Support. It includes
specific applications for the support personnel.

To set up an additional group, click the Add button and type the name of the
new group into the provided text box. Repeat the procedure for each
additional group you want to have. When you are finished, proceed to the next
step by clicking Next.

Figure 204. Adding SDA groups

When users start the SDA-Installer for the first time, they will be asked to
identify themselves by providing the group they belong to. Based on that
information the required applications for that group will be automatically
installed. If you want users to provide additional information about themselves
(like employee number, building number or location), you can add these
user-profile fields in step 4. To add a new field, click the Add button:
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Figure 205. User-profile fields

A new window opens. Type in the name of the field under Field name. Click
the Required check box if it should be mandatory for the user to fill in this
field. You also have to provide a valid set of options for the user to choose
from. Click the Add button and type all the possible options for that field into
the provided text box. When you are done, click OK -> Finish.

Figure 206. Adding additional fields to user profile
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The SDA-Administrator builds and displays the workspace. It is divided into
two panes. The left pane displays the structure of the workspace, showing the
languages created and all the groups listed within each language. The right
pane displays the contents of the item which is highlighted in the left pane. All
items can be edited either by right clicking them or using the menu bar on top
of the window.

Figure 207. Workspace created

If you want to change the workspace after initially creating it, there are two
ways to do it. You can use the menu bar on top of the window, or the pop-up
menus for particular objects. If you wanted to add another language using the
menu bar, just select the workspace (ITSO in our example) and click Insert ->
Language and then choose the language from the list in the next window:
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Figure 208. Creating new language using the menu bar

We also discovered that we need additional groups for sales personnel. To
add this group, right-click the particular language and choose Insert group.

Figure 209. Adding groups

A window pops-up asking for the name of the new group. Type in the name
and click OK.
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Figure 210. Naming the group

If you need the same group in all languages, you don’t need to create it
several times. It is easier to copy the existing group to the remaining
languages. Drag and drop the group onto selected languages and choose
Copy here from the pop-up menu.

Figure 211. Copying groups

When you have created all the needed languages and groups, you can begin
inserting applications. Select the group into which you want to insert an
application, and click Insert -> Application from the menu bar (or,
alternatively you could right-click the group and click Insert Application):
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Figure 212. Inserting applications

A new window opens to specify the details for this application. On the General
tab, enter the following items:

• Name of the application as you want it to appear on the user’s machine
when the SDA-Installer is started.

• If you wish to change the icon representing this application, click the
Change icon button and browse to find the *.ICO or other file associated
with the icon.

• Finally, select all operating systems in which this application should run. If
different versions of this application exist for different operating systems,
they have to be added to the workspace separately.
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Figure 213. Insert application - General tab

Here we changed a standard program icon into a specific one:

Figure 214. Changing the application’s icon
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In the Properties tab, specify the following information:

• If you want the users to be able to uninstall this application through
SDA-Installer, specify its name as it appears in Windows Add/Remove
Programs.

• The version of this application.
• The approximate disk space required to install this application (in MB).

This number is only shown in SDA-Installer and will not be used by any
program to reserve this amount of disk space.

• You can also specify a description of the application that you want to be
shown as a banner when the SDA-Installer is run on the end user’s
machine.

Figure 215. Insert application - Properties tab

In the Source tab you have to provide:

• The location of the installation (setup) files. If you don’t know where the
files are located, click the Browse button to find them.

• The name of the installation file. Specify a command for either standard or
silent installation including any switches (for example, SETUP.EXE - S).
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Figure 216. Insert application - Source tab

In the Installation tab, you need to specify the following:

• Installation type, which can be Required, Recommended or Optional.
Select Required for all important applications that have to be installed
during the auto-installation portion of the SDA-Installer. Select
Recommended for additional applications where the user can decide
whether they need the application. Recommended applications are
selected by default in the SDA-Installer window. Use Optional for any
additional applications, which are not selected for installation by default.

• The installation sequence has to be selected if you want to install
applications which are interdependent (for example, if application B needs
to be installed after application A). Priority level 1 is the highest and Don’t
care is the lowest level priority. If several applications are given the same
priority level, they will be installed in a random order.

• If a reboot is required for optional applications, click the Computer restart
required check box to show a prompt for the user to restart the machine
after the SDA-Installer has finished installing all the optional applications.
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Figure 217. Insert application - Installation tab

Click OK when you have provided all the required information into the Insert
application window. The SDA-Administrator window will open the workspace
with the added applications for all selected operating systems. Following is
the result of setting up Norton AntiVirus:

Figure 218. Newly added application
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Now you can verify that you specified all the required information for this
application by starting Image -> Preview from the menu bar. This simulates
the end user’s experience with the SDA-Installer.

Figure 219. SDA-Administrator preview

If you have set up several languages, the next window pops up, asking which
language group you want to simulate an image build for:

Figure 220. Preview language selection

The preview simulates image copying:
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Figure 221. Simulation

The SDA-Installer window shows the same thing as if it were started on the
end-user machine.

Figure 222. SDA-Installer preview
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If there were any errors in the preparation, the SDA-Administrator will indicate
that. The standard SDA workspace window is shown with a new section in the
bottom indicating the status of the last operation:

Figure 223. Last operation status

The next step is to build the image for this application. Click Image -> Build in
the menu bar:
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Figure 224. Initiating the image build

First, provide the destination location where the image should be copied.
Click OK to start copying:

Figure 225. Selecting the image destination

The SDA-Installer code gets copied together with the actual application setup
files:
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Figure 226. Copying the files

When the procedure is finished, SDA notifies you of possible errors or
warnings:

Figure 227. Build finished

All of the steps of the image build operation are shown in the bottom part of
the SDA-Administrator window. If you click on a particular entry, SDA opens
the item in question and gives you the option to edit it:
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Figure 228. SDA build warnings

In this particular example, no command for the silent install was provided.
Since this is not a required entry, only a warning was issued, not an error.

Figure 229. Reacting to an SDA build warning

For our example workspace, we added additional applications for different
groups:
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• For the Sales group we added Lotus SmartSuite Millennium as a
recommended application.

• For the Support group we added Universal Manageability Services as a
required application.

Here is the final view of the workspace that will be deployed to the client
machines of different groups:

Figure 230. Example workspace

When adding an application after the original image has been built, the
SDA-Administrator will ask you what you want to do with the original image.
You can choose Replace, which creates the image for all applications again,
or Update, which adds only the files for new applications to the existing
image. If you want to stop image creation, click Cancel:

Figure 231. Workspace image location
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The images were created in the D:\Images\SDA ITSO folder as shown in the
next figure:

Figure 232. SDA image folder

After the images are built, you can download them to the end user’s
computer. LCCM can be used for distribution (for example, by running a
maintenance file at the end of the operating system deployment), or the
image can be copied to a CD or ZIP media and transferred to the client
machines. Now the client portion of the setup begins, where the SDA-Installer
tool is run manually or automatically.

Before closing the SDA-Administrator, the just-created workspace has to be
saved. Click File -> Save from the menu.
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Figure 233. Saving the workspace

Provide the SDA workspace file name and location and click Save:

Figure 234. Defining the workspace file name and location

4.1.2.2 Importing a workspace
If there is an existing workspace created on another SDA-Administrator
machine it is possible to import it and modify it according to the end user’s
group needs. If the new image should include any existing applications from
the imported image, the SDA-Administrator will use installation files from the
existing image rather than building the images again. Select Import a
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workspace from an existing image option in the SDA wizard or click the
File -> Import option from the menu as shown in the next figure:

Figure 235. Starting to import the existing workspace

You have to provide a new name to modify the existing workspace and the
location of the workspace images:

Figure 236. Workspace file name and location

It is also possible to manipulate (move, copy) applications from one
workspace to another. In the following example, we just copied over the UM
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Services application from the ITSO to ITSO org workspace without the need
to create the application images again:

Figure 237. Copying application from one workspace to another

4.1.3 SDA-Installer
To start the installation on the user’s machine the SWSelect.exe file has to be
executed. There are several ways to run it:

• Create a shortcut to the file on the user’s desktop. In this way, the user can
start the installation at his or her own discretion by simply double-clicking
the shortcut icon.

Note: It is possible to run the SDA-Installer from a remote network drive,
but there is a requirement to share the images folder on the remote
machine first and to map that share on the user’s machine as a network
drive.
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Figure 238. Mapping a network drive

In our example, the shortcut points to SWSelect.exe on the S: drive:

Figure 239. Shortcut to SWSelect.exe on the mapped drive
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• Create a shortcut to a simple batch file (running SWSelect.exe file only
once and then deleting itself) in the Startup folder of the client’s machine.
This runs the SDA-Installer the first time the machine is started after
creating the shortcut.

• Create an entry in the RunOnce registry key of the end user’s machine.
This will run the SDA-Installer automatically when the machine is run for
the first time. In the registry key,
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\RunOnce,
create the entry SDA “d:\imagepath\SWSELECT.EXE” as shown in the following
figure:

Figure 240. Creating a RunOnce entry

When the SDA-Installer is run for the first time, users are asked to identify
themselves as members of one (or several) of the presented groups. This is
used as the basis for choosing a required application group to be installed on
a particular machine. If you set up additional user-profile fields, they are
shown in the user profile window as well (for example, Location):
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Figure 241. SDA-Installer: profiling the user

After selecting the group, all common applications are installed automatically:

Figure 242. Installing required applications

In our example the common application was Norton Antivirus. It was to be
installed in the interactive mode, so the user had to select the installation
options. To complete the AntiVirus setup just click the Finish button:
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Figure 243. Installing the common required applications

Next, all required applications for the chosen group will be installed (for the
Support group it was UM Services):

Figure 244. Installing the required applications for Support group

When all required applications are installed, the SDA-Installer window opens.
In the left pane you can click the operation that you want to perform:

• Install applications: They are listed by group order (in our example
Sales, Support and Common). Only recommended applications are
selected by default.
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Figure 245. SDA-Installer main window

• Uninstall the applications: A list of applications that were installed using
the SDA-Installer is shown and you can mark them for uninstall. If a
particular application is not on the list, you can click the icon for the
Windows Add/Remove utility program to start it from SDA-Installer.

• Advanced functions - Change settings: Here you can change the SDA
installation image file name and location, the current language of the
SDA-Installer text, and the way an application description is shown. You
can also enable the custom installation of applications. During a custom
installation you can specify certain parameters.
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Figure 246. Advanced functions - change settings

• Help: Explanation of SDA-Installer options are provided.

Some of the applications require rebooting the system after installation.
When you are finished with the SDA-Installer, click the Exit button to close it,
then shut down and restart the machine.
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Chapter 5. Moving settings and data files to the new system

One of the most tedious tasks that is undertaken during a traditional rollout of
new systems is setting up the user’s working environment. Once the
operating system has been installed on the target machine, the System
Migration Assistant (SMA) tool from IBM can be used to minimize the time
needed to capture the existing user’s Personality and Connectivity settings as
well as a user’s created work files and folders, and transfer them to the target
machine. In addition, installed applications can be captured and, together
with their registry settings, transferred to remote systems.

There are some tools from Microsoft that can be used to do tasks similar to
SMA. Such an example is IntelliMirror. However, there are several reasons to
select SMA for the above-specified tasks:

• SMA is geared toward companies trying to migrate user settings and data
from old hardware systems with older operating systems, to new
machines, probably running the latest operating system. IntelliMirror, on
the other hand, is primarily a tool to back up and restore data on the same
system and to allow roaming users to access the same applications on
different machines.

• SMA can be used for migrating user settings from Windows 95/98,
Windows NT as well as Windows 2000 operating systems, whereas
IntelliMirror can only be used for machines running Windows 2000.

• SMA is a stand-alone tool and needs no external service to run, whereas
IntelliMirror needs Active Directory.

You may refer to the System Migration Assistant Version 2.1 User Guide for
additional details on all the procedures shown in this chapter. This document
can be found at:

http://www.pc.ibm.com/us/software/sysmgmt/products/sma/

5.1 System Migration Assistant

SMA uses the idea of a camera, by taking an image of the existing system
(the source profile) and then applying the profile on top of the target
computer. By creating the sample computer with the specific user
environment and needed applications, taking an image of this computer and
then applying that image to several target machines, system administrators
can save a lot of time and resources when rolling out new machines for
departments or companies.
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SMA on the target computer can access migration images through the
network via mapped drives or the profiles can be put on any convenient
storage media such as a CD-ROM or a ZIP drive. It is then used locally on the
target machine, where the network bandwidth is of little concern.

SMA can be run as a GUI application in interactive mode or automated in
batch mode. When run in batch mode, it gives you the greatest time savings
for deploying customized settings and applications to several remote
machines at the same time.

SMA has to be installed on both computers: on the source and on the target
machine. The first phase has to be run on the source computer before
running the second phase on the target computer(s).

We examined procedures for migrating Windows 98 and Windows NT
Workstation clients to Windows 2000 Professional. We used System
Migration Assistant V2.1 for the examples in this chapter.

5.1.1 Requirements for SMA
Before installing System Migration Assistant it is necessary to discuss its
prerequisites.

5.1.1.1 Minimum computer requirements
The minimum system requirements for running SMA include:

• Pentium class system with at least 4 MB of RAM.

• 5 MB of hard disk space and additional space for output files. This can be
anything from a few KB to several hundred MB.

• There are no requirements in terms of the file system used on any
particular machine.

SMA can transfer user settings from any Pentium-based machine to selected
IBM systems, including PC, IntelliStation, ThinkPad and Netfinity servers. PC,
IntelliStation and ThinkPad can be migrated interchangeably while servers
can only migrate to other servers.

It is strongly recommended that you log on as a user with administrator rights.
SMA requires administrator rights to access Windows registry settings. If
SMA is run without administrator rights, the following features can’t be
retrieved or set in the Windows 2000 operating system:

• Computer name
• Computer description
• DNS configuration
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• Shared folders and drives
• TCP/IP configuration
• Workgroup/Domain
• NTFS file permissions

5.1.1.2 Supported operating systems
In the scope of this book it is important to clarify the supported operating
systems which can be used as the source platform to migrate user settings,
data files and applications to a client with the Windows 2000 operating
system installed.

Table 10. SMA - supported operating systems

Note: Selective migration transfers Personality and Connectivity settings and
data files. Mass migration transfers applications and registry settings in
addition to Personality and Connectivity settings and data files.

5.1.2 Installing System Migration Assistant
The installation is very straightforward. In our example the source machine
had the C: partition formatted with the FAT file system and D: was formatted
with NTFS.

After running setup.exe the following window appeared:

From - To
(Migration
method)

Windows 2000
Professional
(Selective)

Windows 2000
Professional

(Mass)

Windows
2000 Server
(Selective)

Windows
2000 Server

(Mass)

Windows 95 X

Windows 98 X

Windows NT
4 Workstation

X

Windows NT
4 Server

X

Windows
2000
Professional

X X

Windows
2000 Server

X X
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Figure 247. SMA installation

By choosing Next the License Agreement window appears. After accepting
the license agreement the program asks for the installation location:

Figure 248. Choosing destination location
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After confirming the installation location, the program folder gets created and
the following files are copied into it:

Here is a list of executable files of interest:

Table 11. SMA executable files

The subfolder SMA\support contains the settings.txt file. The subfolder
SMA\PROFILES contains no files.

Executable file Description

Source.exe Executes interactive source part of SMA (Windows interface)

Target.exe Executes interactive target part of SMA (Windows interface)

Srcbat.exe Executes batch source part of SMA (command interface)

Tarbat.exe Executes batch target part of SMA (command interface)

Directory of C:\Program Files\IBM\SMA

01/22/2000 02:53p <DIR> ..
01/22/2000 02:53p <DIR> .
01/22/2000 02:53p <DIR> Profiles
01/22/2000 02:53p <DIR> support
12/06/1999 05:48p 679 clntmp.bat
04/14/1999 08:03a 53,760 zlib.dll
12/20/1999 02:18p 466,944 smasrc.dll
12/20/1999 02:20p 454,656 smatarg.dll
10/04/1999 12:57p 24,576 CheckVer.exe
12/20/1999 02:25p 188,416 srcbat.exe
09/25/1999 10:26p 332,808 Com32upd.exe
12/20/1999 02:23p 1,601,536 Source.exe
12/20/1999 02:23p 167,936 tarbat.exe
12/20/1999 02:24p 499,712 Target.exe
01/22/2000 02:53p 5,275 Uninst.isu
12/14/1999 09:15a 3,093 tarcommands.txt
12/29/1999 05:15p 9,745 license.txt
12/17/1999 02:59p 10,695 srccommands.txt
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Figure 249. Creating SMA’s program folder

After copying the program files, the system has to be restarted:

Figure 250. Completing the installation
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5.1.3 Capturing a user environment using Source GUI program
To start the Source SMA GUI program, click Start -> Programs -> System
Migration Assistant -> Source.

This runs the SOURCE.EXE program in the \Program Files\IBM\SMA folder.

Figure 251. Starting the SMA Source GUI program

To enable the complete capturing of user settings it is recommended that you
close all running applications.

Note: The migration process can be stopped at any time. Click the Cancel
button in any window. SMA prompts you to confirm that you wish to terminate
the program. If so, click Yes.

The first information window appears explaining the SMA source module and
migration methods:
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Figure 252. Source module

Figure 253. Different migration methods

There are two possible migration methods:
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1. Selective Migration allows you to migrate Personality and Connectivity
settings, user files and folders.

2. Mass Migration replicates user settings, files and folders as well as
registry settings and installed applications. This means that it is possible
to migrate everything from a source to a target computer with the
exception of the operating system.

Note: The default behavior of the SMA GUI program is determined in
SETTINGS.TXT in the \Program Files\IBM\SMA\Support folder and can be
changed. It is possible to transfer the Windows registry settings running
Selective Migration as well. However, if you are not careful you can disable or
destroy the target registry by migrating the wrong settings.

A sample of this file can be found in Appendix A.1, “SMA GUI program’s
configuration file” on page 315.

Figure 254. System Migration Options

5.1.3.1 Selective Migration
In the following steps you can select which settings should be migrated.

If the check box for Personality Settings is ticked, the following settings will be
shown:

• Accessibility
• Active Desktop (active state)
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• Colors
• Desktop Icons
• Display
• Icon Font
• Internet Browser
• Keyboard
• Mouse
• Pattern
• Printers
• Screen Saver
• Send To Menu
• Shell
• Sound
• Start Menu
• Task Bar
• User Profiles
• Wallpaper
• Window Metrics

Figure 255. Personality selection

When the check box for Connectivity Settings is selected, the following
settings are shown:

• Computer Description
• Computer Name
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• DNS Configuration
• Domain/Workgroup
• Gateway
• Mapped Drives
• RAS Networking Connections
• Shared Folders and Drives
• TCPIP Configuration
• WINS Configuration

Figure 256. Connectivity selection

In SMA V2.1 there is a new option to migrate some registry entries in the
Selective Migration method. If you want the Registry Selection window to
show, click the Registry Selection check box as shown in Figure 257 on page
222.
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Figure 257. Registry selection

Click Next so that you can choose particular file types to be migrated; the tick
box for Extension Selection has to be clicked:
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Figure 258. Option to migrate files based on their name extension

The next method allows specific files and folders to be directly selected for
migration:

Figure 259. Option to migrate specific files and folders
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Individual groups of settings can be selected or deselected. If you wish to
select all groups, click Check All. Click Clear All if you don’t wish any groups
of Personality Settings to be migrated.

The description of a particular settings group will be shown in the bottom part
of the window, when that group is selected. In Figure 260 we see the
description for Internet Browser, that is, which of its properties will be
migrated.

Figure 260. Selecting individual groups of Personality Settings with description

Individual groups of Connectivity settings can be selected. If you click the
Load Defaults button, the items defined in the SETTINGS.TXT configuration
file are checked for migration. For further details, see Appendix A.1, “SMA
GUI program’s configuration file” on page 315.
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Figure 261. Selecting individual groups of connectivity settings

Now you will be able to select some of the registry entries from the
HKEY_CURRENT_USER and HKEY_LOCAL_MACHINE hive for migration.

Note: You should be careful with this window because if you migrate the
wrong entries you might end up with a corrupted target registry and an
unusable machine.
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Figure 262. Selecting registry entries

If the file and folder option was previously selected, the next window that
appears will be the Computer File Scan. Click the Scan button and the
system will scan the computer and build a list of files, folders and drives.
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Figure 263. Starting computer file scan

Figure 264. Computer file scan finished
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When the scan is finished, the program shows a list of found file types, drives
and folders on your machine. You can select the particular file types you want
to migrate.

Figure 265. Selecting types of files to be migrated

After the search, the program shows a list of files found of the selected type
and you can choose which particular files should be migrated.

Select the Expand Workspace check box to expand the found files display.
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Figure 266. Expanded display of found files

Click Capture NTFS File Settings if you want to copy the NTFS attributes to
the target computer.

When the Warn of potential transfer problems check box is selected, the
program will warn you that the selected files may cause problems during
migration to the new system.

An example of such a warning would be if you select the AUTOEXEC.BAT file
for migration. As a batch file it contains references to other files and folders
that may not be on the referenced location. If that happens, the migrated
batch file will produce errors or malfunction.

If the target disk drive does not have enough space available to do the
migration you might want to select another target drive. To do this right click it
and in the pop-up window click the desired drive letter on the target computer,
as shown in Figure 267.
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Figure 267. Choosing a different target drive

In the next window you define the SMA file name and location. In the bottom
text box you can write descriptive text about this migration to distinguish it
from other migration profiles.

It is also possible to save the migration profile to an ADSM server. In order to
do that, the ADSM (Tivoli Storage Manager) backup client software has to be
installed and its node configured. In addition, you have to know your ADSM
user ID, ADSM password, and the name of your ADSM server.
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Figure 268. Selective migration profile name and location

The last step of this phase is to start the SMA copy process. Click Start.

Figure 269. Start copying process
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Figure 270. Copying process

When the process is finished, click Next to view the summary or Cancel to
exit without viewing the summary.

Figure 271. Finishing copying process
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To end the Selective SMA source phase, click Exit.

Figure 272. Selective SMA source summary

SMA creates the following non-editable migration files in the \Program
Files\IBM\SMA\Profiles folder:

• DEFAULT.SMA, which is a main header file (a profile).
• DEFAULT.PRC, which is a profile contents file and stores all the

Personality and Connectivity settings that were captured.
• DEFAULT.C01 contains the data files captured from drive C.
• DEFAULT.D01 contains the data files captured from drive D.

At processing time a \Temp directory is used to expand the *.PRC file. When
the processing is finished this directory is deleted.

During the migration a *.LOG file is created in the \Program Files\IBM\SMA
directory. IBM support asks for that file if you call in for help.

To begin the second phase of the migration process, you need to start the
Target part of the SMA (GUI program). See 5.1.4, “Applying captured settings
to the target machine” on page 242.
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5.1.3.2 Mass Migration
If you need to transfer all user settings, installed applications and their
registry entries from the target machine, you need to run the Mass Migration.

Warning: This is an advanced option that requires the source and target
computers to be running the same operating system. The target machine
operating system level must be at least equal to or higher than the source
computer.

In the scope of our book, the Mass Migration can only be used to migrate
Windows 2000 source machines to Windows 2000 target machines.

To start the GUI version of the SMA source module, click Start -> Programs
-> System Migration Assistant -> Source.

Figure 273. Starting the SMA source GUI program in Windows 2000

The next three steps are identical to starting the Selective Migration so
please refer to Figures 251, 252, and 253. On the System Migration Option
window select Mass Migration, as shown in Figure 274.
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Figure 274. System Migration Options (selecting Mass Migration)

If you want to prevent the migration of selected files and folders that could
possibly interfere with the successful deployment of the target computer,
choose the File & Folder Selection check box in the next window:
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Figure 275. Preventing migration of selected files and folders

To start scanning the computer for files and folders, click the Scan button:

Figure 276. Starting computer file scan

With the next window SMA informs you that the scan is completed:
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Figure 277. Computer file scan completed

You are then presented with a drive tree structure to deselect some of the
files and folders. Click + to expand disk drives and folders and clear the check
box in front of the files or folders that you don’t want to migrate.

Note: If the target disk drive does not have enough space available to do the
migration you might want to select another target drive. To do this right-click it
and in the pop-up window click the desired drive letter of the target computer.
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Figure 278. De-selecting files and folders

In the next window you will be able to define the SMA profile name and
location. In the SMA File Notes box you can insert a profile description.
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Figure 279. Mass migration profile name and location

Finally, start the SMA copying process by clicking the Start button.

Figure 280. Start copying process
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The copying might take anywhere from a few seconds to several minutes:

Figure 281. SMA copying files and folders

When the process is finished click Next to view the summary or Cancel to
exit without showing the summary.
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Figure 282. Finishing the copying process

To end the mass SMA source process, click Exit.

Figure 283. Mass SMA source summary
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5.1.4 Applying captured settings to the target machine
The second phase of migration has to be done on the computer where the
captured settings should be applied (target computer). To start the target
SMA GUI program click Start -> Programs -> System Migration Assistant
-> Target.

This action will run the TARGET.EXE program in the \Program Files\IBM\SMA
folder.

Figure 284. Starting the SMA GUI target part

To enable the SMA target program to have full access to all files it is
recommended that you close all running applications:
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Figure 285. Closing running applications

An information window appears explaining the SMA target module:

Figure 286. Target module
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Figure 287. Page Progression Information

In the next window you have to select the location and the name of the SMA
profile you previously created with the source module. The profile can be
available on the target computer, can be copied to a CD-ROM or reside on
another computer on the network. Use the Browse button to locate the
desired profile. DEFAULT.SMA is the default file name chosen by the source
module.

In our example, the profile is located in the SMA folder on the source machine
and will be accessed over the network as shown in Figure 288.
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Figure 288. Choosing the SMA profile name and location

In the next window you can verify that the chosen profile is the correct one by
reading the comments for this selection:
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Figure 289. SMA migration profile comments

If you wish to modify some of the settings that will be applied to the target
machine, click the Edit the SMA file check box as shown in Figure 290.

Figure 290. Modifying the SMA settings
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Settings that can be modified are:

• Computer Name (has to be unique to the network)
• Network Domain or Workgroup to which the target computer belongs
• IP Address (has to be unique on the network)
• Subnet Mask
• Default Gateway

Figure 291. Customizing the target computer settings

To start the migration process, click Yes.

Figure 292. Confirming to start the migration process
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When the process is finished, you can view the summary by clicking Next or
exit the program without the summary by choosing Cancel.

Figure 293. Completing the migration process

Summary includes:

• Source and destination drive
• Number of files migrated
• Report on errors that occurred
• Configuration settings migrated
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Figure 294. Migration summary

At the end of the transfer, an information window prompts you to reboot the
machine.

5.1.5 Unattended migration using SMA batch procedure
For large rollouts, system administrators can further minimize the time
needed for user environment migration by running them unattended. As
indicated earlier, there are two phases of migration: the source phase, done
by SRCBAT.EXE, and the target phase, which uses the TARBAT.EXE
program.

5.1.5.1 SRCBAT.EXE
SRCBAT.EXE can be executed from a command prompt or run within a batch
program. Since it runs without user intervention, it is necessary to create a
command file where you will be able to specify all important decisions already
known from interactive programs (such as Selective or Mass Migration, output
file location, Personality and Connectivity settings, specific files to migrate,
and registry settings to migrate).

During the installation, a command file template called
SRCCOMMANDS.TXT is placed in the main SMA folder, which you can
modify and use for migration. There is a modified command file in Appendix
A.2, “Command file for SRCBAT.EXE” on page 323.
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The syntax for command line usage is:

SRCBAT /c command file /o location

where /c defines the fully qualified location and name of the command file
you created (if no location is specified, it must reside in the same location as
SRCBAT.EXE file) and /o defines the location where output files (SMA profile)
are placed.

Note: A good practice before running SRCBAT and TARBAT from a command
prompt is to update the environment variable Path in the system properties on
the Windows machine. Append the SMA installation folder (\Program
Files\IBM\SMA) and its subfolder Profiles to it and you will avoid common
problems like this:

The following is an example of the successful execution of SRCBAT from a
command prompt:

If you want to run SRCBAT fully automated you can write a simple batch file
and start the source part simply by executing it. Here is an example of such a
batch file:

c:\progra~1\IBM\SMA>srcbat /c srccommands.txt/o C:\progra~1\IBM\SMA\profiles

A complete path for the profile must be provided.
SMA has encountered at least one error and is terminating.

C:\Program Files\IBM\SMA>srcbat /c srccommands.txt /o c:\progra~1\ibm\sma\profil
es\batch.sma
SrcBat has completed.

Configuration Settings were copied

No errors occurred.

REM This is a sample batch file for automated run of SRCBAT
C:
CD \Progra~1\IBM\SMA
SRCBAT /c c:\Progra~1\IBM\SMA\SRCCOMMANDS.TXT /o C:\Progra~1\IBM\SMA\Profiles
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5.1.5.2 TARBAT.EXE
The target part of the migration will be done by running the TARBAT.EXE
program from the command prompt or using a batch program. The valid
syntax is:

TARBAT /f .sma file /c command file

where /f defines the location and name of the previously created migration
profile (you can use any profile created using an interactive or batch
procedure) and /c defines the command file name and location.

Here the command file is much shorter and only includes the User_Exit
command (which gives you the possibility to run another program when
migration is finished), which is a command to specify the ADSM server to be
used as a migration source, and commands for communication settings. This
makes sense because settings such as computer name and TCP/IP address
have to be unique for the new machine.

During the installation, a command file template called TARCOMMANDS.TXT
is placed in the main SMA folder, which you can modify and use for migration.
There is a modified command file in Appendix A.3, “Command file for
TARBAT.EXE” on page 331.

An example of a successful execution of TARBAT from a command prompt
follows:

TARBAT can be run within a simple batch file:

C:\Program Files\IBM\SMA>tarbat /f c:\progra~1\ibm\sma\profiles\batch.sma /c
progra~1\ibm\sma\tarcommands.txt
TarBat has completed.

Configuration Settings were applied

REM This is a sample batch file for automated run of TARBAT
C:
CD \Progra~1\IBM\SMA
TARBAT /f C:\Progra~1\IBM\SMA\Profiles\Batch.sma /c C:\Progra~1\IBM\SMA\tarcommands.txt
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By scheduling the execution time of such a batch file the migration can be
carried out completely unattended during off-peak hours.
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Chapter 6. Installing Netfinity Servers with UM deployment tools

Remotely configuring systems is usually associated with distributing software to
client systems. However, IBM has a number of tools to allow the remote
configuration of both hardware and software on Netfinity servers.
Time-consuming tasks associated with Windows 2000 deployment such as
determining hardware compatibility, setting up the Advanced System
Management adapter, configuring the ServeRAID RAID controller, and installing
the operating system can be automated through the simple point-and-click
environment provided by IBM Universal Manageability tools.

6.1 Our environment

The examples in this chapter were performed on a Netfinity 5000 (8659) with
BIOS 1.15 acting as the target machine and an IBM 300PL (6862) with BIOS
48 which performed the duties of the LCCM server. The Netfinity 5000 ran
Windows 2000 Server. All of the drivers for the Netfinity Server were part of
the base operating system with the exception of the Advanced System
Management (ASM) device driver Version 1.11. The ASM used BIOS and
firmware V2.11 and the ServeRAID adapter ran 3.6 firmware. The IBM 300PL
was running Windows NT 4.0, Service Pack 6a and LCCM 2.5.1 with Service
Pack 3. The device drivers for the IBM 300PL were from the V2.1 Ready To
Configure CD. The systems were connected via an IBM 8222 10Mbps
Ethernet hub using the IBM 300PL onboard Etherjet adapter and a PCI
10/100 WOL Etherjet adapter in the Netfinity 5000.

6.2 Analysis of systems for installation

Determining what servers are hardware compatible with Windows 2000
Server can be a daunting task, especially when you are faced with multiple
servers of various types at remote locations. The data gathering and remote
execution capabilities of Netfinity Director can be leveraged to acquire the
information needed to make the proper migration decisions. The same
techniques used with IBM desktop systems can be applied to the Netfinity
Server line. Please refer to 2.2, “Analysis of systems for upgrade” on page 35
for further details.

6.3 LCCM profile creation prerequisites

There are a pair of tasks that must be completed before a Windows 2000
Server image can be generated for LANClient Control Manager (LCCM).
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First, if the IBM ServeRAID controller is being used as one of the host bus
adapters the required RAID configuration must be captured to a file. This will
allow the remote setup of the controller. The second concern deals with
configuration of the Advanced System Management adapter (ASM). A setup
file must be created to instruct ASM how it is to be configured.

6.3.1 Capturing ServeRAID configuration
Capturing the ServeRAID configuration to a file can be accomplished using
the IPSSEND.EXE command line utility. This executable is distributed as part of
the IBM ServeRAID Command Line Program Diskette or the ServeRAID Support
CD-ROM. Either media image can be downloaded from
http://www.pc.ibm.com/support under the Netfinity Server section.

Open a Windows NT 4.0 command prompt and execute IPSSEND BACKUP 1

A:\5000CFG.IPS NOPROMPT. This command requests a backup of the configuration
for ServeRAID adapter 1 to the file A:\5000CFG.IPS without requiring user
intervention. Once it has completed you will be returned to a command prompt.

Copy the file to a share point for distribution via LCCM. The typical location
for the file is on the LCCM server in the %LCCM INSTALLATION
DIRECTORY%\CLNTFILE\RAID directory. The ServeRAID configuration is
typically updated during an operating system installation profile. An example
of integrating this file into a profile is provided in 6.4, “Creating a Windows
2000 Server unattended installation via LCCM” on page 257.

6.3.2 Configuring the Advanced System Management adapter
The Advanced System Management (ASM) adapter can be configured during
the normal execution of an LCCM profile. The process consists of the LCCM
utility SERVPROC.EXE reading settings from a text file (.INI) specified by the
user and converting them to a format (.PKT) that can be sent to the ASM. The
utility SENDSLIM.EXE is then called to transfer the configuration to the ASM
itself. An example of the service processor configuration .INI can be found in
the file %LCCM INSTALLATION
DIRECTORY%\CLNTFILE\DEFAULTS\SERVPROC.INI. This process can be

C:\>IPSSEND BACKUP 1 A:\5000CFG.IPS NOPROMPT

Found 1 IBM ServeRAID Controller(s).
Back Up Configuration has been initiated for controller 1...
Command Completed Successfully.

C:\>
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used with both the PCI and ISA versions of the Advanced System
Management adapter.

To remotely configure the ASM using LCCM you must start by modifying the
SERVPROC.INI file to meet your needs. All of the relevant configuration
settings are remarks contained within the example file. To enable a setting,
unremark the relevant line and make the desired modifications to the
parameter. In this case you are enabling modem auto-answer for serial port 1.

Save the configuration file to a shared directory, preferably to %LCCM
INSTALLATION DIRECTORY%\CLNTFILE\DEFAULTS. The file must reside in
a shared directory since LCCM uses a Universal Naming Convention (UNC)
name to access the file. Assigning the new settings to a target is
accomplished from the LANClient Control Manager Individual Client Details
window. From the LANClient Control Manager Installation/Maintenance
window highlight the desired target system and click Client -> Configure.

[Modem]; 4.1
[Modem Software Config]; 4.1.1
; Dial-In Activated = 0 ; 0=deactivates, 1=activates
; Dial-Out Table Retry Delay = 60 ; Number of seconds before dial-out numbers are
retried
; Dial-Out Table Retry Limit = 0 ; Number of times the table will be retried ie. a
value of 0 will call all the dial-out table entries once
; Dial-Out Number Retry Delay = 10; Number of seconds before trying the next number in
the table
; Dial-In Tamper Delay = 0; Number of minutes before allowing the next remote login to
occur
[Port Info]; 4.1.2
[Port 1]; 4.1.2.1
; Baud = 47; Baud rate = (Data+1)*2400. Hence 47 is equivalent to 115.2K baud
; Parity = 0; 0=None, 1=Odd, 3=Even, 5=Mark, 7=Space
; Stop Bits = 0; 0=1, 1=2 or 1.5
; Modem Initialization = " " ; Init string for modem. Max 127 characters.
; Port Select = 1; 0=disabled, 1=enabled
; Modem Caller ID = " "; Caller ID information. Max 31 characters.
; Modem Escape Guard Time = 100; Length of time before and after escape string is issued
to modem. Measured in 10ms intervals.
; Modem Escape = "+++"; String used to return modem to command mode. Max 15 characters.
; Modem Dial Prefix = "ATDT"; String used before number is dialled. Max 15 characters.
; Modem Dial Postfix = " M̂"; String used after number dialled to tell modem to start
dialling. Max 15 characters.
Modem Auto Answer = "ATS0=2"; String used to tell modem to answer phone when it rings.
Max 15 characters.
; Modem Auto Answer Stop = "ATS0=0"; String used to tell modem to stop answering phone.
Max 15 characters.
; Modem Query = "AT"; String used to find out if modem attached. Max 15 characters.
; Modem Hang-up = "ATH0"; String used to hang-up modem after a session is finished. Max
15 characters.
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Figure 295. Opening the Individual Client Details

The LANClient Control Manager Individual Client Details window appears.
Selecting the Hardware tab displays the Service Processor configuration
section in the lower half of the window. To set the configuration file to be
used, click Browse and navigate to the location of the .INI file (in this case,
C:\LCCM\CLNTFILE\DEFAULTS\5OOOPROC.INI), and click Open. Notice
that the path name on the local drive is automatically converted to the UNC
share path. To activate the Service Processor update, check the Enable
configuration check box. The Type of Service Processor used by the target
system will be determined during the scan process. Click OK.
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Figure 296. Selecting the Service Processor configuration file

The Service Processor configuration will be updated during execution of the
next profile assigned to the target system.

6.4 Creating a Windows 2000 Server unattended installation via LCCM

At the LANClient Control Manager Installation and Maintenance window, click
Profile and select Create new from the pull-down menu.

Figure 297. Creating a new WIndows 2000 Server profile

When the Create New Profile window appears choose the Use the Profile
Wizard radio button and click OK.
Chapter 6. Installing Netfinity Servers with UM deployment tools 257



Figure 298. Selecting the LCCM wizard to create the Windows 2000 Server profile

A welcome window for the LANClient Control Manager Profile Wizard will be
presented. Enter a name for the profile, select the Unattended install radio
button, and choose Windows 2000 Server from the operating system
drop-down menu. Click Next.

Figure 299. Setting installation details for the WIndows 2000 Server profile

Select the appropriate language from the drop-down menu and click Next.
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Figure 300. Selecting a language for the Windows 2000 Server profile

Check the Yes, the target clients have RAID adapters installed check box.
You are then requested to provide a RAID setup file. Check the Copy new
RAID setup file from... check box and choose Have Disk. Navigate to the
location of the RAID configuration file. For this example it is
C:\LCCM\CLNTFILE\RAID\5000CFG.IPS, and click Open. Notice that the
path name on the local drive is automatically converted to the UNC share
path. Click Next. For details on how to create the RAID setup file please refer
to 6.3.1, “Capturing ServeRAID configuration” on page 254.
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Figure 301. Configuring the ServeRAID for the Windows 2000 Server profile

The next window will ask for partitioning information. Click First partition of
fixed size, second partition using remaining allowed space. Enter 4096 in
the Size of fixed partition (C:) field. For the Select the file system format to
use for your partitions section, choose the NTFS button and click Next.
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Figure 302. Choosing a partition and file system scheme for the server profile

We are now asked for Profile Customization information. Enter a name in the
Company Name field and provide the Windows 2000 Server CD key. Click
Next to continue.
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Figure 303. Providing Profile Customization information for the server profile

Select the appropriate time zone from the drop-down menu and choose Next.
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Figure 304. Setting the time zone for the server profile

Click the radio button for the desired server type, in this case Stand Alone,
then specify the Server Licensing Method. For this example Per Seat should
be selected. Continue by clicking Next.
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Figure 305. Choosing server configuration information for the server profile

For the Network Environment section select the proper domain model and
provide the requested supplemental information. In the Network protocols
section choose the desired protocol. This example will use TCP/IP; therefore
click the TCP/IP radio button then click Next.
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Figure 306. Configuring Networking for the server profile

Since we selected TCP/IP for the target’s protocol we are now requested to
provide the necessary settings. Click the Configure TCP/IP settings
manually radio button and enter the appropriate Subnet Mask and Default
gateway for the target machine. Choose Next when finished.
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Figure 307. Configuring TCP/IP protocol settings for the server profile

We are now asked for the DNS and WINS settings. To enter the information,
enable the resolution type by clicking on the associated check box and filling
in the requested fields. Click Next when complete.
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Figure 308. Setting WINS and DNS Configuration for the server profile

A Profile Summary will now be displayed listing your configuration choices for
review. At this time a description of the profile can be entered in the field
provided. Click Next when satisfied with the settings.
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Figure 309. Profile Summary for the Windows 2000 Server profile

If this is the first time a Windows 2000 Server profile has been created you
are prompted to build a Windows 2000 Server image. You will not need to
repeat this step for future profiles of the same type.

Click Build images.
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Figure 310. Creating a Windows 2000 Server operating system image

A window will appear asking if you are ready to build the image. Place the
installation media for the application in a drive if required and click Yes.

Figure 311. Confirming if the image is ready to be built

Navigate to the location of the setup files for the software, highlight the setup
executable, and click Open.
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Figure 312. Selecting the setup executable

LANClient Control Manager will copy the software installation files to a share
point on the LCCM Server. Repeat the build process until all the software
packages have images built. Click Finish.

Figure 313. Completion of building images for the Windows 2000 Server profile
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You are now returned to the LANClient Control Manager Installation and
Maintenance window. Under Profiles and Assigned Clients the new image will
appear. A target system can now be assigned to the profile.

Figure 314. The Windows 2000 Server profile

For further information on assigning clients to a profile please refer to 3.1.1.2,
“Assigning the client to the installation profile” on page 122. Additional details
about LANClient Control Manager can be found in Chapter 3., “Unattended
Windows 2000 deployment for new systems” on page 101, the Redbook
Using LCCM Functions with Servers and Workstations, SG24-5292, and the
LCCM product documentation available at:
http://www.pc.ibm.com/us/desktop/lccm/.
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Chapter 7. Using UM Deployment Tools on non-IBM clients

In this chapter we show you how to use the UM tools on non-IBM systems.
For testing these we used the following non-IBM systems:

• Dell OptiPlex GX1

• HP Vectra VLI8

On the Dell system we ran Windows NT Workstation 4.0 with SP6a and on
the HP system we ran Windows 98 and Windows NT Workstation 4.0 with
SP6a.

7.1 LANClient Control Manager (LCCM) on non-IBM systems

The LANClient Control Manager server ran on IBM and non-IBM systems. In
the version we used in the book (beta of V2.5.1 Service Pack 3, February
2000), deployment to IBM systems (PC 300, ThinkPad, IntelliStation and
Netfinity Server) is supported. It is important that the systems use NIC with
WOL support, which corresponds to the WMI 1.1 standard.

For further information and for the latest version of LCCM and its Service
Pack you should visit the following Web site:

http://www.pc.ibm.com/us/desktop/lccm/

7.2 Netfinity Director on non-IBM systems

Netfinity Director and the UM Services (as the Netfinity Director Agent) run on
non-IBM systems. For Netfinity Director and its client, you need additional
licenses for non-IBM systems. For the price and availability of the licenses
contact your local IBM sales representative.

We show you how to check the non-IBM system for Windows 2000 readiness.
For that we installed Netfinity Director on an IBM 300PL running Windows NT
Server and UM Services on two non-IBM systems (Dell and HP). After
rescanning from the Netfinity Manager Console, the systems were visible in
the console window.

Then we started the test for Windows 2000 readiness. We used the static
group, Systems not Windows 2000 ready, for this test. How to create this
group is described in 2.2.1.1, “How to use Netfinity Director to gather
inventory” on page 36. This group has all the values for Windows 2000 Pro
readiness set to their maximums. All systems that didn’t reach these values
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are not Windows 2000 ready from the hardware perspective. The HP system
in this group is shown in Figure 315. Now we check the inventory of the
system to see why it is in this group. For example, we can see if the system
doesn’t have enough memory to run Windows 2000. After installing additional
memory, the system is removed from this group.

Figure 315. Netfinity Director

We can see the system information of the non-IBM systems by
double-clicking the system. A window opens with the system information for
the selected system. You can see this for the Dell system in the following
window:
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Figure 316. System Information Dell GX1

Now we check if there is software installed on the system that is not Windows
2000 ready. For this we use the Process Manager in Netfinity Director, where
we had created tasks to check out our systems. How you create and install
these tasks is described in 2.2.1, “Use Netfinity Director to determine
hardware and software” on page 35.

We selected in the Netfinity Director console the Process Management ->
Process Task -> Microsoft W2K compatibility audit task. This task uses
the Microsoft /checkupgradeonly option from the Windows 2000 winnt32.exe
command in this task (check for details in 2.2.1.3, “Netfinity Director and
Microsoft’s Analysis tool” on page 60). We dragged this task and dropped it
on the HP Vectra system in the middle pane. A process task window shows
the task and the result (Figure 317).
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Figure 317. Process task window

Our W2K compatibility task creates a log file with the results from the check.
You can see a piece of the log file for the HP system containing the results of
the check:

Hardware
--------
This section of the report describes hardware compatibility issues.

Incompatible Hardware

The following hardware may not support Windows 2000 without
additional files. Please see the Microsoft Windows 2000 Hardware
Compatibility List at
http://www.microsoft.com/windows2000/compatible/ for a list of
compatible hardware. (Some of the following entries might be software
that is registered as hardware.)

Sound, video and game controllers
Crystal SoundFusion(tm) Game Device
Crystal SoundFusion(tm) Joystick

You can continue with the upgrade, but the hardware may not work
until you supply the additional files.

Software Incompatible with Windows 2000
---------------------------------------
This section lists information about programs that are incompatible
with Windows 2000. Before upgrading, evaluate how important these
programs are to you.

Software That Does Not Support Windows 2000
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You can see in this log file what the HP system must be to make it Windows
2000 ready. You can use Netfinity Director to access the system and change,
delete or update drivers and programs.

This shows that you can use Netfinity Director on non-IBM systems to check
for the readiness of these systems for Windows 2000. Netfinity Director
supports all systems on which a UM Services agent (part of Netfinity
Director) is installed.

7.3 SMA on non-IBM systems

You can use the System Migration Assistant to port settings stored on
non-IBM systems, such as personal or connecting information and registry
settings, to IBM systems. You can’t migrate a non-IBM system with the
version of SMA that we used.

In this section we show how you should set up SMA to port the settings from
an HP Vectra running Windows 98 to the IBM 300PL system running
Windows 2000 Professional.

We installed the SMA source on the HP Vectra running Windows 98.
Information about the install process of SMA can be found in 5.1.2, “Installing
System Migration Assistant” on page 213. When started, we selected the
Selective Deployment. With this setting we can bring the selected personal
and connection settings, files, folders and registry entries from the source
system to the target system. A description of the selective migration can be
found in 5.1.3.1, “Selective Migration” on page 219.
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Figure 318. Migration method selection

Note: Mass Migration is supported only at the same operating system level.

A description of Mass Migration can be found in 5.1.3.2, “Mass Migration” on
page 234.

Now you must select the check boxes in the next window. Only the selected
features will be migrated. In Figure 319 on page 279 you see for example, the
selection for the personality settings. In our example, we also selected the
Connectivity settings and the files and folders selection.

Two additional features that you can select are the registry selection and the
extension selection. With the extension selection, you can select files from a
type to migrate. For example, if you have a lot of *.doc files in different folders,
you can select all of these files with a single click. For a detailed description
see 5.1.3.1, “Selective Migration” on page 219.
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Figure 319. Select the settings you will migrate

When your selection is finished, the following window (Figure 320) appears:

Figure 320. Personality selection
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In the Personality settings selection window select all of the settings that you
want to migrate. After this, click Next and make the selection for the
Connectivity settings. What you should do to make all the necessary settings
for these selections is also described in 5.1.3.1, “Selective Migration” on page
219.

After clicking Next you see the scan window. This window appears because
you selected the files and folder option. This function scans the complete
system and shows the results in a window. Select the files and the folder you
want to bring to the new system. You will get an error message when you
select executable files in the Selective Migration, because Selective Migration
doesn’t support transferring settings for programs. The message is shown
below:

Figure 321. Warning about migrating *.exe files

After selecting the files and folder, click Next. Select the SMA file and profile
destination (in our example we left the standard settings; see Figure 322),
click Next and select Start to begin the copying process for the selected
settings.
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Figure 322. Selecting profile and output destination

When the copy process finishes you will see a summary window. This is
shown in Figure 323 on page 282. In this window you can check the results.
You can also see the destination where the files were copied.
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Figure 323. Summary window source system

With this action the work on the source system is done. You can also perform
all these actions with the command line tool srcbat.exe. Details on srcbat.exe
can be found in 5.1.5.1, “SRCBAT.EXE” on page 249.

Now we can change the target system. In our example, the target system is
an IBM 300PL. On the 300PL we installed Windows 2000 Pro using the
LCCM server. Now we want to bring our settings to this system.

We installed SMA on the IBM 300PL and started the target part of SMA by
clicking Start -> Programs -> System Migration Assistant -> Target. There
you must specify the *.sma file which contains the data for the migration (in
our example we used default.sma). This file can be local, on the LAN
(mapped network drive) or on a CD-ROM.
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Figure 324. SMA file location

When you have selected the SMA data file, click Next. You will see a window
where you are asked if you want to change the SMA File options, such as the
computer name, the IP settings, and domain. You should select Edit the SMA
file to make the changes as shown in Figure 325.
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Figure 325. Selection to edit the SMA file

You can change the computer name, domain, and IP settings which are in the
SMA file. For detailed information about the settings, the editing of the *.sma
file and the procedures for running on the target system, see 5.1.4, “Applying
captured settings to the target machine” on page 242.

In our example, the source system has the name HP Vectra and the IP
address is 10.1.1.133 in the workgroup UM. We changed the name to 300PL,
the IP address to 10.1.1.134 and the domain to WTRNTDM. When we
finished the changes we clicked Next. A window appeared (Figure 326). You
should select Yes to start the transfer process.

Figure 326. Start transfer process
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When the transfer is finished you get a message that shows you the status of
the transfer. After that you get a message to reboot your system. This is
necessary to make the new settings active.

After rebooting you can check if the settings have been transferred and are
active in the new system. We first checked the files and folders which were
transferred in our example. We found the files and folders available on the
new system. Also the network connection that was set on the old system was
available on the new one.

You can see how you can use SMA on non-IBM systems to bring all of the
necessary settings from these systems to IBM systems. When using SMA on
IBM and non-IBM systems there are no changes on the source system. For
details about the settings and the procedures for using SMA see 5.1, “System
Migration Assistant” on page 211.

With SMA you have a tool that gives you great support for the migration of
systems and helps you to reduce the TCO in your company. For updates and
further information about new features and supported systems see the
following Web site or ask your local IBM sales representative for help:

http://www.pc.ibm.com/us/software/sysmgmt/products/sma/

7.4 SDA on non-IBM systems

The Software Delivery Assistant can be run on IBM and non-IBM systems.
You can use SDA on systems running the Windows operating system
(Windows 98, Windows NT and Windows 2000). For example, you can
prepare your applications on Windows NT to be delivered to Windows 2000.
You can run the SDA-Administrator on all systems. The SDA-Installer that we
used in this book was only used on IBM systems.

The detailed description of the Software Delivery Assistant can be found in
4.1, “Software Delivery Assistant” on page 175.

In this section, we show how to prepare an HP system running Windows NT4
to deliver to the Administrator Group in Netfinity Director and the SysMgt
client group, UMS V2.12. In the common group we deliver Norton AntiVirus
V5.02.04 for all systems. The target system for the clients is an IBM 300PL
running Windows 2000 Professional. For the SysMgt client group it is a
Netfinity 3000.
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First start the SDA installation. Information about the installation process can
be found in 4.1.1, “Installing SDA” on page 175. The SDA program can be
downloaded from the Internet at:

http://www.pc.ibm.com/ww/solutions/enterprise/sysmgmt/products/sda/index.html

When starting SDA you will be asked about the workspace. The first time
SDA is started you should create a new workspace. Select Create new
workspace (shown in Figure 327) and click OK.

Figure 327. SDA workspace selection

Then type the workspace name in the entry field on the next screen. The
workspace name should be in context with the application or group. This will
be helpful for administration. After you enter the name click Next to continue
the creation of the workspace. In our example we called the workspace, Our
Company Workspace. Details on how you should create a workspace in the
SDA-Administrator program can be found in 4.1.2, “SDA-Administrator” on
page 180.

When you are finished, the settings for the main workspace windows will be
opened, as shown in Figure 328.
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Figure 328. SDA-Administrator main window

Here you can prepare all the applications you want to deliver to the systems
in your company. How you prepare the applications is also described in 4.1.2,
“SDA-Administrator” on page 180.

After selecting all of the applications to build the image, you can port the
image to the systems where you want to install the applications. In the version
we used for the book (beta of SDA V1.1 from February 2000) the
SDA-Installer was only supported on IBM systems. Please check the Web site
below for updates. Information on how you should use the SDA-Installer can
be found in 4.1.3, “SDA-Installer” on page 204.

You should see that are there no differences in using SDA on IBM or non-IBM
systems. For further information about supported systems and for upgrades
please check the following Web site or ask your local IBM sales
representative:

http://www.pc.ibm.com/ww/solutions/enterprise/sysmgmt/products/sda/index.html
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Chapter 8. Support

In this chapter we show you all the ways to get support for the Universal
Manageability tools that we used in this book.

A central point for information about the Universal Manageability tools and for
downloading these tools and getting support can be found at the following
Web site:

http://www.pc.ibm.com/ww/solutions/enterprise/sysmgmt/products.html

Here you can find links to all the Universal Manageability tools as shown in
Figure 329:

Figure 329. Central link point for Universal Manageability tools

Another good place to access e-support for UM tools is the following Web
site:

http://www.pc.ibm.com/ww/solutions/enterprise/support/index.html
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Here you have access to the e-support UM forum described in the next
section and the e-mail support described in 8.2, “e-mail support for Universal
Manageability tools” on page 294. The Web site looks similar to Figure 330:

Figure 330. Access point for e-support for UM tools

8.1 e-forum support for Universal Manageability tools

For e-support for all parts of the Universal Manageability tools you should use
the IBM UM Solution discussion forum. To connect to the support forum, go to
the following location:

http://www6b.pc.ibm.com:8080/~ums

or click UM Solution Discussion Forum when you are at:

http://www.pc.ibm.com/ww/solutions/enterprise/support/index.html

as shown in Figure 330 on page 290. This will bring up Figure 331:
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Figure 331. Welcome screen for UM support forum

If this is your first time on this site, you must create a new user account. To do
that click New User. Now the following window appears:
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Figure 332. Creating a new user account for UM support forum

After filling out the fields (the fields marked with a red dot are required fields)
you come back to the window shown in Figure 331 on page 291. Type in your
user name and password. If you select Remember My Password you will
never be asked for it again (but you need to remember it in case your browser
has problems or you have to go to another system to access the site). Since
this is a security issue, you should only select that option if you are the only
one who uses the system. Now you will see the following window:
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Figure 333. Start screen for the user in the UM support forum

At the top of the left pane you will see any new messages since your last
logon. Below the messages are the categories for the messages (such as
LCCM, Netfinity Director, Netfinity Manager and Universal Manageability
Services). When you click an entry in the left pane the contents will be shown
in the right pane.

At the top of the right pane you see a toolbar that contains the following items:

• PC Support
• Post
• Mark as Read
• Options
• Help

If you want to insert your own problems or answers in this forum, you should
first select the category and if you want to answer the corresponding file, then
click Post. In the right pane a window will open:
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Figure 334. Post a new message to the support forum

Fill out the topic field corresponding to your problem and describe the
problem in the window below. When you have finished your editing, click Post
in the upper right corner. This will bring your message into the support page.
You should check regularly for answers to your problem.

8.2 e-mail support for Universal Manageability tools

To get access to e-mail support for UM tools, go to the following address:

http://www.pc.ibm.com/us/desktop/lccm/esupport.html

or open the Enterprise Support window shown in Figure 330 on page 290 at
the following location:

http://www.pc.ibm.com/ww/solutions/enterprise/support/index.htm
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If you access the e-mail support item, it opens the following window:

Figure 335. E-mail support form (1 of 6)

Please fill out the form completely (shown in Figure 335 on page 295 to
Figure 340 on page 300), A detailed description about your problem will help
to solve the problem quicker. You will get the information back within one
business day.
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Figure 336. E-mail support form (2 of 6)
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Figure 337. E-mail support form (3 of 6)
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Figure 338. E-mail support form (4 of 6)
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Figure 339. E-mail support form (5 of 6)
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Figure 340. E-mail support form (6 of 6)

8.3 FAQs and other information

For all UM tools you can find different FAQ sites or other information. The UM
tools also have good online help integrated into their programs, which can
help you to learn how to use the tools and help you solve problems by
yourself.

You can also find some links to FAQs and additional help sites for the UM
tools at the following Web sites:

• LCCM - FAQ, hints and tips

http://www.pc.ibm.com/us/desktop/lccm/hints.html

• Netfinity Director - Library

http://www.pc.ibm.com/ww/solutions/enterprise/sysmgmt/products/nfdir/library.html

• SDA - e-mail/e-forum
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http://www.pc.ibm.com/ww/solutions/enterprise/sysmgmt/products/sda/down
load.html

• SMA - User Guide

http://www.pc.ibm.com/us/software/sysmgmt/products/sma/

8.4 How can you find the UM tools

List of URLs for downloads of the UM tools:

• LCCM:

http://www.pc.ibm.com/us/desktop/lccm/

• SMA:

http://www.pc.ibm.com/us/software/sysmgmt/products/sma/

• SDA:

http://www.pc.ibm.com/ww/solutions/enterprise/sysmgmt/products/sda
/index.html

• Netfinity Director:

ask your IBM sales representative for the CD, which will be delivered with
new Netfinity server systems

• Netfinity Director Client (UM Services):

http://www.pc.ibm.com/ww/solutions/enterprise/sysmgmt/products/nfd
ir/index.html

• Netfinity Director desktop extensions:

http://www.pc.ibm.com/ww/software/sysmgmt/products/ums/extensions.html

• Netfinity Director server extension:

http://www.pc.ibm.com/ww/solutions/enterprise/sysmgmt/products/nfd
ir/serv_ext.html

Additional Universal Manageability tools can be found on the following Web
site:

http://www.pc.ibm.com/ww/solutions/enterprise/sysmgmt/products.html

8.5 Phone support

Below is a worldwide Help Center phone list. The list is from February 2000.
For updates to this list, please check the following Web site:

http://www.pc.ibm.com/support?page=YAST-3P2QYL
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Table 12. Help Center phone list (as of February 2000)

Country Language Customer Number Hours of Operation

Argentina Spanish 11-4717-4357 9 a.m. - 6 p.m. M-F

Australia English 131426 9 a.m. - 9 p.m. AEST - 7
days/week

Austria German 1-54658-5075 9 a.m. - 6 p.m. M-F

Belgium Dutch
French

02-717-2504
02-717-2503

9 a.m. - 6 p.m. M-F

Brazil Portuguese 55-11-889-8986 8 a.m. - 10 p.m. - Mo-F

Canada English
French

1-800-565-3344
1-800-565-3344

24 hours/day - 7 days/week
24 hours/day - 7 days/week

Chile Spanish 800-203300 9 a.m. - 6 p.m. M-F

China Mandarin 800-810-1818 8:30 a.m. - 5 p.m. M-F

Colombia Spanish 9-800-18811623-
-2300

8 a.m. - 10 p.m. M-F
8 a.m. - 4 p.m. Saturday

Denmark Danish 03-525-6905 9 a.m. - 6 p.m. M-F

Ecuador Spanish 2-565-130 8:30 a.m. - 6 p.m. M-F

Finland Finnish 9-22-931805 9 a.m. - 6 p.m. M-F

France French 01-6932-4003 9 a.m. - 6 p.m. M-F

Germany German 069-6654-9040 9 a.m. - 6 p.m. M-F

Hong Kong Cantonese 2825-7799 9 a.m. - 5 p.m. - M-F

Ireland English 01-8159207 9 a.m. - 6 p.m. M-F

Italy Italian 02-482-75003 9 a.m. - 6 p.m. M-F

Japan Japanese 0120-141-666 10 a.m. - 6 p.m. - 7 days/week

Luxembourg French 298-977-5060 9 a.m. - 6 p.m. M-F

Mexico Spanish 01-800-426-1000
387-5991

8 a.m. - 8 p.m. M-F

Netherlands Dutch 020-504-0531 6 a.m. - 6 p.m. M-F

Norway Norwegian 2-305-3203 6 a.m. - 6 p.m. M-F

Peru Spanish 349-0050 8:30 a.m. - 8:30 p.m. M-F
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8.6 Preparing for a support call or access to e-support

When you want to start a support call, you should be prepared to have
answers available for questions from the support team. To help you to have all
the necessary information available, we have created the following templates
for each of the UM tools we used, with examples for filling out the templates.

8.6.1 Preparing for LCCM support
Before starting the LCCM support call you should have all of the following
information available:

Table 13. Necessary information for LCCM support

Portugal Portuguese 01-791-5147 9 a.m. - 6 p.m. M-F

Spain Spanish 091-662-427 9 a.m. - 6 p.m. M-F

Sweden Swedish 08-632-0063 9 a.m. - 6 p.m. M-F

Switzerland German
French
Italian

01-212-1810
022-310-0418
091-971-0523

9 a.m. - 6 p.m. M-F

Taiwan Mandarin 886-2-2725-9799 24 hours/day 7 days/week

UK English 01475-555555 9 a.m. - 6 p.m. M-F

United States English 1-800-772-2227 24 hours/day - 7 days/week

Venezuela Spanish 800-426-72 8 a.m. - 5 p.m. M-F

Requested Information Example Information

Your company name IBM ITSO

Your phone number (919)301-xxxx

Your e-mail address xxxx@de.ibm.com

Your access PIN (if req’d)

LCCM Server

Model type and submodel 300PL (6862-R1U)

BIOS revision NVKT44AUS

NIC/FRU TR 16/4 PCI WOL

Country Language Customer Number Hours of Operation
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NIC driver version IBMTRP.SYS
5.22.03.055 (10/19/99)

NIC firmware level

NOS and SP Windows NT 4 Server
SP6a

Version of LCCM LCCM 2.5.1 SP3

LCCM Client

Model type and submodel 300PL (6862-R1U)

BIOS rev. NVKT44AUS

NIC/FRU TR 16/4 PCI

NIC firmware level

RPL or PXE/DHCP PXE/DHCP

DHCP server local or
remote

local

What software/OS is being
pushed?

Windows 2000

What feature of LCCM is
being used?

Wizard

What method is being
used?

unattended installation of
Windows 2000 pro

How is it configured (for
example, share point or
unattendet.txt)?

Network Topology

How are the server and
client connected?

10 Mbps Ethernet via cat5
cable through a
CISCO1700 switch

If you used routers, are the
boot ports open and
directed broadcasts being
forwarded?

Requested Information Example Information
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After filling out the list above, prepare a complete problem description. You
should have read the integrated help information, the FAQ and all of the
user’s guides before starting the support call.

8.6.2 Preparing for SMA Support
For the SMA support call you should have all the following information
available:

Table 14. Necessary information for SMA support

Example Information

Your company name IBM ITSO

Your phone number (919)301-xxxx

Your e-mail address xxxx@de.ibm.com

Your access PIN (if req’d)

SMA Source

Model type and submodel IBM 300PL (6862-R1U)

BIOS revision NVKT44AUS

NOS and SP Windows NT4 SP6a

NIC / FRU TR 16/4 PCI WOL

NIC driver revision IBMTRP.SYS
5.22.03.050 (10/08/99)

NIC firmware version

SMA version 2.1

Selected method for SMA Selective Migration

Selected settings Personality, connectivity

SMA Target system

Model type and sub model IBM 300PL

BIOS revision NVKT44AUS

NOS and SP Windows 2000

NIC/FRU TR 16/4 PCI

NIC driver version IBMTRP.SYS
5.22.03.050 (10/08/99)
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You should also read the user guide and online help before you start the call.
If you can’t find the necessary information, have all the details from the list
above and a detailed problem description available.

8.6.3 Preparing for SDA Support
For the SDA support call you should have all of the following information
available:

Table 15. Necessary information for SDA support

NIC firmware version

Required information Example Information

Your company name IBM ITSO

Your phone number (919)301-xxxx

Your e-mail address xxxx@de.ibm.com

Your access PIN (i req.)

SDA Administrator system

Model type and submodel Netfinity 3000(8476-31U)

BIOS revision NTKT14.0 (21.08.98)

NOS and SP Windows 2000

NIC/FRU TR 16/4 PCI WOL

NIC driver/revision IBMTRP.SYS
5.22.03.050 (10/08/99)

NIC firmware version

SDA version 1.1

Selected software for
deploying

Norton Antivirus
Netfinity Director

Installation method optional/recommended

When silent, are the files
for the silent installation
available?

SDA Installer system

Example Information
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Before you start the call you should have read the online help and the FAQ
sites about the product. Have all the information in the above table available.
This will help the support team to find a solution for your problem.

8.6.4 Preparing for Netfinity Director support
For Netfinity Director support you should have all of the following information
available. This will help the support team to give you a quick solution.

Table 16. Necessary information for Netfinity Director support

Model type and submodel IBM300 PL (6862-R1U)

BIOS revision NVKT44AUS

NIC/FRU TR 16/4 PCI WOL

NIC driver/revision IBMTRP.SYS
5.22.03.050 (10/08/99)

NIC firmware version

NOS and SP Windows 2000

Do you use a share point or
have you copied the SDA
install folder to the target
system?

Share Point

When using a share point
which network topology is
used?

TR

Are there routers or
switches in the network
between the SDA
Administrator and target
system?

no

How are these configured?

Required information Example Information

Your company name ITSO Raleigh

Your phone number (919)301 4540

Your e-mail address

Your access PIN (if req’d)

Required information Example Information
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Netfinity Director Server system

Model type and submodel Netfinity 3000 (8476-31U)

BIOS revision NTKT14.0 (21.08.98)

NIC/FRU TR 16/4

NIC driver/revision IBMTRP.SYS
5.22.03.055 (10/19/99)

NIC firmware version

NOS and SP Windows 2000 (build 2195)

Netfinity Director version 2.11

Database installed for
Netfinity Director

Standard (director.mdb)

Database version

Features selected for
Netfinity Director during
installation?

SNMP support, Remote
Web access

Are there server or desktop
extensions installed?

yes

Which version of the
extensions are installed?

Server extension version
1.0

List of installed extensions
with versiona

*Advanced system
Management support
(V2.1)
*Capacity Manager (V6.0)
*Cluster Administrator
(V1.1)
*Raid (V1.0)

Netfinity Director console system

Model type and submodel Netfinity 3000(8476-31U)

BIOS revision NTKT14.0 (21.08.98)

NIC/FRU TR 16/4 PCI

NIC driver/revision IBMTRP.SYS
5.22.03.055 (10/19/99)

Required information Example Information
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The Netfinity Manager gives you a lot of system management tools in one
central place. To help the support people, have all the information requested
in the above tables available. This will help the support team to give you the
best support.

NIC firmware version

NOS and SP Windows 2000 Server
(Build 2195)

Netfinity Director Console
version

2.11

Netfinity Director client system

Model type and submodel IBM 300PL (6862-R1U)

BIOS revision NVKT44AUS

NIC/FRU TR 16/4

NIC driver/revision IBMTRP.SYS
5.22.03.055 (10/19/99)

NIC firmware version

NOS and SP Windows 2000 Pro (2195)

Netfinity Director Client
versionb

2.11

Network topology

Which type of network
connects the Netfinity
Director Server, console
and client?

Token ring, 16Mbit

Are there any routers and
switches in the Network?

no

a. Can be found when selecting Help -> Product Information running
the Netfinity Director console.
b. Can be checked by Start -> Program -> IBM UM Services Help here
in the point UM Services -> Overview -> About

Required information Example Information
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Chapter 9. Troubleshooting

While creating the examples in this book we realized that there would be a
need to examine the difficulties we had and to share our solutions for them.
The following sections present our experiences in a Frequently Asked
Questions (FAQ) format for each application.

9.1 LANClient Control Manager

How do I configure the $OEM$ directory for a WIndows 2000 LCCM profile
created by the wizard?

When the LCCM Profile wizard creates an unattended installation profile it
makes a common distribution point for the installation files. Since these
files can be used by multiple profiles, LCCM stores the individual profile
custom settings, such as the $OEM$ directory, in the profile’s home
directory and not at the distribution share point. These settings are stored
in a series of PROFXXX directories under %LCCM INSTALLTION
DRIVE%\clntfile\profile\, where XXX is the number of the profile. The first
profile created will be PROF000 and each new wizard-generated profile
will increment the number by one. If you want to modify the $OEM$
directory, simply find the appropriate profile number and make the desired
changes to the OEM directory under that PROFXXX. The changes will
take effect for the next client processed.

How can I modify the answer file for an LCCM wizard-generated Windows
2000 unattended install?

The answer file is stored in the home directory of the profile. This directory
is located under %LCCM INSTALLTION DRIVE%\clntfile\profile\ and is
named PROFXXX, where XXX is the number of the profile. The first profile
created will be PROF000 and each new wizard-generated profile will
increment the number by one. The answer file itself is named
PROFXXX.LCA.

When I assign a client to a profile it does not Wake on LAN.

Under certain circumstances when the machine is improperly shut down
Wake on LAN does not realize that the machine is powered off. To correct
this problem remove power from the machine until the network interface
card link LED goes out. Once power is restored the machine should wake
normally.

After installing Windows 2000 the system will no longer Wake on LAN.
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With certain BIOS levels there are issues with ACPI support that cause
Wake on LAN not to function after Windows 2000 is installed. Disabling
ACPI support in the BIOS under Power Management can be used as a
work around until a resolution can be obtained from IBM support. Please
refer to Chapter 8, “Support” on page 289 for information about contacting
IBM for assistance.

9.2 System Migration Assistant

When I run SRCBAT.EXE I receive a file in use error even though the file
name for the profile is unique.

This error will occur if either the output location specified on the command
line does not match the one indicated in the SRCCOMMANDS.TXT file or
if full drive letter path names are not used for the output location, profile
name, and SRCCOMMANDS.TXT file. To execute the application over a
network a mapped drive must be used. UNC path names are not valid for
SMA.

The command line C:\Progra~1\IBM\SMA\SRCBAT.EXE /C

C:\Progra~1\IBM\SMA\SRCCOMMANDS.TXT /O C:\TEMP\ coupled with the
SRCCOMMANDS.TXT entries presented in the Figure 341 illustrate the
proper command line syntax for SMA.
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Figure 341. SRCCOMMANDS.TXT

Can I use SMA 2.0 command files with SMA 2.1?

No, there are differences between the versions that can cause problems
when restoring the settings. It is suggested that the profiles be generated
again for SMA 2.1 using the new command files.

Can I upgrade to SMA version 2.1 without first uninstalling SMA 2.0?

No, SMA 2.0 must be removed from the system before SMA 2.1 is
installed.

When I perform a mass migration from Windows NT to Windows 2000 I end
up with a blank desktop and an unusable machine. What am I doing wrong?

;==================================================
;OUTPUT LOCATION
;
; Usage:
;Place, after the equal sign, the
;location that is to be used for the
;output files destination. This will
;be ignored if ADSM is being used in
;which case the output files will go
;to the ADSM server.
;
; BOTH SELECTIVE AND MASS MIGRATIONS!
;==================================================
[Output_Location]
OutputLocation=C:\TEMP\
;==================================================
;
;
;
;
;==================================================
;PROFILE NAME
;
; Usage:
;Place the name of the profile after
;the equal sign. This is the name
;that will be used for the profile
;unless another one was specified on
;the command line.
;
; BOTH SELECTIVE AND MASS MIGRATIONS!
;==================================================
[Profile_Name]
ProfileName=C:\TEMP\SETTINGS.SMA
;==================================================
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SMA 2.1 is not capable of performing a mass migration across platforms.
Mass migrations can only be performed between similar machines with the
same operating system.

9.3 Software Delivery Assistant

How can I reinstall the required applications or select another group using
SDA Installer if I have already run it successfully?

The hidden file SDAPROF.INI in the root directory of the system and the
registry key HKEY_CURRENT_USER\Software\IBM\SS must be deleted
to allow the applications for any group to be installed or reinstalled.

Can I use UNC path names with SDA?

SDA must have a mapped network drive for the application to run properly.

9.4 Netfinity Director and Universal Manageability Services

When I assign a system to a process task and execute it I receive a status
stating that Command “COMMAND“ targeting SYSTEM has completed with
Other Error[-1]

Typically this will occur when the login account specified in the process
task does not have adequate permission to complete the action. This is
usually seen when a command is called using a UNC path name.

I have upgraded to Windows 2000 from Windows 98 on my client and in the
process uninstalled and reinstalled UM Services. Netfinity Director now
indicates that the machine is offline even after a presence check.

This situation will happen under both Windows 98 and Windows NT 4.0.
When UM Services is uninstalled and then reinstalled a new unique ID for
the system is generated. The old system icon should be deleted and a
new discovery run so that the machine is now associated with its new ID.

When I am setting the criteria for a new Dynamic Group the only way I can get
the correct AND/OR groupings is by adding criteria in a particular order. Is
there a better way to do this?

The Selected Criteria for a Dynamic Group can be dragged and dropped
to any Boolean function folder; therefore, criteria can be added in any
order desired and organized as required.
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Appendix A. SMA customization files

This appendix contains copies of the SMA V2.1 customization files so that
you can review them before you have the product.

A.1 SMA GUI program’s configuration file

This is a configuration file for SMA’s GUI program. The configuration
commands within determine its default behavior. It is a text file and can be
edited with a standard text editor program (such as Notepad). By changing a
particular parameter the default setting of that part of the SMA procedure will
be changed. Setting a 1 next to a parameter will check that setting’s check
box in the SMA GUI program when the user clicks Load Defaults button.

Each parameter is described in its section of the file under the heading
Description. The file is divided into three sections:

1. Mass and Selective Migration

2. Selective Migration only

3. Mass Migration only

The migration method is again noted with each command next to its
description.

SETTINGS.TXT has to be located in the \Program Files\IBM\SMA\Support
directory.

;++++++++++++++++++++++++++++++++++++++++++++
;
; S E T T I N G S . T X T
;
;++++++++++++++++++++++++++++++++++++++++++++
;
; SETTINGS FILE FOR GUI VERSION OF
; SYSTEM MIGRATION ASSISTANT (SMA)
;
; Description:
; This file is where default behavior
; for the GUI version of SMA can be
; set.
;
; Note: SMA is not case sensitive with any
; of the text appearing within this
; file.
;
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; For example: C:\DOCUMENTS\FILE.TXT
; is treated the same as
; c:\documents\file.txt
;
;++++++++++++++++++++++++++++++++++++++++++++
;
;********************************************
; MASS AND SELECTIVE MIGRTION SETTINGS
;********************************************
;
;============================================
; WARNING EXTENSIONS
;
; Description:
; These are extensions that will
; generate a warning message when
; the warning message option has been
; selected and the user selects
; a file for migration that has the
; same extension as one of those
; listed below. Place an extension,
; preceded with the ".", in the list
; after "Warnings_Start" and before
; "Warnings_End".
;
; BOTH SELECTIVE AND MASS MIGRATION
;============================================
[Warnings_Start]
.com
.dll
.drv
.exe
.lib
.sys
.vxd
[Warnings_End]
;============================================
;
;============================================
; USER EXIT
;
; Description:
; Provide the name of the command file
; that is to be executed upon finishing
; the SMA migration process.
;
; BOTH SELECTIVE AND MASS MIGRATIONS!
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;============================================
[User_Exit]
UserExit=
;============================================
;
;********************************************
; SELECTIVE MIGRATION SETTINGS
;********************************************
;
;============================================
; INCLUSION EXTENSIONS
;
; Description:
; Place an extension, preceded
; with the ".", in the list
; after "Inclusion_Extension_Start"
; and before "Inclusion_Extension_End"
; in order to have that extension
; checked when "Load Defaults"
; is clicked. In addition, on
; the extension selection page,
; the extensions in the list that
; match these extensions will be
; checked by default. The directory
; tree will also, by default,
; check all files that match these
; extensions.
;
; For example: .txt
;
; SELECTIVE MIGRATION ONLY!
;============================================
[Inclusion_Extension_Start]
.000
doc
txt
[Inclusion_Extension_End]
;============================================
;
;============================================
; INCLUSION FILES
;
; Description:
; Place a file name, with its
; complete path, in the list after
; "Inclusion_File_Start" and before
; "Inclusion_File_End" in order to
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; have that file checked when
; "Load Defaults" is clicked.
;
; For example: c:\important.txt
;
; SELECTIVE MIGRATION ONLY!
;============================================
[Inclusion_File_Start]
[Inclusion_File_End]
;============================================
;
;============================================
; INCLUSION FOLDERS
;
; Description:
; Place a folder name, with its
; complete path, in the list after
; "Inclusion_Folder_Start" and before
; "Inclusion_Folder_End" in order to
; have that folders and all of it's
; files and subdirectories checked
; when "Load Defaults" is clicked
; and when first entering the File &
; Folder Selection page.
;
; For example: c:\important\mydocs
;
; SELECTIVE MIGRATION ONLY!
;============================================
[Inclusion_Folder_Start]
[Inclusion_Folder_End]
;============================================
;
;============================================
; PERSONALITY SETTINGS
;
; Description:
; Place a 1 next to the settings that
; are to be checked. Place a 0 next
; to the settings that are not to be
; checked. These choices will take
; effect when first entering the
; "Settings" page and when the
; "Load Defaults" button is clicked on
; the "Settings" page.
;
; The order in which these settings
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; appear below must not be changed nor
; should any of them be removed.
;
; SELECTIVE MIGRATION ONLY!
;============================================
[Personality_Start]
accessibility=1
activedesktop=1
colors=0
desktopicons=0
display=1
iconfont=1
internetbrowser=1
keyboard=1
mouse=1
pattern=0
printers=1
screensaver=1
sendto=1
shell=1
sound=1
startmenu=1
taskbar=1
userprofiles=1
wallpaper=0
windowmetrics=0
[Personality_End]
;============================================
;
;============================================
; CONNECTIVITY SETTINGS
;
; Description:
; Place a 1 next to the settings that
; are to be checked. Place a 0 next
; to the settings that are not to be
; checked. These choices will take
; effect when first entering the
; "Settings" page and when the
; "Load Defaults" button is clicked on
; the "Settings" page.
;
; The order in which these settings
; appear below must not be changed nor
; should any of them be removed.
;
; SELECTIVE MIGRATION ONLY!
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;============================================
[Connectivity_Start]
computerdescription=0
computername=1
dnsconfiguration=1
domain=1
mappeddrives=0
rasnetworking=1
sharedfolders=1
tcpipconfiguration=1
winsconfiguration=1
workgroup=0
[Connectivity_End]
;==========================================
;
;==========================================
; FILTERED EXTENSIONS
;
; Description:
; These are extensions that will not
; appear on the "Extension Selection"
; page. However, files with these
; extensions will still appear within
; the directory and file selection
; page, where they can still be
; selected for transfer.
;
; SELECTIVE MIGRATION ONLY!
;============================================
[Filter_Start]
[Filter_End]
;============================================
;
;============================================
; EXTENSION SELECTION
; PAGE DRIVES
;
; Note:
; Place a drive, with the ":\",
; after the "Drives_Start" and
; before the "Drives_End" in
; order to have that drive
; checked when "Load Defaults"
; is clicked on the Extension
; Selection Page.
;
; For example: C:\
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;
; SELECTIVE MIGRATION ONLY!
;============================================
[Drives_Start]
[Drives_End]
;============================================
;
;============================================
; REGISTRY SELECTION
;
; Note:
; Place a registry key, after the
; "Registry_Start" and before the
; "Registry_End" in order to have that
; registry key migrated.
;
; WARNING:
;
; The migration of registry keys can
; lead to unpredictible behavior.
; Extreme caution and careful
; consideration should be exercised
; before adding any registry keys to
; this migration list.
;
; SELECTIVE MIGRATION ONLY!
;============================================
[Registry_Start]
[Registry_End]
;============================================
;
;********************************************
; MASS MIGRATION SETTINGS
;********************************************
;
;============================================
; EXCLUSION EXTENSIONS
;
; Description:
; Place an extension, preceded
; with the ".", in the list
; after "Exclusion_Extension_Start"
; and before "Exclusion_Extension_End"
; in order to have that extension
; unchecked when "Check Defaults"
; is clicked. The directory
; tree will also, by default,
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; uncheck all files that match these
; extensions.
;
; For example: .txt
;
; MASS MIGRATION ONLY!
;============================================
[Exclusion_Extension_Start]
[Exclusion_Extension_End]
;============================================
;
;============================================
; EXCLUSION FILES
;
; Description:
; Place a file name, with its
; complete path, in the list after
; "Inclusion_File_Start" and before
; "Inclusion_File_End" in order to
; have that file checked when
; "Check Defaults" is clicked.
;
; For example: c:\sample.txt
;
; MASS MIGRATION ONLY!
;============================================
[Exclusion_File_Start]
[Exclusion_File_End]
;============================================
;
;============================================
; EXCLUSION FOLDERS
;
; Description:
; Place a folder name, with its
; complete path, in the list after
; "Exclusion_Folder_Start" and before
; "Exclusion_Folder_End" in order to
; have that folder and all of it's
; files and subdirectories checked
; when "Check Defaults" is clicked
; and when first entering the File &
; Folder Selection page.
;
; For example: c:\sample\info
;
; MASS MIGRATION ONLY!
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;============================================
[Exclusion_Folder_Start]
[Exclusion_Folder_End]

A.2 Command file for SRCBAT.EXE

;++++++++++++++++++++++++++++++++++++++++++++++++++
;
; S R C C O M M A N D S . T X T
;
;++++++++++++++++++++++++++++++++++++++++++++++++++
;
; THIS IS THE COMMAND FILE FOR THE SOURCE
; PORTION OF THE BATCH MODE VERSION OF
; SYSTEM MIGRATION ASSISTANT (SMA)
;
; Important: The semicolon is used within
; this file to let SMA know to
; ignore any text that follows.
; All comments should be preceded
; by a semicolon. All text that
; SMA expects to examine must not
; be preceded by a semicolon.
;
; Note: SMA is not case sensitive with any
; of the text appearing within this
; file.
;
; For example: C:\DOCUMENTS\FILE.TXT
; is treated the same as
; c:\documents\file.txt
;
;++++++++++++++++++++++++++++++++++++++++++++++++++
;
;**************************************************
; MASS AND SELECTIVE MIGRTION SETTINGS
;**************************************************
;
;==================================================
; TRANSFER MODE
;
; Usage:
; After the equal sign, provide the
; type of migration that is to be
; performed. There are two
; possible choices and they are
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; Selective and Mass.
;==================================================
[Transfer_Mode]
TransferMode=Selective
;==================================================
;
;==================================================
; OUTPUT LOCATION
;
; Usage:
; Place, after the equal sign, the
; location that is to be used for the
; output files destination. This will
; be ignored if ADSM is being used in
; which case the output files will go
; to the ADSM server.
;
; BOTH SELECTIVE AND MASS MIGRATIONS!
;==================================================
[Output_Location]
OutputLocation=C:\PROGRA~1\IBM\SMA\Profiles
;==================================================
;
;==================================================
; PROFILE NAME
;
; Usage:
; Place the name of the profile after
; the equal sign. This is the name
; that will be used for the profile
; unless another one was specified on
; the command line.
;
; BOTH SELECTIVE AND MASS MIGRATIONS!
;==================================================
[Profile_Name]
ProfileName=C:\PROGRA~1\IBM\SMA\Profiles\Batch.sma
;==================================================
;
;==================================================
; CAPTURE NTFS ATTRIBUTES
;
; Usage:
; If NTFS file attributes should be
; captured for migration then
; Capture_NTFS_Attributes should equal
; 1, otherwise it should be equal to 0.
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;
; Note: Capturing NTFS attributes takes
; significantly more time than
; when they are not captured.
;
;==================================================
[CAPTURE_NTFS_ATTRIBUTES]
Capture_NTFS_Attributes=0
;==================================================
;
;==================================================
; ADSM
;
; Usage:
; This is where it is indicated whether
; or not ADSM will be used. If ADSM is
; being used, then Using_ADSM should be
; equal to 1, otherwise it should be
; equal to 0. Each field that is
; needed should have a valid value or
; else SMA will abort and exit.
;
;==================================================
[ADSM_Start]
Using_ADSM=0
NodeID=
Password=
ADSM_Server=
[ADSM_End]
;==================================================
;
;==================================================
; USER EXIT
;
; Usage:
; Provide the name of the command file
; that is to be executed upon finishing
; the SMA migration process.
;
; BOTH SELECTIVE AND MASS MIGRATIONS!
;==================================================
[User_Exit]
UserExit=
;==================================================
;
;**************************************************
; SELECTIVE MIGRATION SETTINGS
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;**************************************************
;
;==================================================
; PERSONALITY SETTINGS
;
; Usage:
; Place a 1 next to the settings that
; are to be migrated. Place a 0 next
; to the settings that are not to be
; migrated.
;
; SELECTIVE MIGRATION ONLY!
;==================================================
[Personality_Start]
accessibility=1
activedesktop=1
colors=1
desktopicons=1
display=1
iconfont=1
internetbrowser=1
keyboard=1
mouse=1
pattern=1
printers=0
screensaver=1
sendtomenu=1
shell=1
sound=1
startmenu=1
taskbar=1
userprofiles=1
wallpaper=1
windowmetrics=1
[Personality_End]
;==================================================
;
;==================================================
; CONNECTIVITY SETTINGS
;
; Usage:
; Place a 1 next to the settings that
; are to be migrated. Place a 0 next
; to the settings that are not to be
; migrated.
;
; SELECTIVE MIGRATION ONLY!
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;==================================================
[Connectivity_Start]
computerdescription=1
computername=1
dnsconfiguration=1
mappeddrives=1
rasnetworking=1
sharedfolders=1
tcpipconfiguration=1
winsconfiguration=1
workgroup=1
domain=1
[Connectivity_End]
;==================================================
;
;==================================================
; INCLUSION EXTENSIONS
;
; Usage:
; Place an extension, preceded
; with the ".", in the list
; after "Inclusion_Extension_Start"
; and before "Inclusion_Extension_End"
; in order to have all files that match
; that extension transferred.
;
; For example: .txt
;
; SELECTIVE MIGRATION ONLY!
;==================================================
[Inclusion_Extension_Start]
[Inclusion_Extension_End]
;==================================================
;
;==================================================
; INCLUSION FILES
;
; Usage:
; Place a file name, with its
; complete path, in the list after
; "Inclusion_File_Start" and before
; "Inclusion_File_End" in order to
; have that file checked when
; "Load Defaults" is clicked.
;
; For example: c:\important.txt
;
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; SELECTIVE MIGRATION ONLY!
;==================================================
[Inclusion_File_Start]
[Inclusion_File_End]
;==================================================
;
;
;
;
;==================================================
; SELECTIVE EXCLUSION FILES
;
; Usage:
; Place a file name, with its
; complete path, in the list after
; "Selective_Exclusion_File_Start" and
; before "Selective_Exclusion_File_End"
; in order to have that file excluded
; from transfer.
;
; For example: c:\sample.txt
;
; SELECTIVE MIGRATION ONLY!
;==================================================
[Selective_Exclusion_File_Start]
[Selective_Exclusion_File_End]
;==================================================
;
;==================================================
; INCLUSION FOLDERS
;
; Usage:
; Place a folder name, with its
; complete path, in the list after
; "Inclusion_Folder_Start" and before
; "Inclusion_Folder_End" in order to
; have that folder and all of it's
; files and subdirectories transferred.
;
; For example: c:\important\mydocs
;
; SELECTIVE MIGRATION ONLY!
;==================================================
[Inclusion_Folder_Start]
[Inclusion_Folder_End]
;==================================================
;
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;==================================================
; SELECTIVE EXCLUSION FOLDERS
;
; Usage:
; Place a folder name, with its complete
; path, after
; "Selective_Exclusion_Folder_Start"
; and before "Selective_Exclusion_Folder_End"
; in order to have that folder and all
; of it's files and subdirectories
; excluded from transfer.
;
; For example: c:\dir1\olddocs
;
; SELECTIVE MIGRATION ONLY!
;==================================================
[Selective_Exclusion_Folder_Start]
[Selective_Exclusion_Folder_End]
;==================================================
;
;==================================================
; INCLUSION DRIVES
;
; Usage:
; Place a drive letter, followed by a
; colon, after "Inclusion_Drive_Start"
; and before "Inclusion_Drive_End" in
; order to have the drive included
; for transfer.
;
; For example: d:
;
; SELECTIVE MIGRATION ONLY!
;==================================================
[Inclusion_Drive_Start]
[Inclusion_Drive_End]
;==================================================
;
;==================================================
; REGISTRY SELECTION
;
; Usage:
; Place a registry key, after the
; "Registry_Start" and before the
; "Registry_End" in order to have that
; registry key migrated.
;
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; WARNING:
;
; The migration of registry keys can
; lead to unpredictible behavior.
; EXTREME caution and careful
; consideration should be exercised
; before adding any registry keys to
; this migration list.
;
; SELECTIVE MIGRATION ONLY!
;==================================================
[Registry_Start]
[Registry_End]
;==================================================
;
;**************************************************
; MASS MIGRATION SETTINGS
;**************************************************
;
;==================================================
; EXCLUSION FILES
;
; Usage:
; Place a file name, with its
; complete path, in the list after
; "Exclusion_File_Start" and before
; "Exclusion_File_End" in order to
; have that file excluded from
; transfer.
;
; For example: c:\sample.txt
;
; MASS MIGRATION ONLY!
;==================================================
[Exclusion_File_Start]
[Exclusion_File_End]
;==================================================
;
;==================================================
; EXCLUSION FOLDERS
;
; Usage:
; Place a folder name, with its
; complete path, after
; "Exclusion_Folder_Start" and
; before "Exclusion_Folder_End" in
; order to have that folder and all
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; of it's files and subdirectories
; excluded from transfer.
;
; For example: c:\dir1\olddocs
;
; MASS MIGRATION ONLY!
;==================================================
[Exclusion_Folder_Start]
[Exclusion_Folder_End]
;==================================================
;
;==================================================
; EXCLUSION DRIVES
;
; Usage:
; Place a drive letter, followed by a
; colon, after "Exclusion_Drive_Start"
; and before "Exclusion_Drive_End" in
; order to have the drive excluded
; from transfer.
;
; For example: d:
;
; MASS MIGRATION ONLY!
;==================================================
[Exclusion_Drive_Start]
[Exclusion_Drive_End]
;==================================================

A.3 Command file for TARBAT.EXE

;++++++++++++++++++++++++++++++++++++++++++++
;
; T A R C O M M A N D S . T X T
;
;++++++++++++++++++++++++++++++++++++++++++++
;
; THIS IS THE COMMAND FILE FOR THE TARGET
; PORTION OF THE BATCH MODE VERSION OF
; SYSTEM MIGRATION ASSISTANT (SMA)
;
; Note: SMA is not case sensitive with any
; of the text appearing within this
; file.
;
; For example: C:\DOCUMENTS\FILE.TXT
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; is treated the same as
; c:\documents\file.txt
;
;++++++++++++++++++++++++++++++++++++++++++++
;
;********************************************
; MASS AND SELECTIVE MIGRTION SETTINGS
;********************************************
;
;============================================
; TCPIP
;
; Description:
; Provide the new TCP/IP
; address to be used on
; the target computer to use.
;
; BOTH SELECTIVE AND MASS MIGRATIONS!
;============================================
[TCPIP]
TCPIP=10.1.1.130
;============================================
;
;============================================
; SUBNET
;
; Description:
; Provide the new subnet
; address to be used on
; the target computer to use.
;
; BOTH SELECTIVE AND MASS MIGRATIONS!
;============================================
[SUBNET]
SUBNET=255.255.0.0
;============================================
;
;============================================
; GATEWAY
;
; Description:
; Provide the new gateway
; address to be used on
; the target computer to use.
;
; BOTH SELECTIVE AND MASS MIGRATIONS!
;============================================
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[GATEWAY]
GATEWAY=10.1.1.4
;============================================
;
;============================================
; COMPUTER NAME
;
; Description:
; Provide the new name to be used
; on the target computer.
;
; BOTH SELECTIVE AND MASS MIGRATIONS!
;============================================
[Computer_Name]
Computer_Name=SMA2K
;============================================
;
;============================================
; DOMAIN/WORKGROUP NAME
;
; Description:
; Provide the new domain or
; workgroupname to beused on the
; target computer.
;
; BOTH SELECTIVE AND MASS MIGRATIONS!
;============================================
[Domain_Workgroup]
Domain_Workgroup=UM
;===========================================
;
;============================================
; USER EXIT
;
; Description:
; Provide the name of the command file
; that is to be executed upon finishing
; the SMA migration process.
;
; BOTH SELECTIVE AND MASS MIGRATIONS!
;============================================
[User_Exit]
UserExit=
;============================================
;
;============================================
; ADSM
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;
; Description:
; This is where it is indicated whether
; or not ADSM will be used. Each field
; that is needed should have a valid
; value or else SMA will fail. These
; fields will be ignored if they are
; not needed.
;
;============================================
[ADSM_Start]
NodeID=
Password=
ADSM_Server=
[ADSM_End]
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Appendix B. Scripts for the Windows 2000 upgrade example

The scripts contained in this appendix are part of the Windows 2000
Professional upgrade via Netfinity Director example described in 2.4.1,
“Unattended upgrade to Windows 2000 Professional” on page 86. All
programs were tested using Windows Scripting Host Version 5.1.

B.1 BOOST.VBS

This script is the first part of a three-part process. BOOST.VBS is used to
seed the Startup folder of the target system with PREUPGRD.VBS, set the
autologon registry entries, and reboot the system.
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‘ This script is part one of a three part process with files PREUPGRD.VBS and W2KUPGRD.VBS that
‘ remotely uninstalls Universal Management Services and starts the Windows 2000 Professional Unattended’
‘ install on Windows 98 SE and Windows NT 4.0 Workstation, Service Pack 6a. This script is to be
‘ distributed to remote machines using a Netfinity Manager Task Process.

‘ Set up the required objects
Dim WSHShell,FSO
Set WSHShell = WScript.CreateObject("WScript.Shell")
Set FSO = CreateObject("Scripting.FileSystemObject")
Set WSHEnvironment = WSHShell.Environment

‘ Check what operating system is running on the target machine, set the sysdir variable, and run the
‘ appropriate subroutine
If (WSHEnvironment("OS")="Windows_NT") Then
sysdir = WSHShell.ExpandEnvironmentStrings("%SystemRoot%")
Call NT()

Else
sysdir = WSHShell.ExpandEnvironmentStrings("%windir%")
Call W98()

End If
WScript.Quit

‘ Subroutine for Windows NT 4.0 Operating System
Sub NT()
‘ Copy the file needed for rebooting Windows NT
FSO.Copyfile "\\23ff458\Archive\W2KPro\Scripts\SHUTDOWN.EXE", sysdir + "\"

‘ Create the Autologon entries to be used with the Startup Folder process
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows NT\CurrentVersion\Winlogon\AutoAdminLogon", 1
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows NT\CurrentVersion\Winlogon\DefaultPassword",

"password"
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows NT\CurrentVersion\Winlogon\DefaultUserName",

"administrator"

‘ Copy PREUPGRD.VBS to the Startup Folder
FSO.CopyFile "\\23ff458\Archive\W2KPro\Scripts\PREUPGRD.VBS", sysdir + "\Profiles\Administrator\Start

Menu\Programs\Startup\"

‘ Reboot the system
WSHShell.Run "SHUTDOWN /L /R /T:0 /Y /C",0

End Sub

‘ Subroutine for Windows 98 Second Edition Operating System
Sub W98()
‘ Copy the file needed for AutoLogon under Windows 98
FSO.CopyFile "\\23ff458\Archive\W2KPro\Scripts\TWEAKUI.CPL", sysdir + "\system\"

‘ Create the Autologon entries to be used with the Startup Folder process
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows\CurrentVersion\Winlogon\AutoAdminLogon", 1
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows\CurrentVersion\Winlogon\DefaultPassword",

"password"
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows\CurrentVersion\Winlogon\DefaultUserName",

"administrator"
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows\CurrentVersion\RunServicesOnce\Tweak UI",

"RUNDLL32.EXE TWEAKUI.CPL,TweakLogon"
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B.2 PREUPGRD.VBS

PREUPGRD.VBS is the second of the three scripts. This one is executed
from the Startup folder of the target machine. It will uninstall Universal
Management Services, create a RunOnce entry for W2KUPGRD.VBS, set up
autologon, and reboot the system.

‘ Copy PREUPGRD.VBS to the Startup Folder
FSO.CopyFile "\\23ff458\Archive\W2KPro\Scripts\PREUPGRD.VBS", sysdir + "\startm~1\Programs\StartUp\"

‘ Reboot the system
WSHShell.Run "rundll32 shell32.dll,SHExitWindowsEx 2",0

End Sub
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‘ This script is part two of a three part process with files BOOST.VBS and W2KUPGRD.VBS that remotely
‘ uninstalls Universal Management Services and starts the Windows 2000 Professional Unattended install
‘ on Windows 98 SE and Windows NT 4.0 Workstation, Service Pack 6a. This script is to be distributed to
‘ remote machines using a Netfiniy Manager Task Process.

‘ Set up the required objects
Dim WSHShell, FSO
Set WSHShell = WScript.CreateObject("WScript.Shell")
Set FSO = CreateObject("Scripting.FileSystemObject")
Set WSHEnvironment = WSHShell.Environment

‘ Check what operating system is running on the target machine, set the sysdir variable,and run the
‘ appropriate subroutine
If (WSHEnvironment("OS")="Windows_NT") Then
sysdir = WSHShell.ExpandEnvironmentStrings("%SystemRoot%")
Call NT()

Else
sysdir = WSHShell.ExpandEnvironmentStrings("%windir%")
Call W98()

End If
WScript.Quit

' Subroutine for Windows NT 4.0 Operating System
Sub NT()
‘ Create the Autologon entries to be used with the Runonce
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows NT\CurrentVersion\Winlogon\AutoAdminLogon", 1
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows NT\CurrentVersion\Winlogon\DefaultPassword",

"password"
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows NT\CurrentVersion\Winlogon\DefaultUserName",

"administrator"

‘ Running the command to uninstall Universal Management Services
WSHShell.Run "%COMSPEC% /C %SystemRoot%\uninsums.exe /u",0

‘ Call the subroutine wait which delays reboot until the uninstallation finishes
Call Wait()

‘ Add the Runonce entry for W2KUPGRD.VBS
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows\CurrentVersion\Runonce\W2KUPGRD", "CSCRIPT

\\23ff458\Archive\W2KPro\Scripts\W2KUPGRD.VBS"

‘ Reboot the machine
WSHShell.Run "SHUTDOWN /L /R /T:0 /Y",0

‘ Delete the Startup Folder process
FSO.DeleteFile(sysdir + "\Profiles\Administrator\Start Menu\Programs\Startup\PREUPGRD.VBS")

End Sub

‘ Subroutine for Windows 98 Second Edition Operating System
Sub W98()
‘ Create the Autologon entries to be used with the Runonce
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows\CurrentVersion\Winlogon\AutoAdminLogon", 1
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B.3 W2KUPGRD.VBS

The final script of the trio is W2KUPGRD.VBS. This Visual Basic script will
delete all the temporary files needed in previous parts of the process and
start the Windows 2000 Professional unattended upgrade install.

. WSHShell.RegWrite "HKLM\Software\Microsoft\Windows\CurrentVersion\Winlogon\DefaultPassword",
"password"
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows\CurrentVersion\Winlogon\DefaultUserName",

"administrator"
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows\CurrentVersion\RunServicesOnce\Tweak UI",

"RUNDLL32.EXE TWEAKUI.CPL,TweakLogon"

‘ Add the Runonce entry for W2KUPGRD.VBS
WSHShell.RegWrite "HKLM\Software\Microsoft\Windows\CurrentVersion\Runonce\W2KUPGRD", sysdir +

"\COMMAND\CSCRIPT \\23ff458\Archive\W2KPro\Scripts\W2KUPGRD.VBS"

‘ Run the command to uninstall Universal Management Services
WSHShell.Run "%COMSPEC% /C %windir%\uninsums.exe /u",0

‘ Call the subroutine wait which delays reboot until the uninstallation finishes
Call Wait()

‘ Reboot the machine
WSHShell.Run "rundll32 shell32.dll,SHExitWindowsEx 2",0

‘ Delete the Startup Folder process
FSO.DeleteFile(sysdir + "\startm~1\Programs\StartUp\PREUPGRD.VBS")

End Sub

‘ Subroutine that waits for the uninstallation of UMS to complete.
Sub Wait()
If (FSO.FileExists(sysdir + "\uninsums.exe")) Then
WScript.Sleep 30000
Call Wait

End If
End Sub
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‘ This script is part three of a three part process with file BOOST.VBS and PREUPGRD.VBS that remotely
‘ uninstalls Universal ManagementServices and starts the Windows 2000 Professional Unattended install
‘ on Windows 98 SE and Windows NT 4.0 Workstation,Service Pack 6a.

‘ Set up the required objects
Dim WSHShell,WSHNetwork,FSO
Set WSHShell = WScript.CreateObject("WScript.Shell")
Set WSHNetwork = WScript.CreateObject("WScript.Network")
Set FSO = CreateObject("Scripting.FileSystemObject")
Set WSHEnvironment = WSHShell.Environment

‘ Map Windows 2000 Professional sharepoint
WSHNetwork.MapNetworkDrive "Z:", "\\23ff458\archive"

‘ Check what operating system is running on the target machine and run the appropriate subroutine

If (WSHEnvironment("OS")="Windows_NT") Then
Call NT()

Else
Call W98()

End If
WScript.Quit

‘ Subroutine for Windows NT 4.0 Operating System
Sub NT()
‘ Remove the AutoLogon Registry Entries
WSHShell.RegDelete("HKLM\Software\Microsoft\Windows NT\CurrentVersion\Winlogon\AutoAdminLogon")
WSHShell.RegDelete("HKLM\Software\Microsoft\Windows NT\CurrentVersion\Winlogon\DefaultPassword")
WSHShell.RegDelete("HKLM\Software\Microsoft\Windows NT\CurrentVersion\Winlogon\DefaultUserName")

‘ Remove the Windows NT Shutdown utility
FSO.DeleteFile(WshShell.ExpandEnvironmentStrings("%SystemRoot%" + "\SHUTDOWN.EXE"))

‘ Run the Windows 2000 Professional upgrade
WINNTCMD = WSHShell.Run("%COMSPEC% /C Z:\W2KPro\I386\WINNT32

/UNATTEND:Z:\W2KPro\Scripts\NT4UPGRD.TXT",1,TRUE)
End Sub

‘ Subroutine for Windows 98 Second Edition Operating System
Sub W98()
‘ Remove the AutoLogon Registry Entries
WSHShell.RegDelete("HKLM\Software\Microsoft\Windows\CurrentVersion\Winlogon\AutoAdminLogon")
WSHShell.RegDelete("HKLM\Software\Microsoft\Windows\CurrentVersion\Winlogon\DefaultPassword")
WSHShell.RegDelete("HKLM\Software\Microsoft\Windows\CurrentVersion\Winlogon\DefaultUserName")

‘ Remove the Windows 98 AutoLogon utility
FSO.DeleteFile(WshShell.ExpandEnvironmentStrings("%WinDir%" + "\system\TWEAKUI.CPL"))

‘ Run the Windows 2000 Professional Upgrade
WIN98CMD = WSHShell.Run("%COMSPEC% /C Z:\W2KPro\I386\WINNT32

/UNATTEND:Z:\W2KPro\Scripts\W98UPGRD.TXT",1,TRUE)
End Sub
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Appendix C. Special notices

This publication is intended to help systems management professionals who
are involved in the deployment of Windows 2000 on the Intel platform, migrate
and deploy Windows 2000 on clients and servers. The information in this
publication is not intended as the specification of any programming interfaces
that are provided by Netfinity Director, LCCM, Software Delivery Assistant
and System Migration Assistant.. See the PUBLICATIONS section of the IBM
Programming Announcement for Netfinity Director, LCCM, Software Delivery
Assistant and System Migration Assistant for more information about what
publications are considered to be product documentation.

References in this publication to IBM products, programs or services do not
imply that IBM intends to make these available in all countries in which IBM
operates. Any reference to an IBM product, program, or service is not
intended to state or imply that only IBM's product, program, or service may be
used. Any functionally equivalent program that does not infringe any of IBM's
intellectual property rights may be used instead of the IBM product, program
or service.

Information in this book was developed in conjunction with use of the
equipment specified, and is limited in application to those specific hardware
and software products and levels.

IBM may have patents or pending patent applications covering subject matter
in this document. The furnishing of this document does not give you any
license to these patents. You can send license inquiries, in writing, to the IBM
Director of Licensing, IBM Corporation, North Castle Drive, Armonk, NY
10504-1785.

Licensees of this program who wish to have information about it for the
purpose of enabling: (i) the exchange of information between independently
created programs and other programs (including this one) and (ii) the mutual
use of the information which has been exchanged, should contact IBM
Corporation, Dept. 600A, Mail Drop 1329, Somers, NY 10589 USA.

Such information may be available, subject to appropriate terms and
conditions, including in some cases, payment of a fee.

The information contained in this document has not been submitted to any
formal IBM test and is distributed AS IS. The information about non-IBM
("vendor") products in this manual has been supplied by the vendor and IBM
assumes no responsibility for its accuracy or completeness. The use of this
information or the implementation of any of these techniques is a customer
© Copyright IBM Corp. 2000 341



responsibility and depends on the customer's ability to evaluate and integrate
them into the customer's operational environment. While each item may have
been reviewed by IBM for accuracy in a specific situation, there is no
guarantee that the same or similar results will be obtained elsewhere.
Customers attempting to adapt these techniques to their own environments
do so at their own risk.

Any pointers in this publication to external Web sites are provided for
convenience only and do not in any manner serve as an endorsement of
these Web sites.

Any performance data contained in this document was determined in a
controlled environment, and therefore, the results that may be obtained in
other operating environments may vary significantly. Users of this document
should verify the applicable data for their specific environment.

This document contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples
contain the names of individuals, companies, brands, and products. All of
these names are fictitious and any similarity to the names and addresses
used by an actual business enterprise is entirely coincidental.

Reference to PTF numbers that have not been released through the normal
distribution process does not imply general availability. The purpose of
including these reference numbers is to alert IBM customers to specific
information relative to the implementation of the PTF when it becomes
available to each customer according to the normal IBM PTF distribution
process.

The following terms are trademarks of the International Business Machines
Corporation in the United States and/or other countries:

The following terms are trademarks of other companies:

Tivoli, Manage. Anything. Anywhere.,The Power To Manage., Anything.
Anywhere.,TME, NetView, Cross-Site, Tivoli Ready, Tivoli Certified, Planet
Tivoli, and Tivoli Enterprise are trademarks or registered trademarks of Tivoli
Systems Inc., an IBM company, in the United States, other countries, or both.
In Denmark, Tivoli is a trademark licensed from Kjøbenhavns Sommer - Tivoli

IBM Lotus
ServeRAID Lotus SmartSuite
System/390 SmartSuite
ThinkPad Notes
Wake on LAN NetView
WebSphere Cross-Site
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A/S.

C-bus is a trademark of Corollary, Inc. in the United States and/or other
countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States and/or other
countries.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States and/or other countries.

PC Direct is a trademark of Ziff Communications Company in the United
States and/or other countries and is used by IBM Corporation under license.

ActionMedia, LANDesk, MMX, Pentium and ProShare are trademarks of Intel
Corporation in the United States and/or other countries.

UNIX is a registered trademark in the United States and other countries
licensed exclusively through The Open Group.

SET, SET Secure Electronic Transaction, and the SET logo are trademarks
owned by SET Secure Electronic Transaction LLC.

Other company, product, and service names may be trademarks or service
marks of others.
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Appendix D. Related publications

The publications listed in this section are considered particularly suitable for a
more detailed discussion of the topics covered in this redbook.

D.1 IBM Redbooks

For information on ordering these publications see “How to get IBM
Redbooks” on page 347.

• Netfinity Director - Integration and Tools, SG24-5389

• Using LCCM Functions with Servers and Workstations, SG24-5292

• Tivoli IT Director Automation, SG24-5295

• Integration Examples for Tivoli IT Director: A First Look, SG24-5207

D.2 IBM Redbooks collections

Redbooks are also available on the following CD-ROMs. Click the CD-ROMs
button at http://www.redbooks.ibm.com/ for information about all the CD-ROMs
offered, updates and formats.

D.3 Referenced Web sites

These Web sites are also relevant as further information sources:

• http://www.pc.ibm.com/ww/assetid/systems.html

• http://www.pc.ibm.com/ww/solutions/enterprise/sysmgmt/index.html

CD-ROM Title Collection Kit
Number

System/390 Redbooks Collection SK2T-2177

Networking and Systems Management Redbooks Collection SK2T-6022

Transaction Processing and Data Management Redbooks Collection SK2T-8038

Lotus Redbooks Collection SK2T-8039

Tivoli Redbooks Collection SK2T-8044

AS/400 Redbooks Collection SK2T-2849

Netfinity Hardware and Software Redbooks Collection SK2T-8046

RS/6000 Redbooks Collection (BkMgr) SK2T-8040

RS/6000 Redbooks Collection (PDF Format) SK2T-8043

Application Development Redbooks Collection SK2T-8037

IBM Enterprise Storage and Systems Management Solutions SK3T-3694
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• http://www.microsoft.com/technet/download/default.asp

• http://www.glbs.com/Default.htm

• http://www.microsoft.com/technet/win2000

• http://www.microsoft.com/windows2000/compatible

• http://www.pc.ibm.com/support?page=YAST-3P2QYL

• http://www.pc.ibm.com/ww/solutions/enterprise/support/index.htm

• http://www.pc.ibm.com/us/desktop/lccm/hints.html

• http://www.pc.ibm.com/ww/solutions/enterprise/sysmgmt/products/nfdir/lib

rary.html

• http://www.pc.ibm.com/ww/solutions/enterprise/sysmgmt/products/sda/down

• http://www.pc.ibm.com/ww/solutions/enterprise/sysmgmt/products.html

• http://www6b.pc.ibm.com:8080/~ums

• http://www.pc.ibm.com/us/desktop/lccm/esupport.html

• http://www.pc.ibm.com/ww/solutions/enterprise/support/index.html

• http://www.pc.ibm.com/ww/software/sysmgmt/products/ums/extensions.html

• http://www.elink.ibmlink.ibm.com/pbl/pbl
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How to get IBM Redbooks

This section explains how both customers and IBM employees can find out about IBM Redbooks,
redpieces, and CD-ROMs. A form for ordering books and CD-ROMs by fax or e-mail is also provided.

• Redbooks Web Site http://www.redbooks.ibm.com/

Search for, view, download, or order hardcopy/CD-ROM Redbooks from the Redbooks Web site.
Also read redpieces and download additional materials (code samples or diskette/CD-ROM images)
from this Redbooks site.

Redpieces are Redbooks in progress; not all Redbooks become redpieces and sometimes just a few
chapters will be published this way. The intent is to get the information out much quicker than the
formal publishing process allows.

• E-mail Orders

Send orders by e-mail including information from the IBM Redbooks fax order form to:

• Telephone Orders

• Fax Orders

This information was current at the time of publication, but is continually subject to change. The latest
information may be found at the Redbooks Web site.

In United States
Outside North America

e-mail address
usib6fpl@ibmmail.com
Contact information is in the “How to Order” section at this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl

United States (toll free)
Canada (toll free)
Outside North America

1-800-879-2755
1-800-IBM-4YOU
Country coordinator phone number is in the “How to Order”
section at this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl

United States (toll free)
Canada
Outside North America

1-800-445-9269
1-403-267-4455
Fax phone number is in the “How to Order” section at this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl

IBM employees may register for information on workshops, residencies, and Redbooks by accessing
the IBM Intranet Web site at http://w3.itso.ibm.com/ and clicking the ITSO Mailing List button.
Look in the Materials repository for workshops, presentations, papers, and Web pages developed
and written by the ITSO technical professionals; click the Additional Materials button. Employees may
access MyNews at http://w3.ibm.com/ for redbook, residency, and workshop announcements.

IBM Intranet for Employees
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IBM Redbooks fax order form

Please send me the following:

We accept American Express, Diners, Eurocard, Master Card, and Visa. Payment by credit card not
available in all countries. Signature mandatory for credit card payment.

Title Order Number Quantity

First name Last name

Company

Address

City Postal code

Telephone number Telefax number VAT number

Invoice to customer number

Country

Credit card number
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